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Warning and Disclaimer
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not assume responsibility for the use or inability to use the software product as a result of

providing this information.
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Introduction

The following provides an introduction to the ThreatQ platform.

« ThreatQ Introduction

o Concept Overview

ThreatQ Introduction

ThreatQ is a cyber threat intelligence platform that focuses on centralizing, structuring, and

strengthening a security organization's intelligence-driven defensive posture against attacks.

Concept Overview

The following describes how ThreatQ helps organizations manage threat intelligence, allow-

ing them to defend against sophisticated cyber-attacks.

o Threat Library

o Adaptive Workbench

« Open Exchange

Threat Library

A central repository combining global and local threat data to provide relevant and con-
textual intelligence that is customized for your unique environment. Over time, the library
becomes more and more tuned to your environment and fills in the intelligence gaps created

by different sources, all providing only some pieces of the puzzle.
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Adaptive Workbench

An open and extensible work area for security experts across the organization to work within
your processes and tools. A customizable workflow and customer-specific enrichment

streamlines investigations and analysis, and automates the intelligence life cycle.
Open Exchange

ThreatQ is the only threat intelligence platform specifically designed for customization to
meet the requirements of your unique environment. Get more from your existing security
investments by integrating your tools, teams and workflows through standard interfaces and

an SDK/API for customization.
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Navigation Menu

Navigation Menu

The table below outlines the ThreatQ navigation menu and its related processes.

Name Description References
ThreatQ Icon | Clicking on the ThreatQ icon will navigate you | N/A
back to the home page and dashboard.
Threat Access and search the Threat Library and o Threat
Library view system object details. Library
« Advanced
Search
« Object
Details Page
« System
Objects
Investigations | Navigates to ThreatQ Investigations, a cyber- o ThreatQ
security situation room that enables col- Investigations
laborative threat analysis, investigation, and User Guide
coordinated response.
Analytics Navigates to the Analytics section which  Analytics
provides a summary view of Adversary, Event,
File, Indicator, and Signature Object Types.
Create Button | Create system objects. « Adding
Adversaries
« Adding

ThreatQ User Guide, Version 4.39
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# Name Description References

Events

« Adding Files
« Adding an

Indicator

« Parsing for
an Indicator

» Adding a Sig-
nature

« Adding a

Yara Sig-
nature

6 | Searchlcon | Perform a basic search for a system object or « Search

perform an Indicator Search. « Indicator

Search

7 | Message Receive in-app notifications of system job pro- « Notification

Center Icon cesses such as Bulk Actions. Center

g N

ﬂ Administrator and Main-
tenance account users will
also receive feed health noti-
fications.

(. J

8 | Site Settings | Configure site settings such as user man- « User Man-

agement, incoming feeds, TLP etc. agement

« Incoming
Feeds Over-

view
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# Name Description References
« Exports Over-
view

« Operations
Overview

« Reports Over-

view

 Licensing
Overview

9 | Userlcon Access your user profile. « Managing

your User
Account

Notification Center

The Notification Center alerts you, via an in-app notification icon, when a Bulk Action job
has been queued and/or completed. Administrator and maintenance accounts will also
receive feed health notifications via the Notification Center. The icon is located on the nav-
igation menu for the application. This allows you to monitor system processes while working
within ThreatQ.

Analytics =+ Create Q A

+ Create Q A o NOTIFICATION CENTER MARK ALL AS READ
rc

SYSTEM NOTIFICATION
NOTIFICATION CENTER E
© Bulk Status Job #1 completed successfully. .

alew seconds ago
SYSTEM NOTIFIGATION Bulk Status Job #1 completed successfully.

A 'Alienvault OTX' has encountered errors

2hours ago

Related Topics:
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« Bulk Actions

« Feed Health Notifications

ThreatQ User Guide, Version 4.39 32



THREAT() /™

System Access

System Access

The following describes how to log in and log out of the platform.

o System Access Overview

« Authentication Methods

« System Login

Managing your User Account

2 Step Verification

System Access Overview

To access the ThreatQ web Ul, you must authenticate yourself with a username and pass-

word. You can use the main menu to access ThreatQ functionality.

Authentication Methods

There are three authentication methods that can used to access your ThreatQ platform:

Method

Local

Authentication

Description

User accounts are created and maintained manu-
ally within in the platform. Username, passwords,
and permission roles are configured within
ThreatQ. Administrators can edit a user's profile
including email, password, and permission role in
ThreatQ.

Local users will log in using the local user login

Reference

« User Man-

agement Over-

view

ThreatQ User Guide, Version 4.39
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Method Description Reference

method for the ThreatQ platform - see the Logging

into ThreatQ topic.
LDAP User accounts are created and authenticated out- « LDAP
Authentication | side of the ThreatQ platform and user roles are Authentication

mapped from the user's Active Directory. Due to
this nature, user accounts cannot be modified

within the ThreatQ platform (User Management

page).

LDAP users will log in using the local user login

option for the ThreatQ platform - see the Logging

into ThreatQ topic.
SAML User accounts are created and authenticated out- « SAML
Authentication | side of the ThreatQ platform and user roles are Authentication

mapped from the user's Active Directory. Due to
this nature, user accounts cannot be modified

within the ThreatQ platform (User Management

page).

1

SAML does not allow user role
mapping for maintenance
accounts.

SAML users will log in using the single sign-on
(SSO) login option for the ThreatQ platform - see
the Logging into ThreatQ topic.
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Transitioning Authentication Methods

The following scenarios will detail how authentication methods can be transitioned in the

ThreatQ platform.

Current New

Details
Method Method

Local SAML | Current ThreatQ accounts will be mapped using the user's email
address and users will use SSO to log into the platform - see Logging
into ThreatQ Local Maintenance Accounts will not be mapped in
SAML and will continue to use the local login method. See the Con-

figuring SAML topic for details on this setup process.

A ThreatQuotient strongly recommends that you per-
form a full backup before changing your authen-
tication method.

SAML | Local Contact ThreatQ Support.

Local LDAP | Current ThreatQ accounts will be mapped using the user's email
address and users will continue to use the local login method - see

Logging into ThreatQ See the LDAP Authentication topic for details

on this setup process.

ThreatQuotient strongly recommends that you per-
form a full backup before changing your authen-
tication method.

LDAP | Local Contact ThreatQ Support.

LDAP | SAML |LDAP mustbe disabled before enabling SAML. No account
updates are required if the unique account identifier for LDAP was

the user's email address. The LDAP group thatis mapped to the
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Current New

Method Method

ThreatQ Maintenance role will have to be mapped to different user

role as SAML does not allow maintenance account mapping.

SAML | LDAP | SAML mustbe disabled before enabling LDAP. No account
updates are required if the unique account identifier for SAML was

the user's email address.

System Login

When you installed ThreatQ, you set up the default user account, Maintenance Account,

which you can use to log into the web UL.

Using this account, you can create additional user accounts.

"1

Passwords must be 15 characters or longer. There is no limit on the char-
acter type.

Related Topics:

« Logging into ThreatQ

« Session Timeout

Logging into ThreatQ

When you installed ThreatQ, you defined an IP address for the web Ul, and set up the Main-

tenance Accountand password.

There are two methods that can be used to log into your ThreatQ instance:

e Local Log In
e Single Sign-On (SSO)
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Local Log In
User accounts using local authentication and LDAP will log in using this method.

1. Navigate to your ThreatQ instance -https://your-ThreatQ-web-ip-

address.

THREATQ )

LOGIN

Copyright © 2019 ThreatQuotient, Inc.

2. Enter your username (email address) and password.

3. Optionally, if you have 2-step verification enabled, complete the following steps:
« Enter your verification code from Google Authenticator.
« Optionally, choose to Remember this computer for 30 days.

4. Click Login or Submit.
Single Sign-On (SSO)

Users using SAML authentication will use this log in method.

4 Y

ﬂ SAML users are required to add their email address to their user profiles in
order to use the SSO. As part of the integration process, the ThreatQ plat-
form expects that the user's email address has already been added to
their IdP. See the Setting up LDAP Users/Groups for SAML topic for
more details.
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observes Properties ? % |
[ Member OF Dxabin Environmant Sessong
4 Remote contml Remote Deskdop Services Profile COMe«
Generd  Addess  Account Profie  Telephones  Organmaation
"
[ 33 chasrver
[
a
4 Fistname chearver Inkiaks:
4 Lasrname
I
| Dieplay name chaerver
4 Descrption
4 Dffice
1
1
Tatephore rumber Othar.
a3
Ewmail chserver@tveang com|
Wieh page: Other

N

1. Navigate to your ThreatQ instance -https://your-ThreatQ-web-ip-

address.

If SAML is enabled, you will see a Single Sign-On option.

THREATQ )

threatg@threatg.com

LOG IN USING S50

Copyright ® 2020 ThreatQuotient, Inc.

2. Click on Log in Using SSO.

You will navigate to your third-party authenticated site to log in. Once that has been

completed, you will be automatically sent back to the ThreatQ instance.
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Session Timeout

User sessions time out after 60 minutes of inactivity. Users with administrator and main-
tenance roles can update this setting or, disable session timeouts for that specific user, by

viewing the user's account profile. See the Editing a User topic for more details.

The initial account created when installing ThreatQ does not have a set
session time by default. This setting can be updated as well from the user
profile account.

Managing your User Account

When you click on your User Avatar and select My Account, the system directs you to the
Edit User page for your current login. From here, you can edit your user account, set up 2-

step verification, view your API credentials, or view your login history.

Procedure

1. Click on your user avatar icon, located at the top-right of the screen, and select My
Account
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o

2-5TEP VERIFICATION

The User Profile page loads.

g =

My Account
User Guide
Product Updates
Log Out

THREATQ' )  mresnisoy & oo i s

Edit User

Prafile Infarmation

Change Password
APl Credentials « Client 1D

Sesslen Timeout

Enable 2-Step Verification abled (1)

2. On the User Profile tab, you can view and/or edit the following settings of your user

account:

ThreatQ User Guide, Version 4.39

40



THREA TQ H System Access

Field Description

Display Name | You can update your name.

Title You can update your job title.

Username You can update your username.

Email You can update your email address.

Password You can click on the Change Password link to update your
password.

API Credentials | You can view your AP| credentials, a unique Client ID, which

will allow you to connect with ThreatQ's API.

Session You can update or disable your session timeouts.

Timeout

User Avatar You can update your user avatar; see Update User Avatar for
more details.

2-Step Veri- Optionally, you can set up 2-step verification; see 2 Step Veri-

fication fication for more details.

3. Optionally, you can click on the Login Activity tab to view:
THREATQ ) s mweatiionary

Edit User

User Profile Login Activity

TIMESTAMP = IP ADDRESS ACTION

10/06/2019 07:04pm 10.102.0.1 Successful Login

« The last date and time you logged in.

« The IP Address where you logged in.
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« Whether the login was successful or not.

4. Click Save.
User Avatar Icons

User avatar icons provide a personalized look to your ThreatQ dashboard. Clicking on the

avatar icon will reveal the My Account and Log out options.
Users can update their avatars by clicking on the avatar and selecting My Account.

o Update User Avatar Graphic

Update User Avatar Graphic
1. Click on avataricon located to the top-right on the screen and select My Account.
The Edit Userform will load.

2. Select one of two options:
« Click browse and select the icon graphic to upload.
« Click and drag the new icon graphic onto the page.

3. Click Save at the bottom of the page.

2 Step Verification

When you enable 2-Step Verification (also known as two-factor authentication), you add an
extra layer of security to your account. After 2-Step Verification is active, you sign in with your

password and a code sent to your mobile device.

The 2-Step Verification option is not available for users using SAML
Authentication and the Single Sign-On (SSO) process.

o Enabling 2 Step Verification
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Enabling 2 Step Verification
Procedure:

1. Choose the User Settings icon> My Account.

2. Under Enable 2-Step Verification, click Enabled.

3. Inthe Enable 2 Step Verification dialog box, complete the following:
« Scan the gr code using your Google Authenticator mobile app.

« Enter the validation code delivered to your mobile device via Google

Authenticator.
o Click Submit.
4. Click Save.

What to do next

The next time you log in, you must use the newest verification code.
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Licensing

The following provides an overview of licensing for the ThreatQ platform.

o Licensing Overview

o Viewing the License Status

« Updating a License

Licensing Overview

Your ThreatQ deployment requires a license to initialize the platform. ThreatQ Support
provides the initial license and any subsequent licenses provided to maintain the platform.

You apply the initial ThreatQ license during first boot, as described in the ThreatQ Getting

Started Guide. Any subsequent license updates can be applied in the ThreatQ user inter-

face.

Viewing the License Status

ThreatQ licenses are not perpetual. To view the license expiration date, complete the fol-

lowing steps:
Procedure

Choose the Settings icon >About .

Updating a License

If you receive a new license from Support, apply the new license by accessing the About

page.

Procedure
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1. Choose the Settings icon > About.
Choose Update License.

Enter the new license key.

W N

Click Submit.
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User Management

The following describes how to manage user accounts.

o User Management Overview

« User Account Creation

« User Account Modification

User Management Overview

ThreatQ uses role-based access control to manage user accounts. The system provides sev-
eral user roles, each containing a set of permissions for accessing system functionality. You
create user accounts, and assign them to a user role. The user role determines each

account's set of permissions.

After you create a user account, you can modify the user role group, full name, and email

address.

« User Roles

User Roles

The following details the user roles and their associated permissions.

User Role Permissions

Maintenance Account Members have access to the entire
ThreatQ user interface and can edit

all data.

Important Notes:
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User Role Permissions

« The initial local Maintenance
Account, created when
installing ThreatQ, can not
be deleted

« Local Maintenance Accounts
(manually created within
ThreatQ) cannot be migrated
to SAML authentication

groups.

Administrative Access Members have access to the
entire ThreatQ user interface and

can edit all data.

Primary Contributor Access Members have access to most of
the ThreatQ user interface, except

for:

User Management

Incoming Feeds

« Exports

OAuth Management

System Configurations

Members can edit:

Their own user info

Whitelist Management

o Operations Management

Object meta data

ThreatQ User Guide, Version 4.39 47



THREA TQ ” User Management

User Role Permissions

o Saved Searches

Members have access to most of
the ThreatQ user interface, except

for:

« User Management

« Incoming Feeds

« Indicator Management
Read Only Access « Whitelist Management
« Exports

« Operations Management

o OAuth Management

« System Configurations
Members cannot edit any data.

Members can export search results.

User Account Creation

When you firstinstall ThreatQ, the system creates a default user account, the Maintenance
Account. You cannot delete this account, and you can use it to initially create other user

accounts. Each user account must have a unique username.

Only the Maintenance Account and Administrative Access user role have permissions to
access user management functionality. You can only create new user accounts if logged in

as one of these roles.
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o User Account Properties

« Adding a User

User Account Properties

. full name of the user asso-  any alphabetic character and
Display Name _ _ _
ciated with this account spaces

. , ] any alphabetic character and
Title optional user title
spaces

roles which this user
Group at least one role selected
account belongs to

username associated any alphabetic character and
Username _ .
with this account spaces
o email address associated  valid email address, such as user-
mai

with this account @domain.com

initial password asso-
Password _ _ all characters
ciated with the username

Adding a User

1. From the main menu, choose the Settings icon > User Manangement.
Click Add User.

Enter the user's Display Name.

R

Optionally, enter the user's Title.
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5. Select the level of access for the user from the Group drop-down menu.
Choose from the following options:

« Maintenance Account

« Administrative Access

« Primary Contributor Access

o Read Only Access
Enter the user's Username.
Enter the user's Email address.
Enter a password for the user.

Retype the password.

© © ©o N o

Click Add User.

User Account Modification

After you create a user account, you can modify the account's display name, title, role group,

username, email address, and password.

o Editing a User

o Resetting User Passwords from the Command Line

o Deleting a User

Editing a User

"l

You cannot edit the user details for SAML nor LDAP users from the User
Management page.
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1. From the main menu, choose the Settings icon > User Management.

2. Click the name of the user whose profile you wish to edit.

The User Profile page loads.

THREATQ' ) vy

Edit User

Profile Infarmation

Change Password

Enable 2.5tep Verification abled (1)

AP Credentials - Client 1D

Sesslon Timeout

3. On the User Profile tab, you can view and/or edit the following settings:

Field Description
Display Name | You can update the user's name.
Title You can update the user's job title.
Group You can update the user's role group.
Username You can update the user's username.
Email You can update the user's email address.
Password You can click on the Change Password link to update the
user's password.
API Credentials | You can view the user's API credentials, a unique Client ID,
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Field Description

which will allow him/her to connect with ThreatQ's API.

Session You can update or disable the user's session timeouts.
Timeout
User Avatar You can update the user's user avatar; see Update User

Avatar for more details.

2-Step Veri- Optionally, you can disable 2-step verification; see 2 Step Veri-

fication fication for more details.

4. Optionally, you can click on the Login Activity tab to view:
THREATQ 3

Edit User

User Prafile Login Activity

TIMESTAMP = IP ADDRESS ACTION

10/06/2019 07:04pm 10.102.0.1 Successful Login

« The last date and time the user logged in.
« The IP Address where the user logged in.
o Whether the login was successful or not.

5. Click Save.

Resetting User Passwords from the Command Line

"

You cannot reseta SAML nor LDAP user's password from the command
line.

If you have root access to your ThreatQ installation, you can reset any user's password from

the command line.
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1. SSH to your ThreatQ installation as root.

2. Navigate to the api directory:

cd /var/www/api

3. Run the following command:

php artisan threatqg:password-reset

4. Atthe prompt, enter the email address for the user whose password you are reset-

ting.
5. Atthe prompt, enter the new password.

6. Atthe prompt, re-enter the new password to confirm.

Deleting a User

A\ Deleting a user cannot be undone.

1. From the main menu, choose the Settings icon > User Management.
Select the user(s) you wish to delete.

Click the Delete icon.

B W b

Confirm the deletion when prompted. If the user has any shared custom dash-

boards, select whether to delete the dashboards or reassign them to another user.
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Delete User

User 1 has shared dashboards, how would you like to proceed?

'I [ Reassign to another user v J !’

W Do not reassign. Delete these dashboards.
| @ Aviison Abraham
l ° Ari Ryan

@ Bobby Riccard

—
Q Davida Kraseak

5. Click Delete User.

ThreatQ User Guide, Version 4.39

54



THREA TQ H System Configurations

System Configurations

The following describes how to manage various system configurations in ThreatQ.

« Indicator Statuses

o Indicator Types

« Event Types

o Proxy
o LDAP Authentication

« SAML Authentication

« Date and Time Format

Indicator Statuses

Indicator Statuses page allows you to view, duplicate, add, edit, and delete available sys-
tem-wide indicator statuses. You cannot edit nor delete indicator statuses provided by
ThreatQ (Active, Expired, Indirect, Review, Whitelisted), but you can add, edit, and delete

your own custom statuses.

Enabling the Protect from Feed Override option for a status, via the toggle switch, will pre-
vent feeds from automatically updating the status of indicators. This can be useful for indic-
ators with a specific status, such as Whitelisted, which you may want to prevent from being

automatically updated to Active by a feed.

Related Topics:
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Viewing Indicator Statuses

Indirect Indicator Status

Adding an Indicator Status

Editing an Indicator Status

Deleting an Indicator Status

Viewing Indicator Statuses
To view existing indicator statuses, complete the following procedure.

Procedure:

1. Navigate to Settings Ed > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Indicitor Statuses dcator Types et Types Proay L0AP General

Active Poses a threat and is being exported to detection toals,
Expired Mo longer podes a serious threat.

Indirect Associated to an active indicator or event {i.e. pOMSL
Review Requires further analysis.

Whitelisted Poses NO risk and should never be deplayed.

O Dema This is a dema

CH N NN,

Statuses found within ThreatQ are listed by status, number, and description within the
Indicator Statuses table.

2. Optionally, to sort the table by a column, click the column header. To reverse the

column sorting order, click the header a second time.

Indicator Statuses Table Functions:
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Function Description

Change the number of entries displayed in the table. 1. Click the dropdown
menu at the top right of
the table and select

the desired option.

Sort the table by a column. 1. Click the column

header.

2. To reverse the column
sorting order, click the

header a second time

Indirect Indicator Status

For feeds that set multiple statuses, A status of Indirectis assigned to indicators that meet the

following criteria:
« Indicators created from the relations array are imported with a status of Indirect.

« Ifanindicator already exists, its original status value will remain the same. However, if
the status is Indirect, and itis received as a parent indicator, its value will be updated

as defined in the connector configuration.
Currently, this status only applies to CrowdStrike and iSight feeds, where:

« For CrowdStrike, Indirectindicates that ThreatQ received the indicator from the

relations list for the parent indicator.

« ForiSight Partners, Indirectindicates that ThreatQ received an indicator that does

not have an attribute of Attack or Compromised.
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Adding an Indicator Status

To add an indicator status that can be applied to any system indicator, complete the fol-

lowing procedure.

Procedure:

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

[ L beatee T Evesnt Ty L

FTATUSIE DESCRIPTION & PROTECT RO FEID OVIRRIDE TOTAL IMDICATCRS &
Active Poses a threat and is being exparted to detection toals. )
Expired Mo longer peses a serious threat. CB
Indirect Associated to an acthee indicator or event fi.e. pONS)L @
Review Requires further analysts ®))]
Whitelisted Poses NO risk and should never be deplayed. O

O ema This s a dema D
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2. Click Add New Status.

The Add a Status dialog box opens.

Add a Status

Status Name

Status Description

Add Status | Cancel

3. Enter a Status Name.
4. Optionally, enter a Status Description.

5. Click Add Status.

Editing an Indicator Status

To edit an existing indicator status, complete the following procedure. You cannot edit indic-

ator statuses provided by ThreatQ.

Procedure:
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1. Navigate to Settings E1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations At oy St
" 1 Type

ATUSTE « DESCRPMON & EOTECTFRDM FEID OVERR] o8 ATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad Mo longer poses a serious threat, Q
Indirect Associated to an active indicator or event fi.e. pONS). ®))]

Revlew Requires further analysts. CD A5t
Whitelisted Poses NO risk and should never be deplayed. c
O Dema This Is a dema @

2. Determine the indicator you want to edit and click Edit in the far right column.

The Edit Status dialog box opens.

Edit Status

— Status Name

Demo

— Status Description

This is a demo

3. Optionally, enter a new Status Name.

4. Optionally, enter a new Status Description.

ThreatQ User Guide, Version 4.39 60



THREA TQ H System Configurations

5. Click Save Changes.

Deleting an Indicator Status

To delete an indicator status, complete the following procedure. You cannot edit and delete
indicator statuses provided by ThreatQ. Custom statuses can only be deleted if there are no

indicators using that status.

Procedure:

1. Navigate to Settings £ > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Active Poses a threat and is being exported to detection toals,
Expired Mo lenger poses a serious threat,

Indirect hsmsociated tn an actie indicator or event (i pONS).
Review Requires further analysts

Whitelisted Poses NG risk and should never be deplayed.

860006

O Dema This is 3 dema

2. Determine the indicator you want to delete and select the corresponding checkbox

in the first column.
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3. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

4. Click Delete Statuses.

Indicator Types

The Indicator Types table allows you to view a list of indicator types found in ThreatQ and

the total number of indicators associated with each type.

To view Indicator Types found within ThreatQ:
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1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens.

System Configurations Adk New Status

Indicator Stanuses dcator Types Eveernt Types Browy LOAP General
STATUSES = DESCRIETION & PROTECT FROM FEID OVIRRIDE TOTAL WNDICATORS &
Actrn Prmes a threat and is being sxparted to detection toals, O
Expired Mo longer pedes a serious threat. 8)]
Indirect Associated to an actiee indicator or event fi.e. pONS)L @
Resiew Requires further analysts CD 1S5S
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This is a dema '$)]

2. Click the Indicator Types tab.

The Indicator Types tab opens.
THREAT(Q 3

System Configurations

Indicator Statuses redicatar Types Evert Types Promy  LDAF General
NDSCATER TYPLS « TOTAL INDICATORS &
Binary String a
CI0R Block a
CVE a
Email Address E]
Email Astachment ]
Email Subject i
File Mapping a
File Path a
Filename a
FOON 24
Fuzzy Hash a
GOST Hash a
Hash ION a
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Event Types

The Event Types page allows you to view, add, edit, and delete system events.

System Configurations Addd Neew Evert Type
Indicator Statuses Tdicator Types vant Types Proxy LDAP GEneral
25
TOTAL EVENTS & TOTAL INCICATORS &

Anonymizatian a

Camrmand and Cortral 1

Compromised PKI Certificate a

Dof Attack 1

Exfiltration a

Host Characteristics a

necident a

Login Compromise 0

Malware a

Spearphish a

S0L Injection Attack a

Watchlist a

Watering Hole a

Event Types provided by ThreatQ cannot be edited or deleted, but you can add, edit, and

delete your own custom event types.

System provided Event Types include:

« Anonymization « Malware

o Command and Control « Sighting

o Compromised PKI Certificate « Spearphish

« DoS Attack « SQL Injection
« Exfiltration » Attack

« Host Characteristics « Watchlist

« Incident » Watering Hole

« Login Compromise
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Related Topics:

Viewing Event Types

Editing an Event Type

Editing an Event Type

Deleting an Event Type

Viewing Event Types
To view existing event types, complete the following procedure.

To view Event Types found withing ThreatQ:

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens.

nnnnnnnn ] PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expirad MO |onger poses a serious threat. $)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))]
Revlew Requires further analysts @ 195
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This Is a dema $)]
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2. Click the Event Types tab.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8
Anonymizatian [
Camrmard and Cantral 1
Campromised PRI Certificate a
DS Aftack 1
Exfiliration a
Host Characteristics a
neident Q
Lagin Compromise a
Malware 1}
Spearphish a
S0L Injectian Attack a
Watchlist Q
Watering Hole 0

Event Types Table Functions:

Function Description

Changing the number of entries displayed in the table 1. Click the dropdown
menu at the top right of
the table and select

the desired option.

Sorting the table by a column 1. Click the column

header.

2. To reverse the column
sorting order, click the

header a second time.
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Adding an Event Type

To add an Event Type, complete the following procedure.

Procedure:

1. From the main menu, select Settings [ > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations Adk New Status

indicatnr Statuses dcator Types Eveernt Types Browy LOAP General
STATUSES = DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL MDICATORS &
Actrn Prmes a threat and is being sxparted to detection toals, )
Expirad MO |onger poses a serious threat. ®))]
Indirect Associated to an actiee indicator or event fi.e. pONS)L @
Review Requires further analysts 9)] 4
Whitelisted Poses NO risk and should never be deplayed. C

O Dema This Is a dema @)
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations
Indicator Statuses Indicator Types Event Types Frosy LOwP General
25
TOTAL EVENTS 8 TOTALINDICATORS 8

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Click Add New Event Type.

The Add Event Type dialog box opens.

Add Event Type

‘ Event Name

Add Type Cancel

4. Enter a Event Name.

5. Click Add Type.
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Editing an Event Type

To edit a user-generated Event Type, complete the following procedure.

ﬁ You cannot edit an Event Type provided by ThreatQ.

Procedure:

1. Navigate to Settings E1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

System Configurations

Akl Waw Starus
Indicatar Slatuses Scator Types et Types Proay 0P General
STATUSES & DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Active Poses a threat and is being exparted to detection toals, O
Expired Mo lenger poses a serious threat. '9)]
Indirect Associated to an actie indicator or event {i.e. pOMS). @
Revlew Requires further analysts: 9)] A5t
Whitelisted Poses NO risk and should never be deplayed, O
O Demo This Is 2 dema '$)]
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian
Camrmand ard Cantral
Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics

ncidert

Lagin Compromise

Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the Event Type you want to edit and click Edit in the far right column.

The Edit Event Type dialog box opens.

Edit Event Type

— Event Name
‘ Ransomware

Save Changes Cancel

4. Enter a new Event Name.

5. Click Save Changes.
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Deleting an Event Type

To delete a user-generated Event Type, complete the following procedure.

-

A Custom Event Types can only be deleted if there are no events using that
event type.

ﬂ You cannot delete an Event Type provided by ThreatQ.

.

Procedure:

1. Navigate to Settings £ > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

DESCRIPTION &

Active Poses a threat and is being exported to detection toals.
Expired Mo longer peses a serious threat.

Indirect Assaciated to.an active indicator or event fi.e. pONS).
Review Requires frther analysts

Whitelisted Poses NO risk and should never be deplayed.

CH N R N N,

O Dema This isa dema
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2. Click the Event Types tab.

The Event Types tab opens.

System Configurations

Indicator Statuses Indicator Types Event Types Frosy LOWP General

25

EVENT TYPES = TOTAL EVENTS & TOTAL INDICATORS &

Anonymizatian

Camrmand ard Cantral

Compromised PKI Certificate
Dis Aftack

Exfltration

Host Characteristics
ncidert

Lagin Compromise
Malware

Spearphish

S0L Injection Attack

Watchlist

o 0 0 0o O 0O D O O = o - o

Watering Hole

3. Determine the event type you want to delete and select the corresponding check-

box in the first column.

4. Click the Delete icon in the upper right hand corner.

A confirmation dialog box appears.

Are You Sure?

Are you sure? This action cannot be undone

Delete statuses | Cancel

5. Click Delete Types.
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Proxy

The System Configuration: Proxy page allows you to enable or disable proxies.

A Users are required to set their proxy server settings to use http: for their
https: traffic. The ThreatQ Proxy Configuration page can be found by nav-
igating to Settings > System Configuration > Proxy.

Access Proxies
To access proxies:
1. Navigate to Settings £*1 > System Configurations.
The System Configurations page opens to the Indicator Statuses tab.

2. Click the Proxy tab.

The Proxy Configuration tab loads.

System Configurations

Indicator Typas Ewant Types Precey LDwR

Enable proxy for HTTP traffic
@ Enable proxy for HTTRS traffic
Protocal

-]
hatpe

Proxy Table Functions:
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Function Description

Enabling a proxy for HTTP or HTTPS 1. Check the correct proxy type and
traffic enter configuration details. Click
Save Changes. ThreatQ will check

that the proxy has been configured

properly.
Disabling a proxy for HTTP or HTTPS 1. Uncheck the proxy you wish to dis-
traffic able, and click Save Changes.

LDAP Authentication

( N

A AGDS Users -If you are using LDAP or SAML authentication on your
Source ThreatQ instance, and require users transferred via import to have
authentication capabilities on your Target ThreatQ instance, then you
must enable the same authentication method on your Target ThreatQ
instance prior to performing import.

- J

ThreatQ allows you to configure system access via LDAP, the Lightweight Directory Access

Protocol. You have two configuration options:

« Anonymous Bind (previously referred to as basic)

« Authenticated Bind

"1

It is highly recommended that you review the Required Information for
Creating LDAP Authentication topic before configuring your LDAP set-
tings.

To Access the LDAP tab:
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1. From the main menu, select Settings 1 > System Configurations.

System Configurations

The System Configurations page opens to the Indicator Statuses tab.

System Configurations

Ak W Staus
Indicanr Statuses whator Types Even Types Proay L0AP General
STATUSES = DESCRIFTION & PROTECT FROM FEED OVERRIDE TOTAL INDICATORS &
Actrn Proses a threat and is being sxported to detection toals, O
Expired Mo longer pedes a serious threat. 8)]
Indirect Associated to an active indicator or event fi.e. pONS). ®))
Resiew Requires further analysts CD 1S5S
Whitelisted Poses NO risk and should never be deplayed. C
O Dema This is a dema '$)]

ThreatQ User Guide, Version 4.39 75



THREA TQ H System Configurations

2. Click the LDAP tab.

The LDAP tab opens with the Legacy LDAP form loaded by default.
THR EATQ in Y & Investigations

System Configurations

Indicator Statuses Indicator Types Event Types Proogy LOwP General

LDAP @ Enabled

Lightweight Directory Access Protocol (LDAF) is a lightweight client-server protocol for accessing directory services and is used for authentication and
storing information. Complete the fields below to set the primary server settings and map your permission levels to LDAP.

egacy LDAP Settings Updated LDAP Settings
Primary Server Settings Map Your Permission Levels to LDAP
Server Addre (Note: You can not list the same LDAP User Group for Mulftiple permission
|dap:/ftgldap.threatg.com levels)
Part # administratar
389

AP Domalr
threatq.com

IldapSuper

Ne N Idapanalyst

memberUid

IdapObs;_‘r_\rer_\
E‘I‘I
Yes . -
Peo-p.;le

uid

Switching LDAP Connections
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To switch between using the Anonymous (Legacy) and Authenticated (Updated) Bind LDAP

connections, open the desired connection type’s form in the LDAP section and click on the

Save button.

4 Y

ﬂ Example: A User is using the legacy LDAP Settings option. He switches
to the Updated LDAP tab and clicks on Save. ThreatQ will now use the
Updated LDAP Settings. If he switches back to the Legacy LDAP tab and
clicks on Save again, ThreatQ will start using the Legacy LDAP settings
again.

Related Topics:

« Required Information for Creating LDAP Authentication

« Configuring Anonymous Bind LDAP Settings

o Configuring Secure LDAP

o Configuring Authenticated Bind LDAP Settings

Required Information for Creating LDAP Authentication

Before you configure a connection to your LDAP server, you should work with your LDAP

administrator to collect, at minimum, the following information:
Anonymous Bind
o LDAP Server URL

LDAP Port

LDAP Group Field Name

LDAP Filter Field Name

LDAP group mappings for super, maintenance, analyst, and observer

Authenticated Bind
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o LDAP Server name or IP Address

o LDAP port

o LDAP base DN

o LDAP Group Member Field Name

o LDAP Primary Group Name

o Whetherto use LDAP over SSL (Idaps or Idap)
o LDAP Userld Key Field Name

« LDAP User Group Member Key Field Name

« LDAP group mappings for super, maintenance, analyst, and observer

Configuring Anonymous Bind LDAP Settings

+ . . . .
O Only users with an Administrative or Maintenance account can access
LDAP settings.

A\ ThreatQuotient strongly recommends that you perform a full backup before
changing your authentication method.

| J

Procedure:
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System Configurations

1. Navigate to Settings £*1 > System Configurations.

2. Click on the LDAP option.

The Legacy LDAP Settings form will load by default.
THREATO i) Threat Library

Ll Analytics

System Configurations

Indicator Statuses Indicator Types Event Types

LDAP

General

@ Enabled

Lightweight Directory Access Frotocol (LDAF) is a lightweight client-server protocol for accessing directory services and is used for authentication and
storing information. Comnplete the fields below to sat the primary server settings and map your permission levels ta LDAP.

f‘g.’l(')l DAP ':!".’If‘Eﬁ l.l'lﬂ.'u[x"ﬂ DAP ‘19_.If'g".
Primary Server Settings
|dap://tgldap.threatg.com
389
AP Do
threatg.com
Mo
memberUid
1 Narr

tn

Yes
Peaple

uid

Map Your Permission Levels to LDAP

{Note: You can not fist the same LDAP User Group for Multiple permission
levels)

administratar

ative Access
IdapSuper

Ida p.‘lkr:.aryst

IdapObserver
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3. Complete the following server settings:

Field Description

Server Address Enter the name of the server where LDAP is hosted.

Example: |dap:/[servername]

Port # 389 for LDAP

636 for LDAPS

"1

If LDAPS is used, the Port # will default
to 636.

LDAP Domain Enter the domain for which LDAP is configured to authen-

ticate.

Example: threatq.com

Append Domain to Choose from the following options:

Username _ _
« Yes for most Active Directory servers

« No for most Open LDAP servers

Filter Field Name This field is specific to your LDAP directory configuration.
AD Example: memberuid

OpenLDAP Example: uid

Group Field Name This field is specific to your LDAP directory configuration.
AD Example: memberof

OpenLDAP Example: cn
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Field Description

Use RDN? Choose from the following options:

« Yes to use Relative Distinguished Names.

« No to use full Distinguished Names

Organizational Unit This field is specific to your LDAP directory con-
(OU) figuration. Your LDAP administrator should provide the

correct value for this field.

User Lookup Name This field is specific to your LDAP directory configuration.
AD Example: memberUid

OpenLDAP Example: uid

4. Complete the MAP your Permission Levels to LDAP section:

"

You can not list the same LDAP User Group for multiple permission
levels. For roles not mapped, you should enter a hyphen: "-." You
cannot save the configuration without entering a value in each field.

Field Example

Maintenance OpenLDAP Example: [dapSuper

Account
AD Example:

CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=com

Administrative OpenLDAP Example: administrator

Access
AD Example:

CN-=linux-admins,CN=Builtin,DC=yourdomain,DC=com
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Field Example

Read Only Access | OpenLDAP Example: IdapObserver

AD Example:
CN=read-onlyCN=Builtin,DC=yourdomain,DC=com

Primary Contributor | OpenLDAP Example: IdapAnalyst

Access
AD Example:

CN=primary-contributor, CN=Builtin,DC=yourdomain,DC=com

5. Click Save Changes.
6. Click on the Enable/Disable toggle switch to enable LDAP.

"1

If your LDAP fails to enable or fails to function properly, validate your
inputs. If the configuration continues to fail, please contact ThreatQ Sup-
port.

Configuring Secure LDAP

'd N\
"l

This topic is for Anonymous Bind LDAP connections only. The steps
needed to create a secured connection authenticated bind are included in
the Configuring Authenticated Bind LDAP Settings topic.

A\ ThreatQuotient strongly recommends that you perform a full backup before
changing your authentication method.

. J

To configure secure LDAP, you must complete the following steps:

1. Enter your LDAP settings in the ThreatQ user interface. See the Configuring

Anonymous Bind LDAP Settings topic for more details.

2. Access the ThreatQ appliance command line as root and edit and navigate to the

following directory: /etc/openldap/.
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3. Use vi to edit Idap.conf and update/confirm that your settings are as follows:

#
# LDAP Defaults
#

# See ldap.conf (5) for details

# This file should be world readable but not world writable.

BASE dc=[your domain],dc=com

URI ldap://[your servername] :389 ldaps://[your servername]:636

#SIZELIMIT 12
#TIMELIMIT 15

#DEREF never
TLS CACERTDIR /etc/openldap/certs

# Turning this off breaks GSSAPI used with krb5 when rdns =
false
SASL NOCANON on

TLS REQCERT allow

( M)

A ThreatQ recommends that you edit Idap.conf on the appliance,
rather than editing off box and uploading it. If you do edit the file off
box, ensure that you use a linux editor. Windows and Mac editors
may corrupt the file.

(& J

If your LDAP fails to enable or fails to function properly, validate your inputs. If the con-

figuration continues to fail, please contact ThreatQ Support.

Configuring Authenticated Bind LDAP Settings

A It is recommended that you contact ThreatQ Support before configuring an
authenticated bind connection.
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"1

Only users with an Administrative or Maintenance account can access
LDAP settings.

Procedure:
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1. Navigate to Settings £*1 > System Configurations.
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2. Click on the LDAP option and select the Updated LDAP Settings tab.
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The Updated LDAP Settings form will load.
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System Configurations

THREAT()

System Configurations

ndCator Statises Indicator Typs Event Types Pray LCAP General

LDAP @) Enabled

Lightwelght Directory Access Protocol (LDAP) [s a lightwelght client-server protocol for accessing directory services and s usad for authentication and storing informarten. Complete the fields
below to set the primary server settings and map your permission levels to LDAP.

pEacy LOKP Settings Updated L&P Sattmngs
Server Connection Settings Protocols
@threatg.com Use 881 Yo

tgad.threatg.com

Map Your Permission Levels to LDAP

(Nate: Woer san nat st the sarme LDAP User Graup for tultiple permissian levels)

administrator

389
tgadmin idapSuper
idapAnalyst
-
’ dapCbserver

Connect To Retrieve Data

LDAP Schema

DC=threatg,0C=com
List Users

dn

user

TEuSErs

memberof

sAMACcountName

uid
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3. Complete the Server Connections Settings section:

Field Description

Account Suffix The LDAP account suffix.

Host Address Name of the LDAP domain controller

without the protocol.

Example: tgldap.threatg.com

Port Number The LDAP port; either 636 or 389.

( N
"

ﬂ Only standard ports for
secured and unsecured
connections are sup-
ported. Use port 636 if
using SSL to create a
secured connection.

\

Admin Usemame The LDAP administrative username.

Admin Password The LDAP administrative password.

4. Click on Test Connections to verify the settings are correct.

5. Complete the LDAP Schema section:

Field Description

Base DN The Base DN of the LDAP server con-

nection.

Example: DC=[server], DC="com"

DN Field Name The field used to retrieve the DN or users

and groups.
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Field Description

/' This field should be
DN for both OpenLDAP
and Active Directory.

User Search Filter The field to search for users.

For

OpenLDAP: objectClass=posIxAccount

For Active Directory: objectClass=user

Group Search Filter The field to search for grpups.
For OpenLDAP: objectClass=posIxGroup

For Active Directory: objectClass=group

Primary Group Name The primary group hame.

Group Member Field Name This field is used to search for groups that a

user belongs to.
For OpenLDAP: cn

For Active Directory: memberof

User ID Key Field Name Field used to search for users based on

email.
For OpenLDAP: uid

For Active Directory: sSAMAccountName

User Group Member Key Field Name | Field used to search for groups that user
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Field Description

belongs to.

For OpenLDAP: memberUid

For Active Directory: uid

6. Under the Protocols section, use the Yes/No toggle switch to select whether the

connection will use SSL.

"1

If the connection will use SSL, confirm that the port number, setin
step 3, is 636 to create a secured connection.

7. Complete the MAP your Permission Levels to LDAP section:

"1

You cannot use the same LDAP User Group for multiple permission
levels. For roles not mapped, you should enter a hyphen: "-." You
cannot save the configuration without entering a value in each field.

Field Description

Maintenance Account | The LDAP account the ThreatQ Maintenance group will

map to for permissions.
Open LDAP Example: IdapSuper

AD Example:
CN=tg-maintenance,CN=Builtin,DC=yourdomain,DC=com

Administrative Access | The LDAP account the ThreatQ Administrative group will

map to for permissions.

Open LDAP Example: administrator
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Field Description

AD Example:

CN-=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Primary Contributor The LDAP account the ThreatQ Primary Contributor group

Access will map to for permissions.
Open LDAP Example: IdapAnalyst

AD Example:

CN=linux-admins,CN=Builtin,DC=yourdomain,DC=com

Read-Only Access The LDAP account the ThreatQ Read-Only group will map

to for permissions.
Open LDAP Example: IdapObserver

AD Example:
CN-=read-onlyCN=Builtin,DC=yourdomain,DC=com

8. Use the Connect to Receive Data section connect to your LDAP using the settings

on this page to pull group information and user lists
9. Click on Save.

10. Click on the Enable/Disable toggle switch to enable LDAP.

ﬂ Green indicates the feature is active.
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SAML Authentication

Security Assertion Markup Language (SAML) is a single sign-on (SSO) standard that allows

you to log into your ThreatQ instance using a credentials service outside of the platform.

Email addresses and passwords are authenticated outside of ThreatQ and user roles are

determine using the permissions mappings located on the ThreatQ SAML configuration

page.

Upon enabling SAML, users will see a SSO login option on the ThreatQ login page - see the
Logging into ThreatQ topic.

'd N\

ﬂ Users cannot use SSO to log into a ThreatQ Local Maintenance account.

A AGDS Users -If you are using LDAP or SAML authentication on your
Source ThreatQ instance, and require users transferred via import to have
authentication capabilities on your Target ThreatQ instance, then you
must enable the same authentication method on your Target ThreatQ
instance prior to performing import.

| J

Related Topics:

o Configuring SAML

« Adding ThreatQ as a Service Provider

o Setting up LDAP Users/Groups for SAML

« Authentication Methods

o Transitioning Authentication Methods
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Configuring SAML

-

A ThreatQuotient strongly recommends that you perform a full backup before
changing your authentication method.

ﬂ' SAML users are required to add their email address to their user profiles in
order to use the SSO. As part of the integration process, the ThreatQ plat-
form expects that the user's email address has already been added to
their IdP. See the Setting up LDAP Users/Groups for SAML topic for

ohserves Properties [4 =
q Mesber OF Daiin Emvionment Sossons
1 Femote cortrol Femote Desidop Services Profile COme
Germr@  Addess  Accout Profie  Telephones  Orpanaation
i
i 33 ohisrvar
fl
a
J Fistname chearver niticle:
A Lastname
|
Dispiay name chserver
1 Descwption
"
Office:
Tedephone rumber Other

J

LDAP must be disabled before enabling SAML. The ThreatQ platform will alert you if LDAP
is enabled when you try to enable SAML and will instruct you to disable LDAP.

1. From the main menu, select Settings 1 > System Configurations.

The System Configurations page opens.
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2. Click on the SAML tab.

The SAML configuration page opens.
THREATQ ) & treioray & ivestisons s s

System Configurations

indicator Types  Event Type Proxy DA saml General

SAML @D Encbled

Security Assertion Markup Language (SAML) is a single sign-on standard used for logging users into applications based on their sessions in another context, Complete the fields
below to set the primary server settings and map your permission levels t@ SAML,

Connection Infarmation - Identity Provider Mapping Permission Levels
Provide either an XML configuration file or a configuration URL below. Wote: You can nat list the same SAVAL User Group for multiple permissian levels)
When you provide ane methad, the other method will autopopulate.

Provide IDP Metadata File Administrative Access

Bl rederationMetadataxml  download [ test rest

Provide IDP Metadata URL

Primary Contributor Access
https:/7adis.threatg.comiFederationMetadata/2007-06/Federationhets v

Connection Information - Service Provider Information

Read Only Access

Service Provider Metadata File

B threatg-spaxml

Service

3. Complete the Identity Provider (IdP) section by either:

« Uploading your IdP metadata file by dragging and dropping the file onto the
field or using the browse button to locate the file saved on your local

machine.

« Entering your IdP metadata file’s URL in the Provide IdP Metadata
URL field.
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Connection Information - Identity Provider

Provide either an XML configuration file or a configuration URL below. When you
provide one method, the other method will autopopulate.

Provide IDP Metadata File

o

Drag your files here or click to browse

Provide IDP Metadata URL

ﬂ Whichever method you choose to use will result in the auto-
completion of the other field. Example: Uploading a metadata
file will resultin the IdP Metadata URL being populated with
data parsed from the file.

. J

4. Use either the Service Provider Connection URL or Service Provider Metadata
file listed in the Connection Information - Service Provider Information section to
provide your ThreatQ platform metadata to your Network Administrator to add
ThreatQ as a service provider. The steps to add ThreatQ as a Service Provider

may differ based on your environment - See the Adding ThreatQ as a Service Pro-

vider
Connection Information - Service Provider Information
In arder for your IDP to connect to this platform, you must provide either

this Service Provider's Connection URL or upload the Service Provider
Metadata File (which can be downloaded below) in your IDP.

Service Provider Metadata File

E'I threatg-sp.xmil

5. Check the User Server Certificate and Key option under the Platform Server Cer-
tificate Information section if your environment requires a certificate. You can

upload the Certificate and .key file by either:

ThreatQ User Guide, Version 4.39 96



THREAT() AR~ SAML Authentication

« Drag and drop the file into the field.

« Select browse to locate the file on your local machine.

You Network Administrator will need the certificate and key
later when applying the ThreatQ platforms connection inform-
ation supplied in step 4.

6. Complete the Mapping Permissions Levels section by providing a SAML Attribute
Key and SAML Attribute Value for each ThreatQ user role. See the Setting up
LDAP Users/Groups for SAML topic for information on how to setup LDAP users

and groups for SAML integration.

Mapping Permission Levels

(Note: You can not list the same SAML User Group for multiple permission levels)

Administrative Access

Primary Contributor Access

Read Only Access

Mapping Notes:

« SAML cannot be used for Maintenance Accounts.
« Local Maintenance Accounts cannot be mapped when enabling SAML.

« If converting from LDAP authentication, LDAP groups that were
mapped to the ThreatQ Maintenance role will have to be mapped to

another user role.

« You cannot use the same SAML Key and Values for multiple roles.
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« You do not have to map all ThreatQ roles but at least one role has to be
mapped to use SAML. Example: Administrator and Primary Contributor will

be mapped but the Read Only Access role will be blank.
7. Click on Save located at the bottom of the page.

8. Confirm that your network administrator has completed Adding ThreatQ as a Ser-

vice Provider before proceeding with the final steps listed below.

9. Click on Test Authentication to confirm that the ThreatQ platform and your IdP can

connect.

10. Click on the Enable toggle switch located at the top-right of the page to enable
SAML.

Setting up LDAP Users/Groups for SAML

The following steps detail how to set up LDAP users and groups for SAML integration.
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1. Log into the Windows Server.

2. Start the Active Directory Users and Computers application from the Start Menu.

Best match

~ = Active Directory Users and Computers
: Desktop app

Apps >
E Active Directory Administrative Center

gy Active Directory Sites and Services

@ Active Directory Domains and Trusts

Active Directory Module for Windows
PowerShell

t1  Active Directory Lightweight Directory
Services Setup Wizard

Settings >

(0 Disconnect your device from your work or
school

ttd Choose when to turn on touch keyboard
when Narrator is on

B & [Oh 0 B o™

Active |

3 threatq.com
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4. Click on Actions > New > Group.

[ Active Directory Users and Computers

File = Action View Help

= Delegate Control... ‘ !., T HE EE;
- Move... ~
. ime ype
24 7 D
Find...
P admin arcess nne Lzer
ML New > Computer
All Tasks > Contact
Refresh Group
Export List... InetOrgPerson
A 7 msDS-ShadowPrincipalContainer
ke mslmaging-PSPs
Help MSMQ Queue Alias
2| LDAPTEST Ei Organizational Unit
| Managed Service Accour Printer

w [2] UserAccounts ==
2| Admins
v & Standard Shared Folder

5. Enterin the Group name and click on OK.

New Object - Group X

% Createin: threatg.com/Groups

Group name:
| S50 Group| |

Group name (pre-Windows 2000):

{ S50 Group |
Group scope Group type
(O Domain local (®) Security
(®) Global (O Distribution
(O Universal

[ o
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6. Selectthe Users folder and click on Actions > New > User.

] Active Directory Users and Computers

File = Action View Help

== Delegate Control... o) ‘ 3_; RT3 fsg
— Find... =
= A ime Tune n
: 5 > Computer
v All Tasks > Contact ,
Refresh Group /
Export List... InetOrgPerson

msDS-KeyCredential

h et msDS-ResourcePropertyList b
Help msDS-ShadowPrincipalContainer ’
: ':" —ThreatQ mslmaging-PSPs

MSMQ Queue Alias
Printer

User

Shared Folder

o LDAPTEST
Managed Service Accout,

Le

v 3 UserAccounts
o Admins
v & Standard

BB AR 1B ra sa o

7. Enterin the User Information and click on Next.

New Object - User X

Createin:  threatq.com/Users
3

First name: Initials: I:l
|
|

Last name: \User

Full name: [Pat User

User logon name:

|pat| | @threatq.com v

User logon name (pre-Windows 2000):
|TH REATGO\ | |pat

< Back Next > Cancel

ThreatQ User Guide, Version 4.39

101



THREAT() /o~

SAML Authentication

8. Enter the Password and click on Next.

New Object - User X

; Create in:  threatg.com/Users
d

Password: l..ll.lllll..lll ‘

Corfirm password: loooooooooooouo ‘

User must change password at next logon
[] User cannot change password

[[] Password never expires

[] Account is disabled

< Back Next > Cancel

9. Confirm that the details are correct an then click on Finish.

New Object - User X

‘; Createin: threatq.com/Users

<

When you click Finish, the following object will be created:

Full name: Pat User
User logon name: pat @threatq.com

The password never expires.

< Back Cancel

10. Find and double-click on the newly created user to edit the User Properties.
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11. Confirm that the E-Mail has the user's correct email address.

Pat User Properties ? X
Member Of Dialin Environment Sessions
Remote control Remote Desktop Services Profile COM+

General  Address  Account  Profle  Telephones  Organization

& Pat User

Last name: | User

Description: |

|
Display name: |F‘al User I
|
|

Office: |

Telephone number: | ‘ Cther...

E-mail: |pat@lhrea1q.com|

Web page: | ‘ Cther...

G ] o]

A\ ltisimportant that the E-mail field be filled in order for the SSO integ-
ration to work with this user.
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12. Navigate to the Member of tab and click on Add.

Domain Users threatq.com/Users

e

Primary group: Domain Users

Set Primary Group

applications.

Concel || rony

There is no need to change Primary group unless
you have Macintosh clients or POSIX-compliant

Help

Pat User Properties 4 X
Remote control Remote Desktop Services Profile COM+
General Address  Account Profile Telephones  Organization
Member Of Dialin Environment Sessions
Member of:
Name Active Directory Domain Services Folder

13. Enter the name of the group you created earlier in steps 4-5 in the field provided.

Select Groups

Select this object type:
|Gmups or Built-in security principals

From this location:

|threatq .com ‘

Enter the object names to select (examples):

} Object Types...

Locations...

X

S5O Group|

Advanced...

Check Names

Cancel

14. Click on Check Names to verify the group name and then click OK.

ThreatQ User Guide, Version 4.39

104



THREAT() A

SAML Authentication

15. Verify that the User is now a member of the group.

Pat User Properties ? X
Remote control Remote Desktop Services Profile COM+
General Address Account Profile Telephones Organization
Member Of Dialin Environment Sessions
Member of:
Name Active Directory Domain Services Folder
Domain Users threatq.com./Users
SS0 Group threatq.com/Groups
Add... Remove
Primary group: Domain Users

There is no need to change Primary group unless
you have Macintosh clients or POSIX-compliant
applications.

Set Primary Group

Cancel Apply Help

16. Click OK to close the properties window.

Adding ThreatQ as a Service Provider

The topics in this section provide the required steps to add ThreatQ as a service provider for

your IdP.

« ADFS 2016

Azure AD Provider Setup

Google G Suite Service Provider Setup

Okta Service Provider Setup

ADFS 2016

The steps below detail how to add ThreatQ as a service providerin ADFS 2016 .
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From your server manager.:

N

. Select AD FS under the Dashboard heading.

Click on the Tools option and select AD FS Management.

Navigate to the Relying Party Trusts folder In the left-hand directory.

Click on the Relying Party Trusts > Add Relying Party Trust under the Actions
heading.

Leave the Claims Aware option selected and click on Start.

The Select Data Source section loads.

@1 Add Claims Provider Trust Wizard x
Select Data Source

Steps.
® Welcome

Select an option that this wizard will use to obtain data about this claims provider:

@ Import data about the claims provider pubished oniine or on a local network
@ Select Data Source
= Use this option to import the necessary data and certficates from a claims provider organization that
@ Ready to Add Trust publishes fts federation metadata online or on a local network.

@ Finish Federation metadata address {nost name or URL)

[

Example: fs fabrikam.com or https:/fs fabrikam.com/

O Import data about the claims provider from a file

Use this option to import the necessary data and certficates from a claims provider organization that has
provided its federation metadata in a file

Federation metadata file location:

() Enter claims provider trust data manually
Use this option to manually input the necessary data about this claims provider organization

Confirm that the first radio option, Import data about the claims provider published

online..., is selected.

Paste the Platform Connection URL located on the ThreatQ SAML page, step 4
on the Configuring SAML topic, into the Federation Metadata Address field in the

following format:

https://<your hostname>/FederationMetadata/2007-06/Feder-

ationMetadata.xml
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8. Click Next.

11.

12.

13.
14.
15.
16.

A popup warning will appear stating that some metadata cotent was skipped.
AD FS Management -

Some of the contert in the federation metadats was sopped because & is not supported by AD FS. Review the properties
B, of the trs carsluly badove you save th taus 1 the AD FS confpumton databass

oK

Click Ok to proceed.

. Continue through the next few sections by clicking Next until you reach the Ready

to Add Trust page.

Review the information listed in the multiple tabs provided. Confirm that the proper
certificates are listed under the Certificate and Signature tabs and upload any that

are missing.

Click Next.

The ThreatQ Relaying Party Trust has now been added. The next step to create 4 new

Claims Rules for the new service provider.

Contact your Network Administrator to receive the appropriate group
mapping.

Click on Add Rule.
Select the Send LDAP Attribute as Claims claim rule template and click Next.
Enter a name for the rule. Example: email and UID.

Select the Active Directory as the Attribute Store.

Active Directory must already be installed and enabled in order to
complete this step
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17.

18.
19.
20.
21.
22.
23.

24.
25.
26.
27.
28.
29.

30.
31.
32.
33.

Add the following rows in the LDAP Mapping Attributes table:

LDAP Attribute Outgoing Claim Type

E-Mail-Addresses email

SAM-Account-Name uid

Click on OK to create the rule.

Click on Add Rule.

Select the Send LDAP Attribute as Claims claim rule template and click Next.
Enter a name for the rule. Example: Email.

Select the Active Directory as the Attribute Store.

Add the following row in the LDAP Mapping Attributes table:

LDAP Attribute Outgoing Claim Type

E-Mail-Addresses E-Mail Address

Click on OK to create the rule.

Click on Add Rule.

Select the Send LDAP Attribute as Claims claim rule template and click Next.
Enter a name for the rule. Example: Groups.

Select the Active Directory as the Attribute Store.

Add the following row in the LDAP Mapping Attributes table:

LDAP Attribute Outgoing Claim Type

Token-Groups - Unqualified Names SSO

Click on OK to create the rule.
Click on Add Rule.
Select the Transform an Incoming Claim claim rule template and click Next.

Enter a name for the rule. Example: Named ID Transform.
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34. Complete the following fields:

Field Selection

Incoming Claim Type E-Mail Address
Outgoing Claim Type Name ID
Outgoing Name ID Format Email

35. Select the Pass through all claim value radio option.
36. Click on OK to create the rule.

37. Click OK to close the Issuance Transform Rules dialog box.

Azure AD Provider Setup

The steps below detail how to add ThreatQ as a service provider in Azure AD. This process

is required in order to complete the SAML setup.
Setting Up the SAML App

1. Log in to the Azure portal with administrator permissions.
2. Go to Azure Active Directory > Enterprise applications
3. Click on +New Application then Non-gallery application.
4

. Enter an application name such as ThreatQ then click Add.
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5. Enter the Single Sign On URL and SP Entity ID as follows:
Basic SAML Configuration
L1 " 2
Identifier (Entity ID) https://10€. 877 10D/ api/sami/metadata
Reply URL (Assertion Consumer Service URL) https:// 19108177, .00/api/saml/acs
Sign on URL Optional
Relay State Optional
Logout Url Optional
e User Attributes & Claims f
givenname user.givenname
surname user.surname
emailaddress user.mail
name user.userprincipalname
uid user.mail
Groups user.groups
Unique User Identifier user.userprincipalname
Field Value Description
ACS/ | https://threatq.example.com/api/samle/acs Assertion Consumer
Single Service (ACS) is the
Sign ThreatQ URL +
on appended the “/ap-
URL i/saml/acs” string.
This is the ThreatQ
sp entity ID which is the
_ https://threatq.example.com/api/samle/metadata | ThreatQ URL +
Entity _
D appended with the
“lapi/saml/metadata”
string.

6. Setthe Unique User identifier (Name ID) format to Email Address.
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7. In the Additional claims section add uid and set the value as user .mail.

Both the username and uid attributes are required and must be
mapped to the user's Email address.

8. You also need to add an attribute you want to map to the roles in ThreatQ. In this
example we added a Claim and created a Groups attribute and mapped it to all user-

.groups assigned to the application. The group id the user belongs to is then included

in the SAML assertion upon login.

Home ThreatQ Enterprise applications | All applications hreatQ | Single sign-on

User Attributes & Claims

+ Add new claim -t Add a group claim Columins

Required claim

Claim name

SAML-based Sign-or User Attributes & Claims

Value

Unique User Identifier (Name ID)

user.userprincipalname [nameid-f..

Additional claims
Claim name
Groups
http://schemas xmlsoap.org/ws/2005/05/identity/claims/emailaddress
http://schemasxmlsoap.org/ws/2005/05/identity/claims/givenname
http://schemas.xmlisoap.org/ws/2005/05/identity/claims/name
http://schemasxmlsoap.org/ws/2005/05identity/claims/surname

wid

Value

USEr.groups

user.mail
user.givenname
user.userprincipalname
user.surname

user.mail

When adding a group claim itis recommended to customize name as this is what is

required to be entered on the ThreatQ side as the SAML Attribute Key. This should not

contain a namespace otherwise the full claim name will need to be entered - see

http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname for more inform-
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10.

ation. See the example below:

Group Claims

Manage the group daims used by Azure AD to populate SAML tokens issued to your app

Which groups associated with the user should be returned in the claim?

O None

O All groups

O Secunty groups
O Directory roles

’i‘ Groups assigned to the application

Source attribute *

| Group ID

Advanced options
Customize the name of the group claim

Name (required)

Groups

Namespace (optional)

|

|:| Emit groups as role claims @

On the Assignments tab, verify that each of the users or groups that should have

access have been assigned to the application.

Under SAML Signing Certificate, click the Download link for the Certificate
(Base64) and the Metadata file. These files are required in steps 4 and 5 in the
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Configuring SAML topic.
O SAML Signing Certificate V4
Status Active
Thumbprint 1DA399F6A24D8BE762A855939148E4D3B0662325
Expiration 4/29/2023, 5:06:02 PM
Notification Email bzl il sihesd_am
App Federation Metadata Url https://login.microsoftonline.com/954a89d9-e0... E

Certificate (Basebd) download
Certificate (Raw) Download
Federation Metadata XML Download

Google G Suite Service Provider Setup

The steps below detail how to add ThreatQ as a service provider in Google's G Suite. This

process is required in order to complete the SAML setup.
Setting Up the SAML App

1. Log into your Google Administrative Console.
2. Navigate to Apps > SAML Apps.

3. Click on the + icon located at the bottom-right on the page.
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4. Selectthe Setup my own custom app option.

Step 1 x

Enable SSO for SAML Application

Select an service/App for which you want to setup SSO

Services Provisioning supported

15Five v >
4Me >
7Geese >
Accellion >
Adaptive Insights >
Adobe v >
Adobe Sign >

SETUP MY OWN CUSTOM APP

The Google IdP information page loads.

Step20f5 x
Google IdP Information

Choose from either option to setup Google as your identity provider. Please add details in the SSO
config for the service provider. Learn more

Option 1
SSOURL https://accounts.google.com/o/saml2/idp?idpid=C03mI9s|6
Entity ID https://accounts.google.com/o/saml2?idpid=C03mI9sl6
I 23-5-17-115147_SAML2.
Certificate Google_2023-5: 5147_S. 0
Expires May 17,2023

4 DOWNLOAD
Option 2
IDP metadata 4 DOWNLOAD
PREVIOUS CANCEL NEXT

5. Click on Next.
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6. Complete the Basic Information for Your Custom App fields:

Field Description Example
Application Name | The name of the application. ThreatQ
Description What function the app will serve. | SSO for ThreatQ Platform

Step3of5 X
Basic information for your Custom App

Please provide the basic information needed to configure your Custom App. This information will be
viewed by end-users of the application.

Application Name *

Description

Upload logo [l]J CHOOSE FILE

This logo will be displayed for all users who have access to this application.
Please upload a .png or .gif image of size 256 x 256 pixels.

PREVIOUS CANCEL NEXT

7. Click on Next.
8. Complete the Service Provider Details fields:

Field Description Example

ACS Assertion Consumer https://threatq.example.com/api/saml/acs
URL Service is your

ThreatQ URL + appen-
ded the “/api/saml/acs”

string.

Entity | The Entity ID is your https://threatq.example.com/api/saml/metadata
ID ThreatQ URL + appen-
ded with the “/ap-
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Field

Description

i/saml/metadata” string.

Example

Name

Format

Set this field to Email.

N/A

Step4of 5

Service Provider Details

Please provide service provider details to configure SSO for your Custom App. The ACS url and Entity

ID are mandatory.

ACS URL *

Entity ID *

Start URL

Signed Response

Name ID

Name ID Format

PREVIOUS

O

Basic Information Primary Email

UNSPECIFIED

CANCEL NEXT
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9. Click on Next.

The Attribute Mapping page loads.

Step50f 5 X

Attribute Mapping
Provide mappings between service provider attributes to available user profile fields.

Some providers require you to map application attributes to user fields. You should check the
application's documentation to see if this is required. You can always come back later to complete the
mapping.

There are currently no mappings for this application

ADD NEW MAPPING

PREVIOUS CANCEL  FINISH

10. Click on Add New Mapping.

A The email and uid attributes must be mapped to the Primary Email
field.

11. Create the email mapping:

Attribute Type Google Data Field

email Basic Information | Primary Email

12. Click on Add New Mapping.

13. Create the uid mapping:

Attribute Type Google Data Field

uid Basic Information | Primary Email

14. Click on Add New Mapping:
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15. Create the SSOGroup mapping for ThreatQ roles:

Attribute Google Data Field

SSOGroup | Employee Details | < specific to your company >

i)

Any attribute can be used for this mapping other than Employee ID.
See the Creating custom attributes using the user schema Google
support article for instructions on creating custom attributes to use for
role mapping.

A\ J

16. Your setup should now resemble the following screenshot:

~ Attribute Mapping
Provide mappings between service provider attributes to available user profile fields.

email Basic Information Primary Email
SS0Group Employee Details Department

uid Basic Information Primary Email

ADD NEW MAPPING

17. Click on Finish.

18. Locate your new app under Apps > SAML Apps, click on the vertical ellipsis, and
select On for Everyone.

19. Click on the app to open its settings details.

20. Click on Service Provider Details.

The Service Provider Details page opens.

~ Service Provider Details
Please provide service provider details to configure S50 for tkwok_saml_test. The AGS url and Entity D are mandatory.
ACS URL * https://te-23382 threatq.com/api/saml/acs
Entity ID * https://te-23382.threatq.com/api/ saml/metadata
Start URL

Certificate Google_2023

Signed Response ]

Name D Basic Information Primary Email

Name ID Format e
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21. Click on Manage Certificates.

22. Download the certificate and the |dP Metadata files that are required in steps 4
and 5 in the Configuring SAML topic.

Okta Service Provider Setup

The steps below detail how to add ThreatQ as a service provider in Okta. This process is

required in order to complete the SAML setup.

1. Log into the Okta web application.

2. Click on the Admin button located to the top-right of the screen.
The Dashboard page loads.
3. Click on the Applications tab.
The Application page loads.
4. Click on Add Application.
The Add Applications page loads.
5. Click on Create New App.
The Create New Application dialog box opens.

6. Select Web from the Platform dropdown.
7. Select SAML 2.0 for the Sign on method.

8. Click on the Create button.
The Create SAML Integration page opens with the General Settings tab selected.

9. Enter a name for the app in the App Name field.
10. Click on Next.

The Configure SAML section loads.
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11. Complete the following fields:
Field Entry/Selection Notes
Single sign | https://< Host-name | The Assertion Consumer Service (ACS) is
on URL >.com/api/saml/acs | your ThreatQ URL + appended the “/ap-
i/saml/acs” string.
Audience | https://< Host-name | The Audience URIis your ThreatQ URL +
URI >/api/saml/metadata | appended with the “/api/saml/metadata”
(SP Entity string.
ID)
Default https://< Host-name | The Default RelayState is your ThreatQ URL
RelayState | >/api/saml/acs + appended with the “/api/saml/metadata”
string.
Name ID EmailAddress
format
Application | Email ThreatQ requires that this field be set to
username Email.
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12. Scroll down to the Attribute Statements section and add the following attribute:

Add Another

Name Name Format Value

uid Unspecified user.email

13. Add the required attributes to the Group Attribute Statements that will be used to
map Okta groups to ThreatQ user roles. In the example image below, an attribute
called SSORole was created and is mapped to all Okta group names that starts
with TQ.

SSORole Unspecified v Starts with v TQ

"l

See Okta's Custom Expression help article for additional information
on assigning an attribute.

14. Click on Preview the SAML Assertion to confirm that the settings are correct.

15. Click on Next.
The Feedback section loads.

16. SelectI'm a software vendor. I'd like to integrate my app with Okta and then click

on Finish.
The Application details page loads.

17. Click on the Assignments tab.
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18. Click on the Assign dropdown and select Assign to Groups.

19. Assign the app to groups that will be used to map ThreatQ roles.
20. Click on Save and Go Back.

21. Click on Done.

22. Click on the Sign On tab.

23. In the Sign On Methods section, right-click and download the Identity Provider

metadata file.

24. Click on the View Setup Instructions button.

You will be able to review URL information such as the Identity Provider Single Sign-
On URL, Identity Provider Issuer, and the X.509 Certificate.

25. Click on Download Certificate. The certificate and Identity Provider metadata file

downloaded in step 23 are required in steps 4 and 5 in the Configuring SAML

topic.

Date and Time Format

You can configure the date and time format of your choice system-wide within the ThreatQ

platform.

If you make changes to the date and time format while another user is
working concurrently in the same ThreatQ installation, that user must
refresh their browser for the changes to take effect.

Related Topics:

o Configuring Date and Time Format
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Configuring Date and Time Format

1. Navigate to Settings £*1 > System Configurations.

The System Configurations page opens to the Indicator Statuses tab.

Active Poses a threat and is being exparted to detectian toals, O
Expired Mo |onger poses a serious threat. 9))]
Indirect Associated to an active indicator or event {i.e. pOME). 8))]
Revlew Requires further analysis: §)] |
Whitelisted Prses NO risk and should never be deplayed. O
O Dema This is 3 dema @

2. Click the General tab.

The Date and Time Format tab opens.
THREAT() 9

System Configurations

Ingiganar Statuses ndicatar Types Ewent Types Py L

B
| -u

DATE AND TIME FORMAT

Date Format Time Format
MM/DDAYYY @ 12 haur -]
DDMMAYYY 24 haur

Y MMDD

3. Select the desired Date Format. Options include: MM/DD/YYYY, DD/MM/YYYY,
YYYY/MM/DD

4. Selectthe desired Time Format. Options include: 12 hour, 24 hours.

5. Click Submit to save your settings.
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Traffic Light Protocol (TLP)

Traffic Light Protocol (TLP) schema provides a set of designations used to ensure that sens-
itive information is shared with the appropriate audience. ThreatQ provides a method for des-
ignating the availability of intelligence information by their sources. Users can also use TLP

schema to filter objects when creating an export - see the Adding an Export topic for more

details.

Administrators have the ability to configure TLP visibility settings for the ThreatQ application.
THREATQ )

Data Management
Jematic Exgpiralic Seoring Whitelsied Indicatar
TLP (Traffic Light Protocol) Enabled

TLF I5 a set of des|gnations used to ensure that sensitive information i shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by thair
sources. TLP employs four colors to indicate expected sharing boundaries for data,

Sowice Mame Default TLP
abuse ch Feodo Tracker Botnet C2 IP Blocklist NOME
admin@thraatg.com NOME
Analyst@threatg.oom NOME
ATTELCK Tooks @ RED

Cofense Inteligence NOME

TLP employs four lights to indicate the expected sharing boundaries for data:

Light | Designation Description
® Red Not for disclosure, restricted to participants only.
Amber Limited disclosure, restricted to participant's organizations.
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Green Limited disclosure, restricted to the community.
White Disclosure is not limited.
TLP Assignment Hierarchy

The ThreatQ TLP assignment hierarchy is as follows (highest to lowest precedence):

Method Details
Manually Using the Add New Source option when creating an object will allow
Set you to select a TLP designation.
Source
Provided TLP information received from ingested data.
Data
Source Administrators can set a source's default TLP designation. See the
Default Apply TLP Designation to Source topic for more details.
No TLP A TLP designation has not been set for the source.
Access TLP Settings

Users can manage TLP settings for system sources by accessing the TLP tab under the

Data Management page.

1. From the main menu, select Settings 1> Data Management.

The Data Management page will load with Automatic Expiration tab selected by
default
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2. Click on the TLP tab.

The TLP Setting page will open.

THREATQ )

Data Management

Auioenatic Expiation  Scering Whikeksted Indicatars

TLP (Traffic Light Protocal) ) cnabled

TLP Is a set of designations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intelligence information by their
sources. TLF employs four colors to indicate expected shanng boundarias for data,

Source Hame Detault TL?
abuse ch Feods Tracker Batnetl £2 1P Blocklist NOMNE
admin@thraatg.com NONE
Analyst@threaty com NONE
ATTRCK Took @ RED

Cofense Inteligence HONE

Configure TLP Visibility

System administrators can set visibility settings to either hide or show TLP designation lights

to users.

From the TLP Settings Page (see the Access TLP Settings topic):
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1. Click on the Enable/Disable toggle switch.
THREATQ )

Data Management

Automatic Expiration Seoring
TLP (Traffic Light Protocol) @ enabled

TLP Is a set of des|gnations used to ensure that sensitive information s shared with the appropriate audience; it provides a method for designating the avallability of intalligence information by their
sources. TLP emplays four colors to indicate expected shanng boundaries for data, i I K

Source Name Detault TLP
abwge ch Feods Tracker Botnet C2 1P Blocklist NOMNE
admini@threatg.com NONE
Analyst@threatg.com NONE
ATTECK Took @ RED

Cofense Intefligence NONE

Enabled indicates that TLP designations are visible to users.

"

Administrators will not need to click on the Save button, changes
will be made upon clicking on the switch.

Apply TLP Designation to Source

From the TLP Settings Page (see the Access TLP Settings topic):

1. Locate the source to update from the list provided.
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e A
&
E' You can use the Filter by Source Name field to locate the desired
source.
THREATQ 3
Data Management
sulornatic Expiration  Seoring Whiteissed indicatars
TLP (Traffic Light Protocol)
TLP is a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it provides a methed for designating the avallability of intelligence inform
sources. TLF employs four colors to indscate expected sharing boundaries for data. b rk
Source Name Default TLP
caf
Cofense Intelligence NONE
- J

2. Click on the TLP dropdown to the right of the source and select the appropriate

TLP designation.
THREATQ )

Data Management

Ausomartic Expisation

scoring T Wwihitalisted indicatars

TLP (Traffic Light Protocol) ) Enabled

TUP s a set of designations used to ensure that sensitive infarmation is shared with the appropriate audience; it prosides a method for designating the availability of intelligence information by their
spurces, TLP employs four colors to indicate expacted shanng boundaries for data, How it work

Saurce Nams Default TLP
LP Status
abiuse.ch Feodo Tracker Botnet C2 IP Blocklist NOME
L L=
adrnin@threatg eam AMEBER -
GREEN
Analyst@threaty com WHITE
NENE
ATTRLCK Tools & RED
Cofense Intelligence NOME

3. Click on Save.
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You can override a source-default TLP designation when manually
adding a source to an object. See the Adding a Source to an Object topic
for more details.

Update TLP Schema using TLP Default - Command

Use the following command to update the TLP schema for an Object Source or Object Attrib-

ute Source with the source's default TLP designation.

See Apply TLP Designation to Source topic for more details on setting a
default TLP designation for a source.

You should use this command to update your system to match default TLP configurations,
specifically attributes and sources that were added to the Threat Library prior to the release
of the TLP feature introduced with ThreatQ 4.11. This command will override previous

TLP schema settings for a source including ones set by users. You will be prompted to con-

firm the action after entering the command. All updates will be recorded in the audit log.

The command will update using the default TLP designation. If a default
designation is set to None, all references to the source will be updated to
None.

Update All Sources
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:
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sudo php artisan threatqg:apply-tlp-defaults

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.

5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.

Update a Specific Source
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Run the following command:

sudo php artisan threatqg:apply-tlp-defaults —--

sources="<your source>"

* . . .-
G You can apply the command to multiple sources by listing the
sources in a comma-delimited format.
Example: --sources="CrowdStrike, AlienVault"

4. The application will warn you that this action is not reversible and will require user

confirmation before proceeding.
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5. Type Yes to confirm and proceed with the action.

The application will automatically be placed into maintenance
mode. After the command has completed its operation, the applic-
ation will be automatically be brought out of maintenance mode.

Convert TLP Command

Use the following command to update all object sources and object attribute sources that
have TLP stored as an object attribute. This command will not affect TLP attributes that have
already been converted. Users should use this command for new incoming data, such as

migrating data into the system, which has TLP attributes but no TLP set.
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:convert-tlp-attributes

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Use Scenarios:

Object has one or more TLP Attributes with an invalid TLP (not currently in the TLP

options)
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« Ifthe Object has just one TLP Attribute - none of its Sources or Attribute Sources

will be updated.

« Ifthe Object has more than one TLP Attribute - any Sources or Attribute Sources

that match the Attribute Source of the TLP Attribute will not be updated.
Object has a single valid TLP Attribute

« All of the Object Sources and Object Attribute Sources will be updated to match the
value of the TLP Attribute.

Object has multiple TLP Attributes

« Each TLP Attribute will be evaluated separately.

« Any Object Sources or Object Attribute Sources whose source matches that of the

TLP Attribute will be updated with the value of the TLP Attribute.

« Any Object Sources or Object Attribute Sources whose sources do not match will

not be updated.

« Ifthere are no matches at all between the source of the TLP Attribute and any of the
Object Sources or Object Attribute Sources, a new Object Source will be added using
the Attribute's TLP value. Each of the Object Attributes will receive a new Object Attrib-

ute Source with the TLP value as well.
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Job Management

"l

The Job Management page is only accessible to users with Administrator
or Maintenance accounts.

The Job Management page allows you to view the status and outcome of Bulk Actions.

To access the Job Management page:

1. Navigate to Settings 1 > Job Management.

Job Management

2 threalg@heealg.com Update

thraatg@henatg.com Upcate

Related Topics:

« Viewing Job Details

Viewing Job Details

The Job Management page allows you to view the following details about a Bulk Action job:

Field Description

Job ID The unique ID assigned to the job.
Author The user that initiated the job.
Action The Bulk Action selected.
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Field Description

Search Cri- _ _ _
e The search filters used to select the system objects for the job.
eria
Updates The Bulk Action being performed on the system objects selected.
Example: If you were to run a Bulk Action on a set of indicators to expire on
2-29-2020, the Updates field will display: indicator: { "expires ats"
"2020-02-29"}
Status The current status of the job.
Possible statuses include:
« Created - The job has been queued.
« In-Progress - The job is running.
« Error-The job failed.
» Waiting - The job is waiting for indexing to be complete. This only
applies to the Bulk Change process.
o Completed - The job has completed.
Completed | The timestamp of when the job completed.
Total The total number of objects included in the job.
PID The process ID of the worker executing the job.
Percent This represents the amount of system objects associated with the job that
Completed | have been processed.
Example: 100 indicators out of the 1000 associated with the job have
been deleted = 10%.
Estimated
- The estimated time remaining until the job is complete.
ime
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Field Description

Remaining

Date

The timestamp of when the job was created and queued.
Created

Updated At | The timestamp of when the job or an system object associated with the

job was last updated.

Start Time | The timestamp of when the job was started.

Completed

At The timestamp of when the job completed.

Failed At If the job failed. the timestamp of when it failed.
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Threat Library

The Threat Library is the central repository within ThreatQ that organizes and combines

external and internal threat data.
The Threat Library can be broken down into three segments:

System Objects

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library that allows you to

search, filter, and sort through System Objects.

Object Details
The Object Details page allows you view detailed information about a specific object.

Advanced Search

The Advanced Search page is the primary interface for the Threat Library. You can search
for any system object within the application, filter returned system objects, and apply bulk

changes to search results. You can click on an individual object to navigate to its details

page.
Depending on how you have navigate to the Threat Library will determine which object
types appear on the page.

Threat Library Navigation Menu

You can click on Threat Library > Object Type to open the advanced search for a particular
object type or select Browse All. You can also select which object types appear in your

Threat Library view - see Selecting Object Type View for more details.
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Search Link

You can click on Search > Advanced Search to open the advanced search for all object

types within the Threat Library.
Refining Search Results

You can use Context Filters, Date Filters, Status Filters, Tasks Filters, and Types Filters to

narrow down your search for a specific object or object type.
Related Topics:

« Performing an Advanced Search

« Managing Search Columns

o Exporting Search Results to CSV

« Managing Saved Searches

« Bulk Actions

o Filter Sets

Performing an Advanced Search

"l

You can also click on Threat Library > Browse All to navigate to the
advanced search page or click Threat Library >Object Type to navigate to
the advanced search page for a specific object type.

To perform an advanced search:

1. Choose the Search icon.
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2. In the Search dialog box, choose Advanced Search.

The Advanced Search page opens.
THREATQ 3

) soversaries 0 & Threat Library
@ Altack Patterns 0 All Objects - v T
o Campalgns o

= [ Save

@ Courses of Action 0

@ Exploit Targets ]

Files 1]

eln(iden[s a
O 2| @ icsors o)

D Add Another Filter Set

@ Intrusion Sets o
@ Malware 1]

| Type = Status = l | Seore

@ Signatures 0 VALUE 3 TWE = DATE CREATED =
@ Taske n @ ryrdu.crulsingsmallship.com FQDN D8/0B/2019 03:30pm
0 s . @ rttim-taxl.com FQDN D8/0B/2013 03:30pm
@ 70US.57M.SK FOQDN OB/0B/2019 03:30pm
O TP 0 @ zkic.com FQON D&/08/2019 03:30pm
@ zjjif croukwexdbyerr.net FQDN 08/0B/2019 03:30pm
@ ribup.csheaven.com FQDN 08/0B/2019 03:30pm
@ TIEEySr.oom FQDN 08/0B/2019 03:30pm
@ 77752.com FQDN D8/0B/2019 03:30pm
@ 732538.nb.host127-0-0-1.com FQDN 0&/08/2019 03:30pm
@ yumekin.com FODN 0D&/08/2019 03:30pm
@ youtuhe.com FQDN 0&/08/2019 03:30pm
u @ youtibe.com FQDN D8/0B/2019 03:30pm

s AOMO PO A AN

3. Choose your object search category by selecting an object type from the Filters

dropdown list or selecting an object type from the left-hand list.

See the Filter Sets topic for more information on narrowing down
your search.

4. Use the Not checkbox to indicate whether search results will include or exclude

the filter set.
5. Press Enter or Return.

6. Optionally, repeat steps 3 and 4 to further narrow your search.
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Managing Search Columns
You can choose which columns to display in your search results.
To select columns:

1. Navigate to the Advanced Search page.

2. Choose Manage Columns.

@ Threat Library
All Objects - Q. Search for keywords, Y Clear Filters
oad Search = [ Save You currently have 1 filter set.

@ Add Another Filter Set

@ Indicators (2,211) @ Manage Columns =

| Type - ] ‘ Status hd ‘ [ Score o 3 ] I

VALUE 2 TYPE = ¥ Date Created
@ zyrdu.cruisingsmallship.com FQDN (] Description
@ zt.tim-taxi.com FQDN B Expiration Date
@ zous.szm.sk FQDN :

N Q [ Last Modified
@ zkic.com FQDN
O Related Adversaries

@ zjjif.croukwexdbyerr.net FQDN

. i Score
@ zibup.csheaven.com FQDN

Sources

@ Igsysz.Com FQDN &2
@ 77752.com FQDN i Status

3. Select the columns you wish to display. Clear the columns you wish to hide.
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Selecting Object Type View

You can select which object types appear in your view of the Threat Library using the fol-
lowing methods:

"1

The methods listed below will not be added to your filter set. See the Fil-

tering by Object Type topic for details on how to add object type filtering to
your filter sets.

Threat Library Navigation Menu:

1. Click on the Threat Library navigation dropdown and select an Object Type.

i\ Threat Library A Investigations Ll Analytics

& Adversaries {'i} Exploit Targets & Malware

= Attack Patterns 2 Files W Signatures

l Campaigns G Incidents @ Tasks

&’ Courses of Action (M Indicators A~ Tools

™) Events (8] Intrusion Sets B TTPs

Browse All
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The Advanced Results page opens with the applied object type filter.
THREATQ 3

dicators 15.8K

@ Threat Library

indicators -

T B v

Filter Set 1

0 add Arather Filter Set

Indicators (15,440)

WALUE = TVPE 2

&

P Addrass
FOON

P Address
P Address

P Arddress

E & & & @

P Address

Object Type Dropdown List

DWTE CREATED

L8
0aM1/2
0a12
[E=T R
D&M 1V

D&M 1D

118 11:47pm
013 1147
119 11:47pm
019 11:47pm
013 11:47pm

019 11:47pm

LAST MODIFIED =

QEN22M e aE11am
0BM220M 9 1202am
QBN 1 202am
08N 2/2019 12:02am
DBMZA019 1202am

08N22M I 1 202am

You can use the Global Filter dropdown list to select more than one object type.
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1. Click on the Object Type dropdown list and select one or more object types.
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@ Threat Library

Indicators v Q_ Search for ki

All Objects

Adversaries

Attack Patterns

Campaigns

Courses of Action

Events

Exploit Targets

Files
Incidents .
v] Indicators
_ Intrusion Sets
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The Advanced Search Results page updates the list with the selected object type

(s)
THREAT() D
[ar— Tk | Threat Library =
Irsdicatnry
T B hrkd Arocher Rl St

WRLUL @ TFPrEL & LAS]

1P Agidiress Q0 20200 I3 3 pm (==}

1P Aiciress 0N 2030 :ll':l1r|— (=21

1P A SO F20D O30 e o

- 1P Acddress QA0 3 03D I S5 4

Filter Sets

Filter Sets allow you to create multiple sets of filters that can be applied to the threat library at

the same time using AND/OR logic. You can also save your Filter Sets using the Save
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Search option - see the Saving Searches topic for more details.
THREATQ 3

G hoveraces 1n Threat Library
a Al Pamais =tL Al iyt L
0 Campaigns l

B Courses of ion i Filer 2601 OO ray

grwﬂn o

@ Espiit Targets OO STATUS
'3. Fiex
@ Iseniies FloerSecd  0OF = DiHG

6 Imriderey

g- Irdcatoes ERk |
" L] !

£ I5E
[':_?l-u.m.u. i @ Indicatars (63,378)

LTI
e
& 522191
'D 1 @
€ winernines & 527130
& 1870132
& 231571

Related Topics:

Adding Filter Sets

« Editing Filter Sets

Deleting Filter Sets

And/Or Order of Operations

Filter Options:

Date Filters

Context Filters

« Types Filters

Status Filters

L &

# Addriss
P Agidepas
 Agidress
P ACdress
CIDR Block

=

T Oear Fliers Q0 Add Ancthar it Sal

DATE CREATED: -

ODERI0 O Dpm
DS O 1 Dipm
(MR 2R DY pm
200 D0 Spm
D800 OE03pm
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Adding Filter Sets

To Add a Filter Set to the search results:
From the Advanced Search page:

1. Use the NOT checkbox to determine if the filters in the initial filter set will be used

to include or exclude Threat Library objects.

2. Select one or more filters for the search.

Fa"

Threat Library Load Search » () Save
All Objects -
Filter Set 1 O wnoT m -
INDICATOR TYPE IP Address | Type = @

INDICATOR STATUS m - ®

T Clear Filters © Add Another Filter Set

"1

You can use the search box provided at the top of the filters drop-
down to narrow down the list of available filters.
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3. Click on Add Another Filter Set.
A new Filter Set table will load below the first set.
Threat Library sd Search » (@ Save
All ':'bjE(t'S - 1 Search for keywords

Filter Set 1 O woT

INDICATOR TYPE IP Address x Add Type =

INDNCATOR STATUS m Add Status -

Filter Set 2 OR = O NOT

Y Clear Filters @ Add Another Filter Set

4. Use the Not checkbox to determine if the filters in the new filter set will be used to

include or exclude Threat Library objects.
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5. Use the Filters dropdown next to the new filter set to add filters.

Threat Library Load Search ~ [@ Save
All Objects - L Search for keywords. .
-
INDICATOR TYPE IP Address x Add Type =

INDICATOR STATUS Active X Add Status =

Q pearch... ‘ \nother Filter Set

@ Indicators (42,253) ™ Dates

Expiration Date

VALUE = TYPE Published Date DATE CREA

@ 52.219.101.27 IP Add P ——— 04/06/2C

@ 343225213.92 IP Add . 04/06/2C
Last Modified

@ 52.71.209.91 IP Add 04/06/2C

@ 187.1.132.84 pagg O Context 04/06/2C

6. Click on the And/Or dropdown to set the And/Or logic for the Filter Sets. See the

And/Or Order of Operations topic for more details.

ThreatQ User Guide, Version 4.39 148



THREA TQ n Threat Library

Threat Library Load Search = (@ Save
All Objects - 2, Search for keywords..
=Emn-
INDICATOR TYPE IP Address x [EEERERTTEE ®

INDICATOR STATUS m Add Status - &

-] B
CREATED AT Before 04/06/2020 03:22pm X ®

T Clear Filters € Add Another Filter Set

{ ﬂ Repeat steps 3-6 to add additional filter sets. }

Editing Filter Sets

The steps to editing a filter within a Filter Set may differ based on the type of filter.

Editing Filter Set Filter Values

Filter Steps

Dates

Date Created 1. Click on the pencil & icon located to the right of the value.

The Date Created dialog box opens.

2. Update the date values and click Save.

Last Modified 1. Click on the pencil & icon located to the right of the value.

The Last Modified dialog box opens.
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2. Update the date values and click Save.

Context

Keyword Keywords already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing keyword to delete it.

2. Click on the Filters dropdown and select Keyword.
The Filter by Keyword dialog box opens.

3. Enter the new keyword and click Add.

Relationship Related objects already applied to the filter cannot be edited and must

be deleted. Perform the following:

1. Click on the X next to the existing related object to delete it.

2. Click on the Filters dropdown and select Relationship.
The Filter by Relationship dialog box opens.

3. Use the search box to locate the object and click Add.

Indicator Score 1. Click on the Update Score option next to the existing score fil-

ter.
The Define Your Score dialog box opens.

2. Adjust the score range and click Submit.

Source Sources already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing source to delete it.
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2. If another source filter exists, click on Add Source option oth-

erwise click on the Filters dropdown and select Source.
The Source dialog box opens.

3. Use the search box to locate the source.

Tag Tags already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing tag to delete it.

2. If another tag filter exists, click on Add Tag option otherwise

click on the Filters dropdown and select Tag.
The Tag dialog box opens.

3. Use the search box to locate the tag.

Value Contains Values already applied to the filter cannot be edited and must be

deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select Value Contains.
The Value Contains dialog box opens.

3. Select an Object, enter a Value, and click Add.

With Attribute With Attribute values already applied to the filter cannot be edited and

must be deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select With Attribute.

The With Attribute dialog box opens.
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3. Select an Attribute, enter a Value, and click Add.

Without Attribute | Without Attribute values already applied to the filter cannot be edited

and must be deleted. Perform the following:

1. Click on the X next to the existing value to delete it.

2. Click on the Filters dropdown and select Without Attribute.
The Without Attribute dialog box opens.

3. Select an Attribute, enter a Value, and click Add.

Types
Object Type 1. Click on the Add Type next to the existing types.
(Indicator, Event, The Type dialog box opens.

Signature, File)
2. Use the checkboxes to select and unselect types.

Statuses

Object Status 1. Click on the Add Status next to the existing status.

(Indicator, Sig- The Status dialog box opens.

nature, Task) 2. Use the checkboxes to select and unselect statuses.

Deleting Filter Sets

"l

Deleting a Filter Set removes it from the search results and cannot be
undone.

To Delete a Criteria Set:
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1. Click on the delete BM icon located next to the right of the Filter Set's name.

Threat Library cad Search ~ ([ Save
All Objects - Search for keywards. ..
Coe ]
INDICATOR TYPE IP Address x Add Type = 23]

INDICATOR STATUS m Add Status - &

CREATED AT Before 04/06/2020 03:22pm % ®

T Clear Filters & Add Another Filter Set

"1

You can click on Clear Filters, located beneath the filter sets, to
remove all filter sets from the current search.

And/Or Order of Operations

Filter Set AND/OR logic follows the standard mathematical order of operations with ANDs

being executed before ORs. The table below provides different scenarios and examples for
Filter Sets.

ThreatQ User Guide, Version 4.39 153



THR EA T'Qm Threat Library

Scenario Order Example
Single AND Filter 1 AND Filter 2 R
sosonrvee  ([EETED e -
FmerSecz  aNp < | Cwer

T Jea

Single OR Filter 1 OR Filter 2

Fiter Set1 g wat

el . - I

Filter Sa1 2 ar - Qmor

WICATOR STHTUS P —

T Cled

Single AND, Single (Filter 1 AND Filter 2) OR Filter 3
OR Filter Set1 0O noT

INDICATOR TYPE IP Address  x Add Type -

INDICATOR STATUS Add Status |=

Filter Set 2 AND = O poT

CREATED AT Before 04/06/2021) 03:22pm X

Filter Set 3 OR - O poT

LAST MODIFIED Before 04/06/5!020 03:35pm X
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Scenario Order Example
Multiple ANDs, (Filter 1 AND Filter 2 AND Filter 3)
Single OR OR Filter 4 Fter set T Gmor
INDICATOR TYPE Add Type -
INDICATOR STATUS Add Status |w

Filter Set 2 AND - O poT

CREATED AT Before 04f06/2020) 03:22pm X

Filter Set 3 AND = O poT

LAST MODIFIED Before 04/06/5/020 03:35pm  x

Filter Set 4 OR = O poT

INDICATOR CONTRAIMNS 172 X
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Scenario Order Example

Multiple ANDs, Mul- (Filter 1 AND Filter 2) OR (Filter 3
tiple ORs AND Filter 4) Filter Set1 [ NOT

INDICATOR TYPE IP Address Add Type ~

INDICATOR STATUS Add Status |-

Filter Set 2 AND - O poT

CREATED AT Before 04f06/2020) 03:22pm X

Filter Set 3 oR - O MoT

LAST MODIFIED Before 04/06/5/020 03:35pm  x

Filter Set 4 AND = O poT

INDICATOR CONTRAIMNS 172 X

Date Filters
Date filters allow you to filter advanced search results by date-related values.
Additional Topics:

« Filtering by Date Created

« Filtering by Last Modified

o Filtering by Published Date

ThreatQ User Guide, Version 4.39 156



THREA TQ H Threat Library

o Filtering by Source Ingest Time

« Filtering by Expiration Date

Filtering by Date Created

Complete the following procedure to filter Advanced Search results by the date the objects

were created.
To filter by Date Created:
1. Click on the Filters option and select Date Created.

The Date Created dialog box opens.
T EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE———

Date Created %

is before -

— Time Zone

‘ May v o - 2019 - 0317 PM ® uTc -

2. Select one of the following options to determine how the filter is applied:

Option Result
is before Search results include items before a selected date
is after Search results include items after a selected date

is in the range _ _ _
¢ Search results include items in a selected range of dates
o

Search results include items within the selected number of
is within the last
days.
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3. Use the controls to select date options based upon the selection in step 2.

4. Click Save.
Filtering by Last Modified

Complete the following procedure to filter Advanced Search results by the date objects were

last modified.
To filter by Last Modified:
1. Click on the Filters option and select either Last Modified.

The Last Modified dialog box opens.

H x
Last Modified
is before v
Date Time Time Zone
May - g9 - 2019 - 03:19 PM © uTc -

2. Select one of the following options to determine how the filter is applied:

Option Result

is before Search results include items before a selected date

is after Search results include items after a selected date

is in the range _ _ _
¢ Search results include items in a selected range of dates
o

L Search results include items within the selected number of
is within the last
days.
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3. Use the controls to select date options based upon the selection in step 2.

4. Click Save.

Filtering by Published Date

"l

The Published Date is the date that an object was originally published by
the source. This is not to be confused with when the object was ingested
into ThreatQ.

To filter by Published Date:

1. Click on the Filters dropdown option for a filter set and select Published Date.

& Threat Library

All Objects -

= ) S

piter st m '

@ add Anodher Fiter Set

ate Created

Indicators (114 Published Date m

Source Ingest Time

Status = | | Soare
Last Madifiad
WALLUE @ TYPE @ Contest

& 213.176.20.v22 CIDR Blodk
mpart I

& 213130BBOS22 CIDR Block
Keywword

@ 2129514402 CIDR Block

kT - iy el athonship
@ ) : ¥ 0 CIDR Elock PR AR o i Jere
& 21057128018 CIDR Block 11042015 06:34pm

CIDR Block 110472019 06:34pm
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The Published Date dialog box opens.

Published Date

The published date is the date that the source originally published the object. This is not to be confused with when the object
was ingested Into Threatd,

published before

Wowvernber u - v 06:37 PM

2. Select the Source that published the object.

3. Select one of the following options to determine how the filter is applied:

Option Result

published before Search results
include items before

a selected date

published after Search results
include items after a

selected date

published between Search results
include items in a
selected range of

dates

published within the last Search results
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Option Result

include items within

the selected number

of days.

4. Select Date, Time, and Time Zone for the filter to use.

5. Click Save.

Filtering by Source Ingest Time

"1

The Source Ingest Time is the date that an object was ingested into
ThreatQ.

To filter by Source Ingest Time:

1. Click on the Filters dropdown option for a filter set and select Source Ingest Time.
@ Threat Library

All Dbgects - arch far keyvs T

|+ [ Save Yau currerily havs 1 filter set

& Add Arather Flter Set Date Created

Piilslished Date
@ vamare 59 i |
Last Maodified
WALLIE = DATE CREATED =

@ 055 _OCEANLOTUS.D 11/04/201 % 06:39pm D Context

@ FlawedAmmyy 1170472019 D6:39pm
Impart 1D

& ROFSMIFFER 117047201 % D6:39pm
Keynwrord

& MNETWIRE 11042019 D6:39pm
Relationshi

@ FakeM 117044201 % D6:39pm T I ukractd 1 Ut | pm
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The Source Ingest Time dialog box opens.
Source Ingest Time

The Source Ingest time |s the date that the object was initially ingested into Threat(),

created before

November - ol - 07:49 PM

2. Select the Source that published the object.

[ ﬂ You have the option to select Any Source.

3. Select one of the following options to determine how the filter is applied:

Option Result

created before Search results
include items before

a selected date

created after Search results
include items after a

selected date

created between Search results
include items in a

selected range of
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Option Result

dates

Search results

. include items within
created within the last
the selected number

of days.

4. Select Date, Time, and Time Zone for the filter to use.

5. Click Save.
Filtering by Expiration Date
You can narrow down the Indicators in your search results by the expiration date.
Tofilter by Expiration Date:

1. Click on the Filters dropdown option for a filter set and select Expiration Date.

@ Threat Library

Indicators - Q. search for keywords, Y Clear Filters

Load Search = [§) Save You currently have 1 filter

Filter Set 1 m R
© Add Another Filter Set
@ Indicators (0) @ Manage Columns  ~

No Results Found

If you are currently viewing system indicators in the Threat Library,
you can click on the Expiration button located above the search res-
ults.
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@ nocaors ©

| Type ~ I | Status v I | Score v I | Expiration ~

Y Expiration Date

is "

— Month —— — Day
| Jan v

m cancel

The Expiration Date dialog box opens.

2. Select one of the following options to determine how the filter is applied:

Option Result

is Search results include the specified date.

is not Search results exclude items from a range of dates.

is after Search results include items after a selected date.

is before Search results include items before a selected date.

is between Search results include items in a selected range of
dates.

is within the last Search results include items within the selected num-
ber of days.

is within the next Search results include items within a range of future
dates.

is protected from auto- Search results include items that are protected from

expiration auto-expiration.

3. Select Day, Month, and Year for the filter to use.
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4. Click Submit.

Context Filters

Contextfilters allow you to filter advanced search results by specific details associated with

an object.
Additional Topics:

o Filtering by Attribute

o Filtering by Value Contains

« Filtering by List of Indicators

o Filtering by Keyword

« Filtering by Relationship

« Filtering by Related Object Types

o Filtering by Score

o Filtering using Tags

Filtering by Attribute
You can filter the Threat Library list to include or exclude objects with a specific attribute.

From the search resuits:
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5.

. Click on the Filters option and select either With Attribute or Without Attribute.

The Attribute Filter dialog box opens.

With Attribute

Select an Attribute Type.

Enter an Attribute Value associated with the Attribute Type.

"1

Users can leave the Attribute Value field blank to filter for any value
associated with the selected Attribute Type.

. Click on the Plus icon to the right of the dialog box to add another attribute and

repeat steps 2-3. This step is optional.

Click on the Add button.

The filters will be applied to the search results.

The following section applies to using multiple attribute filters.

-

A\

ﬂ\ The Match Any/All toggle option will allow users to configure the filter to

include objects that either fit one attribute filter or all. The Any option will
be selected by default. This means the filter will display results that fit any
of the attribute filters. The All option means the filter will display results that
fit all attribute filters.

Example:
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ANY - Match Toggle Selection

Filter Options

Setting Field Value
Attribute Type Attack Phase
Filter A
Attribute Value C2
Attribute Type Severity
Filter B
Attribute Value High
Any/All Toggle Any

Search Results are filtered to include/exclude objects with Attack

Filter Options

Any/All Toggle

Result
Phase: C2 OR Severity: High attributes.
ALL - Match Toggle Selection
Setting Field Value
Attribute Type Attack Phase
Filter A
Attribute Value C2
Attribute Type Severity
Filter B
Attribute Value High
All

Result

Search Results are filtered to include/exclude objects with Attack

Phase: C2 AND Severity: High attributes.

Common Scenarios

The following scenarios demonstrate the Attribute Filter option in use with search results.

Applying a "With Attribute" filter (All items with an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select With Attribute.
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The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.
4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators with an attribute of Attack
Pattern: C2.

Applying a "Without Attribute" filter (All items without an Attribute Type and Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filter button and select Without Attribute.

The Attribute Filter dialog box opens.

3. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.
4. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2
listed. The search results update to show all Indicators without an attribute of
Attack Pattern: C2.

Applying a "Without Attribute" filter (All items Without a specific Attribute Type with any
Value)

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User clicks on the Filters button and select Without Attribute.

The Attribute Filter dialog box opens.
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3. User selects Attack Pattern as the Attribute Type and leave the Attribute Value
blank.

4. User clicks on Add.
The User will now see a search parameter Without Attribute with Attack Pattern

listed. The search results update to show all Indicators that do not have an Attrib-

ute Type of Attack Pattern assigned to them.

Applying keyword filters then applying a "With Attribute" filter

1. User clicks on the Threat Library tab and selects on the Indicators tab.

2. User searches for keyword: demo.

The User will see a search parameter listed Keyword: "demo" and the results

update to show only indicators that mention demo.

3. User clicks on the Filters button and select With Attribute.

The Attribute Filter dialog box opens.

4. User selects Attack Pattern as the Attribute Type and C2 as the Attribute Value.
5. User clicks on Add.

The User will now see a search parameter With Attribute with Attack Pattern: C2

listed. The search results will update to show all Indicators that mention the
keyword demo AND have an attribute of Attack Pattern: C2.

Editing multiple attributes that were applied as part of the search parameters
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1. User clicks on the Threat Library tab and navigates to the Indicators tab.

2. User clicks on the Filter button and select With Attribute.

The Attribute Filter dialog box opens.

3. The User specifies two attributes:
« Attack Pattern:C2
« Severity: High

4. User clicks on Add.

The User will now see two search parameters under the With Attribute section -
Attack Pattern: C2 and Severity: High. The search results updates to show all
Indicators with an attribute of Attack Pattern: C2 and Severity: High. The search
parameter for attributes is defaulted to Any. This indicates that objects with an

attribute of Attack Pattern: C2 or Severity: High are displayed.

5. User clicks on the Filters option and selects With Attribute.

A form will load with all applied filter attributes.

6. The User clears the Attack Pattern's Attribute Value field and clicks Add.

The User will now see two search parameters under the With Attribute section:
Attack Pattern: Any and Severity: High. The search results updates to show all
Indicators with an attribute type of Attack Pattern OR Severity: High.

Add multiple attributes and toggle Match from Any to All

1. User applies two attribute filters to the indicators results: Attack Phase: C2 and
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Severity:High.

The filtered results will display any indicators that has either of those attributes.

2. User clicks on the Any/All Match toggle button and select All.

The filtered results will display any indicator that has both of those attributes

Filtering by Value Contains

You can now filter Threat Library objects by a specific value or string within the value using

the Value Contains filter.
To filter by contains:
1. Click on the Filters option and select Value Contains.

The Contains dialog box opens.

Value Contains

2. Select an Object, enter a Value, and click Add to apply the filter.
Filtering by Keyword
You can filter the Threat Library items on the Advanced Search by keyword.

To filter by keyword:
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1.

Navigate to the Advanced Search page.

2. Enter a keyword in the Keyword text field and press <Enter> or <Return>.

ﬂ\ Repeat Step 2 to apply multiple keyword filters

Each keyword filter appears in a box below the keyword text field. "

& Global Filters

All Objacts - }

3. Click on the X for each filter to remove it or select Clear All Filters to remove all fil-

ters

The following list of fields are all searched against for any matches of keywords:

Source Names

Attribute Names

Attribute Values

Comments

Tags

Adversary Name

Adversary Description
File/Attachment Name
File/Attachment Title
File/Attachment Type Name
File/Attachment Content-Type Name

File/Attachment Hash
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« File/Attachment Description
« File/Attachment Contents

» EventTitle

« Event Type Name

« Event Description

« Spearphish Subject (for Events of Type 'Spearphish')
« Spearphish Value (for Events of Type 'Spearphish’)
« Indicator Type Name

« Indicator Status Name

« Indicator Value

« Indicator Class

« Indicator Description

» Signature Name

« Signature Description

» Signature Value

« Signature Has

« Signature Type Name

« Signature Status Name

o Task Name

« Task Description

» Task Status Name

« Task Assignee Source Name

o Task Creator Source Name
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Filtering by List of Indicators

The List of Indicators Filter option allows you to filter the Threat Library by pasting a list of
indicators, in raw text.

The filter will return indicators that are an exact match. It does not return
partial matches.

To Filter by a List of Indicators:

From the search results:

1. Click on the Filters option and select List of Indicators.

@ Threat Library

The List of Indicators dialog box opens.

List of Indicators *

2. Enter or paste your list of indicators into the textbox provided.

List of Indicators *

Provide a list of indicators
Basfe76feee34416525/8beSd50faa5d585b13cf
Bada691783C1661750bbbf340d637169a9e80679
abd34c09dasf043d821129eb286792e4743ed39
76f3a46eedefadbecSeaal 440fee7cb74c24fd25
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ﬂ' The accepted list format is one indicator per line.

3. Click on Add to apply the filter.
Filtering by Related Object Types

The Related Obiject filter allows you to filter search results by related object type. Using this

filter, you can do the following:

« Filter search results that return related items linked to certain objects.
« Filter search results that return related items linked to certain object types.

« Apply a Value Contains filter to the results.

To Filter by Related Object Types:

1. Click on the Filters option and select Relationship Criteria.

The Relationship Criteria dialog box opens.

Relationship Criteria

n descrize the type of object your result will be related te, For example, you could apply filters to show
Adversary with a specific geolocation.

By adding flters you ca
all abjects rel

Return results related to:

#ny Object

Additional Criteria (optional) Y

[ om ]

2. Use the text box to select your Object and Type.

Relationship Criteria

By adding filters you can describe the type of object your result will be related to. For example, you could apply filters to show
ocati

all objects related to an Adversary with a specific gealocatior

Return results related to:

Indicators

Additional Criteria {optional) T =

2N
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ﬁ Steps 34 are optional.

AN

3. Click on the Filters dropdown and select Value Contains.

Relationship Criteria .

By adding filters you can destribe the type of object your resuit will be related to. For example, you could apply filters o show

all objects related to an Adversary with a specific geolacation

Return results related to:

Indicators - ovE
Additional Eriteria (optionaly r m
Value Contains

4. Enter your desired value in the field provided.

Relationship Criteria

By adding fiters you can describe the type of object your result will be related to. For example, you could apply filters to show
all objects related to an Adversary with a specific geolocatian.

Return results related to:

Indicators - CIDR Block
Additional Criteria (optional) T Clear Filters m
®

5. Click on Apply to filter.

Filtering by Relationship

The Relationship Filter option allows you to filter the Threat Library by related objects. Using

the Relationship filter, you can:

« Filter search results to include objects related to a specific object.

« Filter search results to include objects using multiple related object filters. You will

also have the option to set the filter to include objects that fit one of the multiple fil-

ters or all.

To Filter by Related Object:
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From the search results:
1. Click on the Filters option and select Relationship.

The Filter by Relationship dialog box opens.

Filter By Relationship

Q

‘» Search for keywords...

2. Use the textbox provided to select an object.

ﬁ Repeat step 2 to add multiple object filters.

3. Click on Add to apply the filter.

e N

ﬂ The Match Any/All toggle option will allows you to configure the fil-
ter to include objects that either fit one related object filter or all. The
Any option will be selected by default. This means the filter will dis-
play results that fit any of the related object filters. The All option
means the filter will display results that fit all related object filters.

. J

Examples:
ANY - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
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Filter B DEF Event
Filter Option Any
Search Results are filtered to
Result include objects related to the ABC
Indicator OR the DEF Event.

ALL - Match Toggle Selection
Setting Related Object
Filter A ABC Indicator
Filter B DEF Event
Filter Option All
Search Results are filtered to
Result include objects related to the ABC
Indicator AND the DEF Event.

Filtering by Score

You can filter indicators in the advanced search results by score.

G\ This option is only available for indicators.

To filter by score:

1. Navigate to the Advanced Search results page by selecting Search > Advanced

Search then selecting Indicators from the left-hand object type menu.

You can also select Threat Library > Indicators from the main

menu.
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2. Click on the Filters dropdown and select the Indicator Score filter option.

The Indicator Score dialog row will load in the filter set.

Update Score «

Define your score Clear

ﬁ The scale offers a range of 1-10.

3. Adjust the score scale to filter the results.
Filtering by Scoring Range
You can move the two scale markers to select a scoring range.

Example: Move the left marker to 6 and the right marker to 8 to filter the search

results to include indicators with a score between 6 and 8.
Filtering by Specific Score

You can move the scale makers to the same scoring number to filter by a specific

score.
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Example: Move the left and right markers to 8 to filter the search results to

only include indicators with a score of 8.

ﬂ Select the Update Score filter again and select Clear to remove the
filter.

Filtering using Tags
Using the Tags filter allows you to filter search results based on tags applied to an object.
From the search results:

1. Click on the Filters option and select Tags.

The Filter by Tag row opens.

Filter Set 1

TAG
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2. Select Add Tag.
The Add Tag dialog box opens.

Filter Set 1

TAG

3. Use the supplied text field to select a tag.

4. Repeats steps 2-3 to apply multiple tag filters.

G The Match Any/All toggle option will allows you to configure the filter to
include objects that either fit one tag filter or all. The Any option will be
selected by default. This means the filter will display results that fit any of
the tag filters. The All option means the filter will display results that fit all-

tag filters.
Examples:
ANY - Match Toggle Selection

Setting Tag
Filter A Phishing
Filter B DDoS

Filter Option Any
Result Search Results are filtered to
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include items with either Phishing
OR the DDoS tags.

ALL - Match Toggle Selection
Setting Tags
Filter A Phishing
Filter B DDoS
Filter Option All
Search Results are filtered to
Result include items with both Phishing
AND DDoS tags.

Tasks Filters

Tasks filters allow you to filter tasks based on their priority and to whom they are assigned.

Related Topics:

Filtering Tasks by Assignment

Filtering Tasks by Due Date

Filtering Tasks by Priority

Filtering Tasks by Reported By

Filtering Tasks by Assignment

You can filter tasks based on whom they are assigned to.

From the Advanced Search page:
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1. Click on the Tasks option in the Threat Library menu.

i\ Threat Library A Investigations Lul Analytics

& Adversaries Files [2) Reports
o Attack Patterns |dentities Q Signatures
_!_ Campaigns § Incidents

& Courses of Action Mi Indicators

f Events Intrusion Sets

{1} Exploit Targets Malware #¥ Vulnerabilities

Browse All

2. Click on the Filters option and select Assigned To.
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@ Tasks
Assigned To
Priority

@ Types

Indicator Type
Event Type
File Type

Signature Type

3. Use the Add User dropdown to select the user.
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Filter Set 1

ASSIGNED TO Add User =

.t
| g

-4 Search

[J Amy Rose
[J Ivo Robotnik

[J John Apple !

Filtering Tasks by Due Date
You can filter tasks based on its due date.

From the Advanced Search page:
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1. Click on the Filters option and select Due Date.

Search., inaither Filter Set

WY ILTILILIL AT TLPULE
@ Tasks I

Assigned To

5 Found

Priority

Reported By

i Types

The Due Date dialog box opens.

Due Date

2. Select one of the following options to determine how the filter is applied:

Option Result

is after Search results include tasks with a due date after a selected

date.

is before | Search results include tasks with a due date before a selected

date.

is Search results include tasks with a due date that set between the

ThreatQ User Guide, Version 4.39 186



THREA TQ ” Threat Library

Option Result

between | selected range of dates.

Is within | Search results include tasks with a due date within the last user-

the last | specified number of days.

Is within | Search results include tasks with a due date within the next user-

the next | specified number of days.

3. Click Save.
Filtering Tasks by Priority
You can filter tasks based on their priority.
From the Advanced Search page:

1. Click on the Tasks option in the Threat Library menu.

iy Threat Library A Investigations Lul Analytics

& Adversaries [ Files [ Reports
o Attack Patterns 2% Identities & Signatures
_!_ Campaigns @ Incidents

4? Courses of Action (M Indicators

f*) Events (@ Intrusion Sets

€ Exploit Targets 4 Malware # Vulnerabilities

Browse All
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2. Click on the Filters option and select Priority.

(i) Tasks
Assigned To
Priority
Types

Indicator Type
Event Type
File Type

Signature Type

3. Use the Priority dropdown and select Add Priority.
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Filter Set 1

PRIORITY Add Priority

"
<, Search

J High
[J Low

[0 Medium

Filtering Tasks by Reported By
You can filter tasks based on who created it.

From the Advanced Search page:
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1. Click on the Filters option and select Reported By.

Search, |
nother Filter S
(@ Tasks
Assigned To I
Due Date

und Priarity

Reported By

D Types

Indicator Type

The Reported By Filter will appear in the filter set.
Threat Library

All Objects - Q4 Search for keywords

Filter Set1 Qmar

REPORTED BY Add User -
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2. Click on the Add User option to select the user.

Hnsaw L any

All Objects -

Filter Set 1 [ noT

REPORTED BY

O threatg@threatg.com
E-A Adversaries (ul

Types Filters
Types filters allow you to filter advanced search results by object or subtype.
Additional Topics:

o Filtering by Object Type

Filtering by Object Type

You can filter Indicators, Events, Signatures, and Files by specific types of each.
Example: Filter the Signature listto include YARA types only.

Tofilter by status:

1. Click on the Filters dropdown and select <Object Type>Type.

[ ﬂ The Type filter row will appear in the filter set. }

2. Click on Add Type.

ﬂ You can select multiple types using the check boxes. ]

The search results will update with the applied filter.
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Status Filters

Status filters allow you to filter advanced search results an object's Status.

ﬂ\ Only Indicators, Signatures, and Tasks can be filtered by their Status.

Additional Topics:

o Filtering by Status

Filtering by Status
You can filter Indicators, Signatures, and Tasks by Status.
To filter by status:

1. Click on the Filters dropdown and select <Object Type>Status.

{ ﬂ' The Status filter row will appear in the filter set. J

2. Click on Add Status.

[ ﬂ You can select multiple statuses using the check boxes. }

The search results will update with the applied filter.

Bulk Actions

The Bulk Actions feature gives you the ability to update and delete large groups (1000+) of
system objects from the Advanced Search page. Once selected, the job process will run in
the background and allow you to continue working within ThreatQ. You can review the

status of the job and its results on the Job Management page.
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You will also receive in-app notifications, via the Notification Center, when a Bulk Action job

has been queued and when it has been completed.

THREAT()

D Inghoatian L4k | Thireat |_||>|'.3-'-’- B Saws
INERLI0ITS
- -

T Chiar Albirs & Arkd Araxitier FRer Set

© nocaos e e
Tyme - Habw ™ Hore | | Expiratizn - | :
Walk T TRE = DATE £EFATRD 1m
@ AT 00 T2saba b5 ch T a0 ] D00 A 0
@ BadTdi2 1 TI40ERANR T ShadaTdea521 L] D020 014
@ SCEESEIecil 1 T Sbaasi T2c0ET 48005 L] D0/ F030 3 4
L] D02/ F020 04
BOEAdbca 07 13871 doc s td e ] D02/ 3020 0 A v
@ 9ETeBEIedbSibe 0393 See bl T2 2tk L8] A0 020 M 45pm oan

Related Topics:

« Bulk Delete

o Bulk Change Expiration Date

« Bulk Add Source

« Bulk Status Change

+ Bulk Add/Remove Attributes

o Bulk Add/Remove Tags

o Bulk Add/Remove Relationships

« Job Management

Bulk Delete

You can use the Bulk Delete option to delete a group of indicators on the Advanced Search

page. This feature is only available if you have a maintenance or administrator role.
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G Deleting an indicator also deletes its child records such as attributes and
relationships. The number of child records will influence the overall time it
takes to complete the job.

A The Bulk Delete function permanently deletes selected indicators from
the system. Once deleted, you will be unable to undo the action. If you are
executing a Bulk Delete on a large group of indicators, ThreatQuotient
highly recommends performing a backup of your system before per-
forming this function.

(-

To Perform a Bulk Delete
From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.

0000200

Qe

i - Indicators

o000

2. Click on the Actions dropdown and select All <System Object> under the Bulk
Delete heading.
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@ Manage Columns = Actions

& Bulk Changes

All Indicators (19)
L

1 ] Bulk Delete

All Indicators (19)
+ Export
]

Ccsv

larvoreur» VL S0pI

"l

You will see the number of system objects affected next to the link in
parentheses.

The Bulk Action Confirmation dialog box will load.

Confirm Bulk Action *

O Permanently delete 19 items.

Cancel

3. Click on the checkbox to confirm deletion and then click on Delete.
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The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER MARK ALL AS READ
I Cle:

SYSTEM MOTIFICATION

ve1f
©  Buk Delete Job #1 queued. .

a few seconds ago

The system will also notify you, via the Notification Center, that the job has been com-

pleted.

NOTIFICATION CENTER MARK ALL 45 READ
I Cle:
SYSTEM MOTIFICATION
ﬂ Bulk Delete Job #1 completed successfully. [ ] velf

a few seconds ago

SYSTEM NOTIFICATION

©  Buk Delete Job #1 queued. .

a few seconds ago
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You can also view the status and other details of the job on the Job Management

page.

Bulk Change Expiration Date

You can use the Bulk Change option to update the expiration for a group of objects on the

Advanced Search page.

ﬂ This function can only be performed on Indicators.

To Perform a Bulk Expiration Update
From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.

Indicators 963 | @ Threat Library

Indicators - T Clear Filters

Load Search ~ [ Sawe

© Acd Another Filter Set
Indicators (963) M Manage Columns =

WALLE = TYRE 2 DATE CREATED =
@ 22325400116 CIDR Block 03/04/2019 D2:40pm
@ 22371730016 CIDR Block 09/04/201% 02:40pm

@ 223169.00/16 CIDR Black 09/04/201% 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk
Changes heading.
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You will see the number of system objects affected next to the link in
parentheses.

......

‘ge Expir: te
Tags
et
sttocazs
Attributes
prer
uuuuuu
0
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3. Select the type of expiration update to perform:

"1

See the Bulk Change Expiration Date Scenarios topic for specific
details and outcomes.

Extend expiration date

"1

The platform will ask you for the number of days to extend the
expiration upon selection.

Protect from auto-expiration

Remove expiration date

Set a new expiration date

"1

The platform will ask you to select a new date using a date
picker upon selection.

4. Click on Apply Changes located at the bottom of the form.

ThreatQ User Guide, Version 4.39 199



THREA TQH Threat Library

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER WANEM ALL AS HEAD

EYETEM NOTIFICATION
n Builk Updale Jab #3 qieaied. L]

a few saconds ago :IEI

SYSTEM ROTIFICATION

@  Bulk Update Job #2 compieted successiully. -
5 days ago
BYETEM HOTIFICATION
il
@ Bulk Update Job #2 queuad -
5 days g
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The system will also notify you, via the Notification Center, that the job has been com-

pleted.

HNOTIFICATION CENTER

SY¥SETEM NOTIFICATION

Builk Update Jab #3 eompleted succasstuly.

& law icancd aga

ESYETEM NOTIFICATION

Bulk Update Job #3 queusd

& fow secands ago

SYSTEM NOTIFICATION
Bulk Update Jab #2 completed sucoesstully.

& days ago

SYETEM NOTIFICATION
Bulk Update Job #2 queuad.

5 days ago

SIAHK ALL &S HEAD

Al

1]

You can also view the status and other details of the job on the Job Management

page.

Bulk Change Expiration Date Scenarios

The following scenarios describe the behavior of the Bulk Expiration Update feature.

Scenario #1 - Expiration isn't part of the form if indicators are not part of the result set

1. The user attempts to make bulk expiration changes to system objects other than

indicators.

2. The Change Expiration Date option will not be listed on the Bulk Changes form.

Scenario #2 - Setting expiration policy to a specific day

1. The user selects a set of indicators using the advanced search.
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2. The user selects Set a New Expiration Date from the Change Expiration option.

3. The users selects a day using the date picker.

G The date selected must be a future date.

4. After submitting the request, all indicators as part of that record set have the new

expiration date.
Scenario #3 - Extending the expiration policy by a number of days

1. The user selects a set of indicators using the advanced search.
The user selects Extend Expiration Date from the Change Expiration option.

The user enters the number of days to extend.

W N

After submitting the request, all indicators in that record set will now have their

expiration date extended by that number of days specified.
Scenario #4 - Removing an expiration policy

1. The user selects a set of indicators using the advanced search.
2. The user selects Remove Expiration Date from the Change Expiration option.

3. After submitting the request, all indicators in that record set will no longer have an

expiration date.
Scenario #5 - Protecting items from auto-expiration

1. The user selects a set of indicators using the advanced search.
2. The user selects Protect from Auto-Expiration from the Change Expiration option.
3. After submitting the request, all indicators in that record set will have the protect

from auto-expiration expiration policy applied.

Scenario #6 - Extending / Setting an expiration date on an indicator with a status of

Expired
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1. The user selects a set of expired indicators using the advanced search.
2. The user selects Set a New Expiration Date from the Change Expiration option.

3. The users selects a day using the date picker.

ﬂ The date selected must be a future date.

4. After submitting the request, the expired indicators in that record set are then
changed to a status of Active and the expiration date is set to the date indicated

with the date picker.

Scenario #7 - Extending / Setting an expiration date on an indicator with a status of
Whitelisted

All whitelisted indicators included in a Expiration Change set will be skipped.

Scenario #8 - Removing an expiration date on a previously expired indicator

1. The user selects a set of expired indicators using the advanced search.
2. The user selects Remove Expiration Date from the Change Expiration option.

3. The expired indicators in the set are skipped.

Bulk Add Source

You can use this Bulk Action option to add a source to a set of selected objects on the

Advanced Search page.

If an object is already associated with the source selected for the Bulk Add
Sources action, the object will be skipped during the bulk process.

To Perform a Bulk Add Source

From the Advanced Search Page:
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1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.
THREATQ 9

G} Indicators ) | @ Threat Library

Indicatars - T Clear Filters

Load Search « [ Save

Filter Set 1 Qo m .
cor (D .

@ Acd Another Filter Sat

@ Indicators (963) M Manage Columns =

| Typa | | 5 5 | | Scone
WALUE = WPE 2 DATE CREATED  ~
@ 2232540416 CIDR Block 09/04/2019 02:40pm
@ 223173.00W16 CIDR Block 09/04/201% 02:40pm
& 273169.0.0W16 CIDR Block 03/04/2019 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk

Changes heading.
THREAT() il

D Indhizatan wdk | Threat Litsrary M Saws

Indicatars -

fieal S m -

T Chaar Albers © Arks Araytter Fiter Set

@ nocaos =

& aITMSsEaRS0dal T2 sababSatch? 210 WID5 M0 MA 0

@ EBal7d 40BN b7 SladaToed531 WIDS D0/ 3020 0 4

@ Sc6eSiSlech il b obea3i 120674105 WiDS DRAIE020 M A

@ @ = WADS D0/ Z020 0 4

i 07133710 s 0d D MIDS D0/ Z020 4 v

@ SETeBESedboteINIcI92 300 T2 20kl WIDS D402/ Z020 01 45pm oan
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You will see the number of system objects affected next to the link in
parentheses.

The Bulk Changes form will load.

THREATQ ) s recasiesy e

xxxxxx

Change Expiration Date

Attributes

uuuuuu

3. Click on Add Row under the Source heading.

A new row with a dropdown option will load.

Sources

‘ Source - ‘ w

Add new source

Add Row ©

4. Use the dropdown to select the source to add to the selected objects. You can also

use the Add New Source link to add a source that is not listed in the dropdown.

4 Y

ﬂ If you have TLP enabled, you will also be able to update the des-
ignation for the source selected or keep the source-default des-
ignation.

Sources

| threatq@threatq.com - H - ‘ W

Add new source
@ RED

Add Row © AMBER
@ GREEN
WHITE

NONE
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5. The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER MARK ALL AS READ

SYSTEM NOTIFICATION
©  Bulk Update Job #1 queued. o

atew secands ago

The system will also notify you, via the Notification Center, that the job has been com-

1
+ Create Q '
NOTIFICATION CENTER MARK ALL AS READ
SYSTEM NOTIFICATION
[ ] Bulk Update Job #1 completed successfully. L W
a few seconds ago
SYSTEM NOTIFICATION
©  Bulk Update Job #1 queued. ]
a few seconds ago

You can also view the status and other details of the job on the Job Management

page.

Bulk Status Change

You can use the Bulk Change option to update the status for a group of objects on the

Advanced Search page.

'a N\

ﬂ This function can only be performed on objects that use the status field
such as Indicators, Signatures, etc.

Whitelisted Indicators are not affected by Bulk Status Change. If a Whitel-
isted Indicator is included in the set of system objects selected for a Bulk
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tatus Change, the platform will skip the object without making a status

hange.

To Perform a Bulk Status Change

From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.

Indicators ) | @ Threat Library

Indicatars -

Load Search « [ Save

Filter Set1 O wor

@ Acd Another Filter Sat

Indicators (963)

WALUE = ™WPE =

CIDR Block

CIDR Block

T CIDR Block

T Clear Filters

M Manage Columns =

DATE CREATED =
09/04/2019 D2:40pm
089/04/201% 02:40pm

03/04/2019 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk

Changes heading.
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THREAT()

D ndatan sk | Thireat Library

M Sawe

Indicatars -

Hie el S m i

Tilhear Ay 0 Ackd Ansritier Fiier 5ot

© wicoor T

@& AIT4EnEaRS0da ] T2eababhSaieh? 210 MRS D020 A 0

@& Ealld TANERAN2 b7 SladaTde4530 MRS D020 01 A

& SCERSS3echl BT obaal T2c06T44305 MRS DAAO/Z020 0 A

@ a = MRS DAAO/Z020 01 A

o 0713371 dde T Od D W05 DAA/Z020 M A Y

@ SETeBERe eI I92300E T2 WIDS D4A02/Z020 01 45pm nan

You will see the number of system objects affected next to the link in
parentheses.

xxxxxx

‘ge Expir:
Tags
et
e
Attributes
prer
uuuuuu
0

3. Use the dropdown provided to select a new status to be applied to the selected
objects.
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4. Click on Apply Changes located at the bottom of the form.

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER
[ Clear

SYSTEM NOTIFICATION

@ Bulk Status Job #1 queued.

a few seconds ago

The system will also notify you, via the Notification Center, that the job has been com-

pleted.

Analytics

NOTIFICATION CENTER MARK ALL AS BEAD
rds... Fc

SYSTEM NOTIFICATION

© Bulk Status Job #1 completed successfully. o

afew seconds age
Bulk Status Job #1 completed successfully.
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You can also view the status and other details of the job on the Job Management

page.

Bulk Add/Remove Tags

You can use the Bulk Change option to add/remove tags for a group of objects, per object

type, on the Advanced Search page.
To Perform a Bulk Status Change

From the Advanced Search Page:

1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.
THREATQ 9

Indicatoes 963 | @ Threat Library

ndicatars -

Load Search ~ [ Save

Filter 3et1  Quom

KEYWORDS m
© Acd Another Filter Set

Indicators (563)

[or -]

WALUE = TWPE =
@ 22325400116 CIDR Block
@ 2237173.00M16 CIDH Block

& 273169.0.0M16 CIDR Block

T Clear Filters

M Manage Columns =

DATE CREATED =
03/04/2019 D2:40pm
09/04/201% 02:40pm

09/04/201% 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk

Changes heading.
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THREAT()

D Indizatan LAk | Thireat |_||)|.L'|l',l M Sawe
Indlcaars
Filler 801 O m -

Tilhear Ay 0 Ackd Ansritier Fiier 5ot

0 ndicators D Marage Columns = “

L ER F0da T2 eababSatch? 2310 MRS D020 A 0
EeAr2ch?SdadaToed5a0 MRS D020 01 A
@& S el a3 1 T RCOET L0 MRS DAAO/Z020 0 A
MRS DAAO/Z020 01 A
@ 51728038 dbca3%07 13871 a0 Ts0d D W05 DAA/Z020 M A
WIDS D4A02/Z020 01 45pm nan

"1

You will see the number of system objects affected next to the link in
parentheses.

The Bulk Changes form will load.

THREATQ ) mmein &

Bulk Changes Your changes wil affect 40 cbjects

xxxxxx

Change Expiration Date

Attributes

uuuuuu

3. Select whether either the Add or Remove function and the Tag. You can also use

the Add New Tag option if the desired tag is not listed in the dropdown.
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Tags
— Add f Remove —, - .
Add v ‘ Select a tag > | @
Add new tag
Add Row ©
{ ﬂ Click on Add Row and repeat step 3 to add/remove multiple tags. }

4. Click on Apply Changes located at the bottom of the form.

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER
F Clear

SYSTEM MNOTIFICATION

© Bulk Status Job #1 queued. i

a few seconds ago
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The system will also notify you, via the Notification Center, that the job has been com-

pleted.

Analytics

NOTIFICATION CENTER

SYSTEM NOTIFICATION

© Bulk Status Job #1 completed successfully. o [F

afew seconds ago
Bulk Status Job #1 completed successfully.

You can also view the status and other details of the job on the Job Management

page.

Bulk Add/Remove Attributes

You can use the Bulk Change option to add/remove attributes for a group of objects, per

object type, on the Advanced Search page.

"l

Using Bulk Actions to remove an attribute from the selected objects will
remove the full attribute record regardless of how many sources the attrib-
ute may have.

To Perform a Bulk Add Attribute

From the Advanced Search Page:
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1. Perform an advanced search and create a filter set to narrow down your results -

this step is optional.
THREATQ 9

G} Indicators ) | @ Threat Library

Indicatars -

Load Search « [ Save

Filter 3et1 QuoT

cor (D

@ Acd Another Filter Sat

| Typa | | 5 5 | | Scone
WALUE = WPE 2
@ 22325400716 CIDR Black
@ 223173.00W16 CIDR Block
& 273169.0.0W16 CIDR Block

T Clear Filters

M Manage Columns =

DATE CREATED  ~
09/04/2019 02:40pm
09/04/201% 02:40pm

09/04/201% 02:40pm

2. Click on the Actions dropdown and select All <System Object> under the Bulk

Changes heading.

THREAT()
D Indheatzn sk | Threat Liksrary

v (D

@ ndicators

Tyze - Wabma v Score ol | | Expiratian

Wik = TE =

8 8 &8 & @8
i
=
th

JETeB Tt I 00393 3ea b T 208 M5

M Sawe

T Chaar Albers © Arks Araytter Fiter Set
DATE EREATED -m

D020 A 0
DRI 01
DAAO/Z020 0 A
DAO/Z020 0 A
DAA/Z020 M A

D4A02/Z020 01 45pm nan
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You will see the number of system objects affected next to the link in
parentheses.

The Bulk Changes form will load.

THREATQ ) m sy ey

xxxxxx

Change Expiration Date

Attributes

uuuuuu

Only the Bulk Actions that relate to the type of system object you
selected will load on the Bulk Changes form. Example: Bulk Expir-
ation Change will not load for non-indicators.

3. Locate the Attributes heading and select either Add or Remove.

4. Select the attribute Name and Value. You can also use the Add New Name and
Add New Value options to create new attributes. If you are adding an attribute, you
will also select a Source. If you do not select a Source, the Source default will auto-

matically be used.

Attributes

Add ASN 13335 abuse.ch URLhaus Plai... o

Add new name Add newvalue Add new source

Add Row O

Attributes

Remove ASN 13335 o

Add Row O
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Click on Add Row and repeat steps 3-4 to add/remove multiple attrib-
utes. See the Scenarios section below for more details.

5. Click on Apply Changes located at the bottom of the form.

The job will be queued by the system and you will receive an in-app notification via

the Notification Center icon.

NOTIFICATION CENTER MARK ALL AS READ

SYSTEM NOTIFICATION

©  Bulk Update Job #1 queued. o [

afew seconds ago

The system will also notify you, via the Notification Center, that the job has been com-

1
+ Create Q a
NOTIFICATION CENTER MARK ALL AS READ
SYSTEM NOTIFICATION
[ ] Bulk Update Job #1 completed successfully. * 20
a few seconds ago
SYSTEM NOTIFICATION
©  Buk Update Job #1 queued. .

a few seconds ago

You can also view the status and other details of the job on the Job Management

page.

Scenarios

Add Multiple Attributes

1. The user narrows down the Threat Library using advanced search filters.
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2. The user selects Bulk Changes from the Actions dropdown.

3. The user enters the Attribute Name, Value, and Source for the first row in the

Attributes section.
4. The user clicks on Add Row.
5. The user enters the Attribute Name, Value, and Source for the new row.

6. The user clicks on Apply Changes.
Results

« All objects with in the list will have those attributes added

The attributes will be listed in the audit log mentioning that this. The
author of the action will be "Job ID <job_id_number> (<username>)"

Remove Multiple Attributes

1. The user narrows down the Threat Library using advanced search filters.
2. The user selects Bulk Changes from the Actions dropdown.

3. The user selects Remove from the dropdown in the Aftributes section and then

enters the Attribute Name, Value, and Source for the first row.
4. The user clicks on Add Row.

5. The user selects Remove from the dropdown and then enters the Attribute Name,

Value, and Source for the second row.

6. The user clicks on Apply Changes.
Results

« All objects in that change set that have the attributes specified (exact Name,

Value, Source) will have them removed
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The attributes will be listed in the audit log mentioning that
this. The author of the action will be "Job ID <job_id_number>
(<username>)"

« Any object that does not have the attributes specified (exact Name, Value,

Source) will be skipped.

"l

There will be no mentions of the job in the audit log for those
objects because no changes were made.

Add and Remove Attributes
In this scenario, the platform will execute the Bulk Changes in the following order:

1. Add Attributes - See the Add Multiple Attributes Scenario above.

2. Remove Attributes - See the Remove Multiple Attributes Scenario above.

Managing Saved Searches

If you are following a particular area of interest, you can create a Saved Search. Saved

Searches can then be run atany time.
Related Topics:

o Saving Searches

« Running Saved Searches

« Deleting Saved Search

Saving Searches

To save a search:
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1. Choose the Search icon.

2.

In the Search dialog box, choose Advanced Search.

"l

You can also select Threat Library > Object Type to navigate to the
advanced search page for a specific object type.

Perform an Advanced Search.

Choose Save.

The Save Search dialog box opens.

Save Search

Name Your Search

5. Enter a name for the search in the Save Search dialog box.
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6. Choose Save Search.

The name of the saved search will appear at the top of the page.

THREATQ 3 ii\ Threat Library A Investigations Lul Analytics

e Adversaries 0 | @ Last Modified

@ Attack Patterns 0 All Objects -

Load Search = [8) Save

@ Events 0 Filter Set 1 QO not
@ Exploit Targets 0
CREATED AT Before 10/21/2019 09:31pm
Files 0
Identities 0 M AdA Anathar Cilbar Sat

Running Saved Searches
To run a saved search:

1. Navigate to the Advanced Search page.
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2. Click on the Load Search dropdown list and then select the desired saved search

from the list.

@ Threat Library

All Objects v Q Search for keyw

Load Search = [8) Save

SaveThatSearch

ThreatQ Search T

3. The saved search will load. The name of saved search will appear at the top of the

page.

THREATQ 3 i\ Threat Library & Investigations Lul Analytics

e Adversaries 0 | @ Last Modified

e Attack Patterns 0 All Objects - Q, Search for keywords...

Load Search ~ [§) Save

@ Events 0 Filter Set1 QO Not

@ Exploit Targets 0

@ Files 0
Identities

CREATEDAT  Before 10/21/2019 09:31pm

[=]

MM AdA Anathar Cilkar Catr
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Deleting Saved Search
To delete a saved search:

1. Navigate to the Advanced Search page.

2. Click on the Load Search dropdown, hover the mouse over the saved search to
delete, and click on the 'l icon.

3. Click on Delete Search to confirm.

Are You Sure?

This will delete your search from the list.

Delete Search ‘ Canc

Exporting Search Results to CSV

You can export your search results as a CSV file, which allows you to use the data in

another application, such as external spreadsheet software.

e N

ﬂ If you export a file with too many search results, the file may be too large to
open in desktop applications. If you encounter this issue, you should sep-
arate your exports into smaller chunks of data.

s N

ﬂ When exporting search results to a CSV file, if you include additional
columns beyond the default, this modification will impact the performance
of the export process.

A\ J

To export search results to a CSV file:
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1. Navigate to the Advanced Search page.
2. Perform your search.
3. Choose Export.
@ Threat Library
All Objects - 2\ Search for keywords... T Clear Filter:
M| Save You currently have 1 filter set

Filter Set 1

@ Add Another Filter Set

@ Indicators (2,211)

I Type - I I Status - l l Score

VALUE = T™PE =

@ zyrdu.cruisingsmallship.com FQDN

The CSV file downloads to your desktop.

System Objects

m N

M@ Manage Columns =

DATE CREATED =

08/08/2019 03:30pm

Threat data, both ingested and manually added, is referred to as System Objects and is sor-

ted and categorized by object type.

See the topics below to learn more about each object type and how to manage them.

System Objects:

Adversaries

« Events
« Files

Indicators
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« Signatures
« STIX Overview

Adversaries
Adversaries are the suspected groups that are attempting to do malicious activity.
Related Topics

o Adding Adversaries

o Editing Adversaries

o Deleting Adversaries

Adding Adversaries
To create an Adversary:

1. Go to Create > Adversary.
The Add an Adversary dialog box opens.

ThreatQ User Guide, Version 4.39 224



THREA TQH Threat Library

Add An Adversary

Add new source

Description

Farmal

Related Objects (optional)

All Objects d

2. Enter a name.

3. Select a Source from the dropdown provided.

-~

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
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opic for more information on TLP schema.

Source

Threat Library

Demo ) -

Select a source

® RED
Stalus )
& AMBER
@ GREEN

WHITE

[¥) NONE

4. Enter a description.

5. Select any Related Objects you need to link to the adversary. This field is optional.
6. Click Add Adversary.

Editing Adversaries
To edit the name of an Adversary:

1. Locate and click the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing

2. Click on Edit next to the Adversary name.

The Edit Adversary dialog box opens.

Edit Adversary

‘ Claw

3. Make the desired change to the Adversary name.
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4. Click on Save Adversary.
Deleting Adversaries
To delete an Adversary:

1. Locate and click on the adversary.

The Adversary Details page opens.
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THREATQ 3 i\ Threat Library

Claw ¢ Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17pm

@ Context

@) Attributes (2) | (0 ATTRIBUTETYP

@ Attributes

&3 Sources (1) Q Start typing
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2. Click on the Actions menu and select Delete Adversary.
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Claw & Edit
ADVERSARY

Created: 04/17/2019  First Seen: 04/17/2019 06:17f

@ Attribu

@ @ Context

(

o | ® Add Attribute O  ATTRIBUT
2 Add Comment

(= Q Starti
¢ Add Relationship

R O Confidenc
5 Add Source

& | O MalwareT

© Create Task

&
Generate PDF
J

@I il Delete Adversary =1 Source

@ Tasks (2)

O Self Monitor

ThreatQ User Guide, Version 4.39 231



THR EA TO” Threat Library

A confirmation dialog box appears.

Are You Sure?

Deleting this Adversary can not be undone.

Delete Adversary | Cancel |

3. Click on Delete Adversary.

Events

Events are observations made by the threat intelligence community of adversaries’ mali-

cious attempts.
Related Topics:

« Adding Events

« Editing Events

« Deleting Events

Adding Events
To add an Event:

1. Go to Create > Event.
The Add Event dialog box opens.
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Add Event

Spearphish

Add new source

Provide the content you'd like to be parsed for the spearphish event.

&b

Drag your file here or click to browse

Supported files include: eml, emlx, msg, and txt.

Related Objects (optional)

All Objects

L )

2. Select the Event Type.

3. Select a Source from the dropdown list provided.

r

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
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opic for more information on TLP schema.

Source

Demo -

Select a source

@ RED
Status )

) AMBER

@ GREEN

WHITE

<) NONE

Add the date and time the event occurred in the Date of Occurrence fields.
Add an Event Title.
Select any Related Objects you need to link to the event. This field is optional.

Click Add Event.

N o a &

Editing Events

To edit an Event:

u,

You can also update the Event Type by clicking on the Type dropdown
located to the top-right of the Event's Object Details page.

1. Locate and click on the event.

The Event Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on Edit next to the Event name.

The Edit Event dialog box opens.

Edit Event %

‘ Help Desk DoS Attack ‘

‘ April v 17 - 2019 v 10:38 AM ® uTC -

3. Make the desired change to the Event Name and Event Date.

4. Click on Save Event.
Deleting Events
To delete an Event:

1. Locate and click the event.

The Events Details page opens.
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THREATQ 3 i\ Threat Library A In

Help Desk DoS Attack ¢edit
EVENT: DOS ATTACK

Created: 04/17/2019  Event Date: 04/17/2019 10:38am  F

@ Context

@ Attributes (1) | (0 ATTRIBUTE TYPE

@ Attributes (1)

O Sources (2) Q Start typing...
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2. Click on the Actions menu and select Delete Event.
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Created: 04/17/2019 Event Date: 04/1

G Context

[¢

@ «
o © Add Attribute ]

2 Add Comment
=1
& Add Relationship

< C
5 Add Source

@ |
© Create Task

& |
Generate PDF

@| E
] Delete Event |

] . .
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A confirmation dialog box appears.

Are You Sure?

Deleting this Event can not be undone.

Delete Event Cancel

3. Click on Delete Event.

Files

Files are received from various intelligence providers and contain information on indicators,

adversaries, and events within ThreatQ.

Related Topics:

o Adding Files
« Editing Files

o Deleting Files

Adding Files
To add a File:

1. Click Create New > File.

The Add a File dialog box opens.
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ADD A FILE

&

Drag your file here or click to browse.
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2. Drag the file into the dialog box or browse and locate the file.
The Add a File Dialog box will update.

Add a File

Add new source

CrowdStrike Intelligence

off (Q) oN

‘ & ‘ Enabling this will .zip files for safer download. To
unzip, use the password "infected".

Tags

Type here and press enter
Related Objects (optional)

All Objects
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3.
4.

8.
9.

Update the Title if desired.

Select a Source from the dropdown list provided.

Threat Library

e

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)

topic for more information on TLP schema.
i

Source
Demo
Selact a source

Status

| -

Select a Category.

Select whether to have the Malware Safety Lock on or off.

"l

Enabling the safety lock will create a password-protected .zip file so
any malware is safer for download. The system default password is
"infected."

Add any desired tags.

ﬂ Tags added appear on the File Details page.

Select any Related Objects you need to link to the file. This field is optional.
Click Save File.

Editing Files

To edit a File Name:
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1. Locate and click on the file.

The File Details page opens.

THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute

2. Click on Edit next to the File name.

The Edit File dialog box opens.

Edit File
sﬁam_email.txt

spam_email.txt

3. Make the desired change to the File Name.
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4. Click on Save File.
Deleting Files
To delete a File:

1. Locate and click the file.

The File Details page opens.
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THREATQ 3 i\ Threat Library

spam_email.txt ¢ Edit
FILE: GENERIC TEXT

Created: 03/12/2019 First Seen: 03/12/2019 07:27am

@ Context

2 Attrilabac 113 I M ATTRIBUTE TY

@ Attribute
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2. Click on Actions menu and select Delete File.
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G Context

@ Add Attribute

DIy,
2 Add Comment
af
& Add Relationship
79
& Add Source
> 1
© Create Task
3 |
Generate PDF ,
) |

3' ] Delete File

A confirmation dialog box appears.
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Are You Sure?

Deleting this File can not be undone.

Delete File Cancel

3. Click on Delete File.

Indicators

Indicators are the so called "finger prints" associated with a malicious attempt or adversary

group.

Indicators can be scored to allow you to apply weighting using contextual information, such
as sources, attributes, and indicator types, as they are added to ThreatQ. You can also seta

manual score per indicator.

You can also apply expiration dates to an indicator to when it is determined to pose less of a

threat to your infrastructure than other indicators.
Related Topics:

Adding an Indicator

Parsing for an Indicator

Indicator Search

Indicator Expiration

Automatic Expiration and Policies

Indicator Scoring
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« Whitelisted Indicators

« Indicator URL Normalization

Adding an Indicator
To add an Indicator:

1. Click on Create > Indicator.

"1

You can also select Indicator Parser from the Create menu if import-
ing a file. The option is located under the Import section of the
Create menu. See the Parsing for an Indicator topic.

The Add Indicators dialog box opens.

Add Indicators

Parse For Indicators Add Indicator

Add new source

Related Objects foptional)

All Objects v

2. Enter a value in the Value field.

3. Select the Type of Indicator.
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4. Select a Source from the provided dropdown list.

4 Y

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo
Select a source

Status

| N

5. Select a Status for the indicator.

6. Select any Related Objects you need to link to the indicator. This field is optional.

7. Click Add Indicator.
Parsing for an Indicator

1. Click on the Create button, located at the top of the dashboard and select Indicator

Parser under the Import heading.

"

You can also click on Create > Indicator and then select the Parse
for Indicators option at the top of the Add Indicators modal.
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The Add Indicators dialog box will load.

Add Indicators "

Parse For Indicators Add Indicator

Provide the content you'd like to be parsed for indicators.

& :

Drag your files here or click to browse

Supported files include: xml, plain text, csv.

Normalize URL Indicators

e — |

2. Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

3. Select the Parser to use and click on Next Step.

4. Select whether to save or delete the file after the import.

"

Steps 5-7 pertain to saving the file. Skip to step 8 if you are not sav-
ing the file after import.

5. Update the File Title if needed.

6. Enter an optional File Description.
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7. Confirm or update the File Category.

8. Select a Source from the dropdown menu provided.

e

ﬂ Users can also click on Add a New Source if the desired source is
not listed in the dropdown menu. If administrators have enabled TLP
view settings, users can select a TLP classification light for the new
source in the dropdown menu provided. See the Traffic Light Pro-
tocol (TLP) topic for more information on TLP classifications.

Add Indicators

Parse For Indicators Add Indicator

demao

Select a source

[ |
9. Select a Status to be applied to the extracted indicators.
10. Select any optional Attributes to be applied.
11. Click on Next Step.
ﬂ If the file contains events that are detected, the Step 2: Review
Events page opens. Indicators may be new or pre-existing. Pre-exist-
ing indicators are identified by a badge within the table. You can isol-
ate new and pre-existing indicators by using the tabs at the top of the
right hand panel.
12. Locate and select one or more indicators using one of the following options:
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« From within the contents (on the left)
« From the table (on the right)
» By using the Select dropdown menu
13. Once you have selected one or more indicators, you can perform these functions:

1. Add Info - Click the Add Info button to open the Add Info dialog box where you

can perform the following functions:

« Add Attributes to the indicator: add one or more attributes to the selected

indicator(s). Once completed, click Add Attributes.

« Link to Another Object: Link the selected indicator(s) to another object

(indicator, event, adversary, file) and click Link Object.
« Set Status: Select a status and click Set Status.

2. Edit the type or status of an indicator by clicking its type or status in the table and

selecting an option from the dropdown menu.

3. Add Indicator - If you notice an indicator on the left that was not extracted, you

can add it by clicking Add Indicator and completing the process.

4. If you wantto search within the table, use the fields at the top of the columns.

If at any point, you wish to abandon the import, click x ABANDON THIS
IMPORT.

15. Click on Finish Import.
CSV File Format - Parsing

When importing a .csv file to parse for indicators using the ThreatQ CSV File Parser, the .csv

file must meet the following criteria:
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o The file must be comma-delimited.
« The file mustinclude at least the following columns:
o Indicator

o Type: This column cannot contain types that are not already established in
ThreatQ. You cannot add custom indicator types and indicator types are case

sensitive. Choose from the following:
« CIDR Block
« CVE
« Email Address
« Email Attachment
o Email Subject
» File Path
» Filename
« FQDN
o Fuzzy Hash
o GOST Hash
« IP Address
. MD5
o Mutex
» Password
« Registry Key
o SHA-1
o SHA-256
. SHA-384
o SHA-512
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o String
. URL
« URL Path
« User-agent
» Username
« X-Mailer

o Status

If the file is not properly delimited, missing a required column, or containing a valid type, it

will fail upon upload.
Editing Indicators
To edit an Indicator:

1. Locate and click on the indicator.

The Indicator Details page opens.

THREA TQ 3 i\ Threat Library

2.50.52.255 & Edit
INDICATOR: IP Address

Created: 04/17/2019  First Seen: 04/12/2019 07:49pi
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2. Click on Edit next to the Indicator name.

The Edit Indicator dialog box opens.

Edit Indicator

Value
zzygdx.com

Type
FQDN v

3. Make the desired change to the indicator Value and Type.

4. Click on Save Indicator.
Deleting Indicators
To delete an Indicator:

1. Locate and click on the Indicator.

The Indicator Details page opens.
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Demo & Edit
INDICATOR: Email Subject

Created: 04/17/2019  First Seen: 04/17/2019 07:16pm  Expires: add date =

@ Attributes

@ Context
@ «
@ Add Attribute No attributes have
@ ! Click the Add button to add atl
& Add Comment
B¢
& Add Relationship
] Add S
jua} ource
7 =7 sources
|

@ Create Task

‘5) I ATT&CK Tools

[ Generate PDF

O

W Delete Indicator

= ) Tags

x Operations

2. Click on Delete this Indicator located to the top right of the page.

A confirmation dialog box appears.

Are You Sure?

Deleting this Indicator can not be undone.

Delete Indicator Cancel

3. Click on Delete Indicator.
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Indicator Search

Indicator Search allows you to search indicators based on a wide range of modifiers and
search criteria. For example, when searching for an event, the results will include all indic-

ators related to that event.

Using indicator search will provide the total number of indicators matching
the criteria of your search, however, the page will only load 1,000 indic-
ators within the results table.

With respect to searching for IP Address or CIDR Block indicators, your results will be as fol-

lows:

« If searching for an IP Address, CIDR blocks will be returned if they fall within the

range.

« If searching for CIDR blocks, IP addresses will be returned if they fall within the

range.

This will search indicator values as well as Attribute of type “IP Address”
(for instance, if an IP address is associated to another IP address through
a passive DNS relationship).

Performing an Indicator Search

To perform an Indicator Search:
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1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.
The Indicator Search page appears.
THREATQ 3 iy Threat Library A Inw Lk Analytics

Q, Indicator Search

Select a search filter - - u
e ] lide Form =

3. Select the desired search parameters and operators using the dropdowns, and

enter the values.

Parameter Operator
Is
' Is not
Indicator Class
Is Blank
Is Not Blank
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Parameter Operator

Indicator Value

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

List of Indicators

Contains

Does Not Contain
Is

Is not

Is Blank

Is Not Blank

Indicator Status

Is

Is not

Is Blank

Is Not Blank

Indicator Type

Is

Is not

Is Blank

Is Not Blank

Date Created

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank

Date Last Modified

Is

Is not

Is after

Is before

Is in the range of
Is Blank

Is Not Blank
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Parameter Operator

Contains
Does Not Contain
) Is
Attachment Title
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Adversary
Is not
Is Blank

Is Not Blank

Contains
Does Not Contain
Is
Event Title
Is not
Is Blank

Is Not Blank

Is

Is not

Is Blank

Is Not Blank

Event Type

Contains
Does Not Contain
) Is
Attribute
Is not
Is Blank

Is Not Blank

Click + to add more parameters. When your search consists of more than one para-

meter, you can select and or or using the dropdown between the search parameters.

ThreatQ User Guide, Version 4.39 262



THREA TQH Threat Library

4. Click Search.
Search results are displayed in a search results table.
THREATO 3 il Threat Library Lo Investigations Lid Analytics

Q, Indicator Search

Indicator Status - Is - Active - n

[ Reset Recent Searches = Hide Form =
Search :QESU|[._: ‘Make Bulk Changes to 1,000 Indicators
Showing 1 te 25 of 1000 Row count: 25 3

M INDICATOR & TYPE & S{EU.CE STATUS & SCORE & DATE CREATED & EXPIRATION DATE & AE‘WERS#.RIES

1.178.179,217 IP Address J:yhlj‘ Active a 03/15/2019 07:04pm

1.179.170.7 |P Address J:yT' Active Q 03/15/2019 07:04pm

101.187.28.8 IP Address Jrf’yhlj" Active a 03/15/2019 07:04pm

B 103.13.29.158 1P Address J:JI‘_’," Active 0 03/15/2019 07:04pm

103.16.131.20 IP Address JI'ID;"T- Active ] 03/15/2019 07:04pm

5. (Optional) Change the number of entries shown in the search results table by

clicking the dropdown menu at the top right and selecting the desired option.

6. (Optional) Click a column header to sort the data by column, and click again to

reverse sort order.

7. (Optional) Search within a column by clicking within the search field at the top of

the column, entering a search keyword, and pressing Enter.
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Results will be shown below the search query.
THREATQ )  m ety

Q Indicator Search

Indicator Status - Is - Active - n
m [ Recent Searches Hide Form =

Search Resulis Make Bulk Changes to 1,000 Indicators

Showing 1 to 25 of 1000 Row count: 25 3
M INDICATOR & TYFE & s?UICE STATUS @ SCORE & DATE CREATED & EXPIRATION DATE & aEVFRSARIES
1.178.179.217 IP Address J:thj‘ Active 0 03/15/2019 07:04pm
B 1.1791470.7 1P Address JI'IC;'T- Active 0 03/15/2009 OT:04pm
101.187.28.8 IP Address J:yhl;" Active 0 03/15/2019 OT:04pm
@ 103.13.29.158 1P Address J:JI‘J’" Active 0 03/15/2019 07:04pm
103.16.131.20 IP Address J:y?- Active 1] 03/15/2019 O7:04pm

You can hide the query to view more of the search results.
Making Bulk Updates to Search Results

The bulk update tool allows you to make batch changes to the objects in your Search res-

ults. The tool is limited to 1000 objects per update.

To make bulk updates to search results:
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1. From the main menu, click the Search icon.

The Search dialog box appears.

SEARCH

Advanced Search Indicator Search

During a search, you may use a percent sign (%) ta match characters in a string. For example,
specifying net% matches netwark, netware, netscape, and so on: See more examples.

2. Click Indicator Search.

The Indicator Search page appears.
THREATQ 3 i\ Threat Library

Q, Indicator Search

Select a search filter - - u
, ‘ Hide Form =

3. Perform your Indicator Search.
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4. Atthe top of the Search Results, choose Make Bulk Changes to 1,000 Indicators.

The Bulk Update Tool appears.
THREATO 3 () Home ) Threat Library ~ s Investigations

Bulk Update Tool Your changes will affect 1,000 Indicators
Apply a new status

Provide an additional source
Select a source o
Add new source

Apply Attributes

- v Selact a source -

Add new source

Relate 1o ancther object (e.g. an indicator, event, adversary, etc...)

Update Expiration Policy

Extend Date

Add a number of days to expiration date:

5. Optionally, apply a new object status by choosing from the dropdown.
6. Optionally, enter an additional source.
7. Optionally, apply one or more attributes:

a. Choose an Attribute Type from the dropdown.

b. Enter an Attribute Value.

c. Enter an Attribute Source.

d. Optionally, choose the add icon to apply additional attributes.

8. Optionally, relate your search results to another object in the platform. As you

enter the related object, ThreatQ offers type-ahead suggestions.
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9. Optionally, update the object's expiration policy, by choosing an option from the

Update Expiration Policy dropdown.

10. Click Apply Changes.

Indicator Status
Every indicator in the system will have a status applied to it.

The default statuses that ship with a standard installation of ThreatQ are as follows:

Status Description

Active Poses a threat and is being exported to detection tools.
Indirect Associated to an active indicator or event (i.e. pDNS).
Review Requires further analysis.

Whitelisted | Poses NO risk and should never be deployed.

Expired Indicator has reached its expiration and has been is deemed by an ana-

lyst to pose less of a threat to their infrastructure than other indicators.

"1

You cannot delete a default status but you can add new custom statuses
to be used. See Adding an Indicator Status and the Related Topics sec-
tion below for more details.

A J

Most exports in ThreatQ are configured to use the Active status to signal deployment to
external devices. However this can be modified and each status can be used however your

organization sees fit.
Related Topics:

« Changing the Status of an Indicator

« Bulk Status Change

« Indicator Statuses
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o Indicator Expiration

« Automatic Expiration and Policies

Changing the Status of an Indicator

Changing an indicator’s status is straightforward, except in the case of whitelisting CIDR

Block indicators. When whitelisting a CIDR Block indicator, this process generates a whitel-

isting rule. See Whitelisted Indicators for more information.

"1

See the Bulk Status Change topic for information on changing the status

for multiple indicators.

Changing the status of an indicator:

1. Locate and click the indicator to open its details page.

2. Click the status dropdown menu, and select the desired status.

SCORE: o0-Verylow =~ (i) STATUS: [ Active

Expired

No longer poses a serious threat.

Indirect

ociated to an active indicator or event (i.e. pDNS).

ided.

to this object.

Review
Requires further analysis.

Whitelisted
Poses NO risk and should never be deployed.
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The status will be updated.

'd N\

ﬂ If an Administrator or the Primary Contributor are whitelisting a CIDR
BLOCK indicator, there is a different process, as this actually gen-
erates a whitelisting rule. For more information, see the Creating a
Whitelist Rule topic.

A

Indicator Expiration

Expiration ("Expired") is a status that can be assigned to an indicator. The expired status
should be used when an indicator is deemed by an analyst to pose less of a threat to their

infrastructure than other indicators.
Related Topics:

Ways an Indicator can Expire

Expiration Date Displays

Changing an Individual Indicator's Date

Automatic Expiration and Policies

Ways an Indicator can Expire
« An analyst manually changes an indicator(s) status to "Expired"

This can be achieved by visiting an individual indicator's details page, then using the

Status dropdown in the top right hand comer of the page to change the status.

If the analyst wishes to change the status of multiple indicators at the same time, they
can use the advanced search tool to find the indicators they'd like to update, then click

the Bulk Update button found directly to the right above the search results.
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« An analyst manually sets an expiration date for a specific indicator

Each indicator has the option to have an expiration date set, which once past, will

toggle the status of that indicator from it's current status to "Expired".

« An expiration policy has been applied to the source reporting an indicator and
therefore an expiration date is automatically set for that indicator during inges-

tion

Using the “Expiration” tab on the Indicator Management page, a ThreatQ admin has
the ability to apply expiration policies to all ingested information, both new and exist-

ing, coming from a specific intelligence source.

G If an indicator is reported by multiple sources that have expiration policies,
the date will be set using the greater expiration date. For example, if both
Feed A (with a 5 day policy) and Feed B (with a 3 day policy) report the
same indicator on the same day, that indicator will automatically expire 5
days from now.

Changing an Individual Indicator's Date

See the Bulk Change Expiration Date topic for steps on updating the
expiration date for a group of indicators.

When viewing a specific indicator, its expiration date can be changed by clicking on the link

next to the expiration information.
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THREATQ 3 iiy Threat Library A Investigations Lut Analytics

195.123.245.83:447/tt0002/william-
pc_w629200.f71819bb1edf5078c2b2ab2aff931102/5/bcclientdll64/

INDICATOR: URL

Created: 05/09/2019 First Seen: 05/09/2019 07:31am Expires: add date ~
Add 7 days
. Add 14 da
@ Attributes (10) v
@ Context Protect from auto-expiration
@ Attributes (10) | 0 ATTRIBUTETYPE = Remove current expiration date JE =

L L

Options include:

Option Description

Add 7 Days This will extend the current expiration date by 7 days.
Add 14 Days This will extend the current expiration date by 14 days.
Protect from This will set the indicator to "Never Expire". Once set, this indic-

Auto-Expiration ator will be exempt from all automated expiration processes
regardless of circumstances. The only way for this indicator to

expire moving forward is by analyst choice.

Remove Current | This will remove the currently set expiration date. If this indicator
Expiration Date is reported by an intelligence feed (with an expiration policy) in

the future, a new expiration date will be added at that point in time.
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Expiration Date Displays

Option

No expir-
ation date

has been set

Image

In this example, thg

Expwes add date «

This status will be
or a new source (W

this indicator in the

Description

indicator will not automatically expire

becauseanexpiration date has not been specified.

changed if an analyst sets an expiration date
th an expiration policy applied to it) reports

future.

ation (Never

Expire)

words "Never Expirg

An expir- Expires I higsexample, the indicator has an expiration date set of
ation date is 1/20/2017. This means that this indicator will expire when the cal-
set endar day changes fram the 19th to the 20th of January (based
on ThreatQ's server time, not the user's local time).
ExpiresYMh}ea'E@g g)}gg}irq }iqn date is less than 7 days away, ThreatQ will
switch to show a relative version of the date.
Protected ‘IS: ometimes an analyst will want an indicator to stay "Active" regard-
Never Expire (change) =
from auto- less of any automated circumstances. In this case you can set an
matic expir- indicator to be protegted from auto-expiration, which will display the

". This can only be "overwritten" by an analyst.

Automatic Expiration and Policies

Automatic expiration allows you to deprecate stale intelligence based on a set of defined cri-

teria. As the data becomes less relevant, ThreatQ sets the status to Expired, which relieves

the data burden on your team or infrastructure.

You can configure automatic expiration from the Data Management page.
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1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.

Related Topics:

« How ThreatQ Calculates Expiration Dates

Selecting an Expiration Policy per Feed

Applying Expiration Policy Changes to Data

Adding Exceptions

« Common Expiration Policy Scenarios

How ThreatQ Calculates Expiration Dates

Scenario Description

Indicator If an indicator has an expiration date and it's reported by a new
Reported by source that has an expiration policy, ThreatQ will set the expiration

Source with an | date using the policy with the greater expiration date.

Expiration

Policy

Indicator If an indicator has an expiration date and it's reported by a new
Report by a source that has an expiration policy of Never Expire, ThreatQ sets

Source with an | that indicator to Never Expire.
Expiration
Policy of Never

Expire

Indicator If an indicator is reported by a source that has an exception for the

Reported by a | indicator, the exception expiration date will be used regardless of
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Source with an | the greater expiration date.

Exception for

"

that Indicator ﬂ An exception takes precedence over the source’s

expire policy.
Indicator If an indicator is reported by a source with an Expiration Policy and
Reported by then reported by a second source with another Expiration Policy, the

Two Different | greatest expiration date is selected to set the expiration date. The
Sources expiration date will be set based on the date the second source

reported the indicator.

Indicator If an indicator is reported by a source that has an exception for the
Reported by indicator and then reported by a second source, the greatest expir-
Two Different | ation date is selected despite the exception. The expiration date will
Sources, one be set based on the date the second source reported the indicator.
with an Excep-

tion

Selecting an Expiration Policy per Feed

You can choose from three options when configuring an expiration policy for a source of

intelligence:
Option Description
Don't automatically ThreatQ sets all feeds to Don't Automatically Expire until an
expire (No policy set) analyst decides otherwise. When set, indicators reported from

this specific feed do not have an expiration date automatically

applied to them.

If an indicator is reported by Source A (an intelligence feed
without an expiration policy), and is later reported by Source B

(an intelligence feed that expires data in 7 days), ThreatQ sets
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Option Description

the indicators to automatically expire in 7 days.

Automatically Expire When setting a specific intelligence feed to Automatically
Indicators Expire Indicators, ThreatQ requires you to provide a specific
number of days. After you configure this setting, it applies to all
intelligence currently in the system, as well as new intel-
ligence as itis ingested. ThreatQ calculates the appropriate
expiration date based on the number of days from ingestion.

Once an indicator's expiration date is met, its status changes

to Expired.
Automatic Expiration
Unburden your team from the task of manually deprecating intelligence. Based on a set of criteria defined and controlled by you, threat intelligence will automatically
expire as it becomes less relevant to your team and infrastructure. How it works
abuse.ch SSLBL IP Blacklist Don't automatically expire @ Exceptions ~
Exceptions
Binary String - Expire | 25 days after ingestion. il Delete
Never Expire Using this setting ensures that all intelligence reported by a

specific feed is protected from automatic expiration, regard-

less of scenario.

Applying Expiration Policy Changes to Data

When updating an expiration policy, the system now applies the update to all selected
existing data in the platform to honor the new policy. This process can take a while based on

system resources and the number of indicators in the system.

Refer to the following table for estimates on the total time required for the system to apply the

selected policy to existing data, based on the following criteria:
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« Dataset: 6 Million Indicators

« System Specifications: 32GB VM 4 vCPU

Indicators to reset

Reset and Recal- Total Time for
expiration out of - Expire Indicators
- culate Expiration Reset
6m total indicators
50,000 3 hours and 30 53 seconds
3 hours 31 minutes
minutes
100,000 4 hours and 51 1.8 minutes
_ 4 hours 53 minutes
minutes
200,000 10 hours 20 minutes | 3.5 minutes 10 hours 24
minutes
1.2 million 2 days 7 hours 4 35 minutes 2 days 7 hours 40
minutes minutes
3.1 million 3 days 16 hours 42 | 3.5 hours
_ 3 days 20 hours
minutes
4 days 7 hours 17
5.3 million _ 4.7 hours 4 days 12 hours
minutes

Adding Exceptions

ThreatQ allows you to add exceptions based on specific indicator types within in a feed in
addition to setting an expiration policy at a global level for all intelligence ingested by a spe-

cific feed.
To Add an Exception:

1. Navigate to the Automatic Expiration tab under Data Management.

2. Locate the source.
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3. Click Exceptions to expand the option.

The Exceptions option menu opens.

Data Management

Whitalisted Indicatars Autoenstic Expiration  Seoring

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence, Based on a set of criteria defined and controlled by you, threat intelligence will automanically expire as it becomes less

relevant to your team and infrastructure, How ity
abuse.ch Feodo Tracker Botnet C2 1P Cron't automatically expire - ExCeprions »
Blocklist
admin@threatg.com Don't automatically expire - Exceptions *
e N
%
o

The number of existing exceptions for a source will be listed next to
its Exceptions link.

€) Exceptions »

4. Click Add Exception.
5. Select the Indicator Type from the dropdown.

6. Enter the number of days after the item has been ingested before expiring.

ﬂ Repeat steps 4-6 to add multiple

7. Click on Delete next to the row to delete an exception.
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8. Click on Save.

Common Expiration Policy Scenarios

Scenario Description

An indicator is reported by a single

source (with an expiration policy)

1. On 10/1, Source A reports the indicator

and the expiration date is setto 10/8.

. When the date switches from 10/7 to 10/8,

this indicator is queued to have its status

changed to Expired.

An indicator is reported by Source A
(with an expiration policy of 7 days)
and 3 days later is reported by
Source B (with an expiration policy of
10 days).

. On 10/1, Source A reports the indicator

and the expiration date is setto 10/8.

. Source B reports the same indicator 3

days later (10/4). The indicator's expir-
ation date is set using the greatest expir-
ation date between the two sources. In
this example, the new expiration date will
be 10/14 (10 days from when it was repor-
ted by Source B).

. When the date switches from 10/14 to

10/15, this indicator is queued to have its

status changed to Expired.

An indicator is reported by Source A
(with an expiration policy of 7 days)
and is later reported by Source B

(with an expiration policy of Never

Expire).

. On 10/1, Source A reports the indicator

and the expiration date is set to 7 days.

. Source B reports the same indicator 3

days later with a policy of Never Expire.
The indicator’s expiration date is removed
and the indicator is now set to Protect

from auto-expiration.
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Scenario Description

An indicator is currently set to
Expired and is reported by Source A
(with an expiration policy of 7 days).

1.

On 10/1, an indicator is in ThreatQ with a

status of Expired.

. On 10/1, Source A reports the indicator.

The status of the indicator changes to
whatever the default status is for Source A

and the expiration date is setto 10/8.

When the date switches from 10/7 to 10/8,
this indicator is queued to have its status

changed to Expired.

An indicator is currently set to
Expired and is reported by Source A

(with an expiration policy of Never

Expire).

. Anindicator is in ThreatQ with a status of

Expired.

. Source A, with an expiration policy of

Never Expire, reports the indicator. The
expiration of that indicator changes to Pro-

tect from auto-expiration.

A FQDN indicator is reported by
Source A (with an expiration policy of
10 days with an exception for 5 days
for FQDN indicators) and is later
reported by Source B (with an expir-
ation policy of 15 days).

. On 10/1, Source A reports the FQDN indic-

ator and the expiration date is setto 10/6.

"]

An exception takes pre-
cedence over the
source’s expire policy.

. Source B reports the same indicator 1 day

later (10/2). The indicator's expiration date
is set using the greatest expiration date
between the two sources. In this example,
the new expiration date will be 10/17 (15

days from when it was reported by Source
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Scenario Description

B).
3. When the date switches from 10/17 to

10/18, this indicator is queued to have its

status changed to Expired.

Indicator Scoring

Indicator scoring allows you to apply weighting to indicators and their contextual information,
such as sources, attributes, and indicator types, as they are added to ThreatQ. Indicator scor-
ing allows you to set manual scores or you can rely on ThreatQ’s scoring algorithm to cal-
culate scores. After scores are calculated, you can change the score as desired to your

custom value or accept the calculated value.

Related Topics:

« Configure Indicator Scoring

« Building a Scoring Algorithm

» Overriding the Scoring Algorithm with a Manual Score

Configure Indicator Scoring

1. From the navigation menu, click on settings icon 1 and select Data Management.

The Data Management page will open with the Automatic Expiration tab selected by
default.
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2. Click on the Scoring tab.
THREATQ )  m ovescioy

Data Management

whitelsted indicators Automatic Expiration

Scoring Sensitivity Configuration

Indicatar scoring allows you to apply weighting to contextual information, such as sources, attributes, and indicator types, After scores are caloulated, you can change the score as desired on
the individual indicator pages, For each subset of data below, you can increase or decrease the score.

tor 5 At L I
Binary String DECREASED ? INCREASED 0=
CIDR Black DECREASED ? INCREASED o
CVE DECREASED ? INCREASED o
Email Address DECREASED . ? - INCREASED o =

m After clicking sawe, these changes will take time to process and will not immediately take effect

Building a Scoring Algorithm

As you build a scoring algorithm, you influence indicator scores based on the following cri-

teria:
« Indicator Type
« Indicator Source
o Attributes
« Adversary Relationship

Use the slider to determine the sensitivity of the criterion you select. By default, the slider is
positioned in neutral position, which in isolation produces an indicator score of zero. You

may increase the score up to 10, which creates a score of Very High. You may also
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decrease the score, which creates a score of Very Low.
THREATQ 3 @ Threat Library

Data Management

Whitelisted indicatoes AutomiEtic Expiration SEoeing TP

Scoring Sensitivity Configuration

Indicator scoring allows you to apply weighting o contextual information, such as sources, attributes, and indicator types. After scores are caloulated, you can change the score as desired an
the individual indicator pages. For each subset of data below, you can increase or decrease the score

Vdcator Source Altributes Adversary Relaticnship
il fic ¥
Binary 5tring DECREASED ? INCREASED 10 =
CIDR Block DECREASED ? INCREASED | 0 -
CVE DECREASED . ? s IMCREASED | 0
Email Address DECREASED - ? - INCREASED o :

“ Afver clicking s, these changes will take time 1o progess and will not immesately take effect

Influencing Score Based on Attributes

1. Navigate to the Attributes category under Scoring.
Scoring Sensitivity Configuration
Indicator scoring allows you to apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the

score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score,

ndicator Type ndicator Source Attributes Adversary Relationship

scorne * |is B DECREASED - -~ = = == —? —— INCREASED 2 = Dalete

2. Click Add

3. Designate an Attribute Key / Value Pair
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4. Adjust the sensitivity using the slider.
5. Click Save.

Influencing Score based on Adversary Relationship

1. Navigate to the Adversary category under Scoring.
Scoring Sensitivity Configuration

Indicator scoring allows you ta apply weighting to contextual information, such as sources, attributes, and indicator types. After scores are calculated, you can change the
score as desired on the individual indicator pages. For each subset of data below, you can increase or decrease the score,

Indicator Type ndicator Source Altrizutes Adversary Relationshi

| Agitated Rhinoceros : DECREASED R . ? e S INCREASED [+ Delete

2. Click Add

3. Select an Adversary.

4. Adjust the sensitivity using the slider.
5. Click Save.

Overriding the Scoring Algorithm with a Manual Score
Setting a manual Indicator Score:

1. Navigate to an Indicator's Details page.

2. Click the Score dropdown and select a score.
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THREATQ 3

Edil
Demo It SCORE: | O-Verylow » | (i) STATUS:  Active =
INDICATOR: Email Subject
10 - Very High
Created: 041772019 First Seen: 04/17/2019 07:16pm  Expires: add dme - Add ta Watchlist
9 - High
@ Attributes | © add
7 - Madium
(©) context
5-Llow
B sources 1) & sources & Add
4 -Wery Low
¢ Tags (
@ MTRCK Tools 3-Very Law
@ Descrip
2 -Very Low
g§’ Relationships 1 -Very Low
) Tags
{2y comments () 0 -Very Low
}& Operations
B audit Log
[&7 Description & Edit
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Optionally, you may revert to the calculated score by clicking on the Score dropdown

and selecting Generated Score.

SCORE: (i) STATUS: Active ~

I 10 - Very High

8 Add to Watchlist

9 - High

8 - Medium

_ © Add
7 - Medium

6 - Low
5-Low
© Add
4 -Very Low
3 -Very Low
2 -Very Low

1 -Very Low

0 - Very Low

10 - Generated Score

Whitelisted Indicators

There are some indicators that should be considered to be whitelisted, or non-malicious,

and we do not want those indicators going out to other systems. For example, a company’s
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own domain name would never need to be blocked.

The whitelisting process creates rules that apply to particular indicators, so that when those

indicators come in in the future, they will be automatically whitelisted.
Within this section, the following options are available:

Viewing Existing Whitelist Rules

Creating a Whitelist Rule

Editing a Whitelist Rule

Removing a Whitelist Rule

Viewing Existing Whitelist Rules

To view existing whitelist rules:

1. Click on the settings icon E] and select Data Management.

2. Select the Whitelisted Indicators tab

The Whitelist Rules page opens. Existing whitelist rules are listed in the Whitelist
Rules table.
THREATQ 3

Data Management

cenatic Expiration Seoving

Whitelisted Indicators n

Whitelisting indicators designates therm as non-malicious, which ean apply 1o yeur company's demain name of any ether domain your rganization knows L be safe, Threatl) provides you with

the ahility to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted autemarically. How iTwork

(m] RULEVALUE INDICATOR TYPE AFFECTED 2 ACTIONS
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Creating a Whitelist Rule

The process of creating a whitelist rule is almost exclusively available via the Tools menu.
However, itis important to note that whitelisting a CIDR Block indicator also creates a whitel-

istrule.

To create a whitelist rule:

1. Click on the settings icon E! and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team from the task of manually deprecating intelligence. Sased on aset of criteria defined and controlled by you, threat intelligence will automatically expire as it becomes less relevant
ta your team and infrastructure

abuse.ch Feodo Tracker Batnet C2 1P Blocklist | Doet automatically exgire - Exceptions ¢
admin@threatq. com Do Autormatically expire - Exceptions
ATTELK Teals Dierrt automatically expire v Exceptions ¢
Cofense inteliparce Disrit autarmatically expire - Excoptions ¢

m A ickieg apedy, i chargges il ke e 2 prscirss at wll ot invraciatty 1ok afToct
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2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.
THREATQ )  movestoony A esgaions 1o ansiyics

Data Management

Autormatic Expiration Stonng TP

Whitelisted Indicators n

Wiitelisting indicators designates them as sen-malicious, which can apply 1o yeur company’s demain name or any other demain your soganization knows to be safe, ThreatQ pravides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How T works

D RULE VALUE + INDICATOR TYPE AFFECTED 3 ACTIONS

3. Click Add Rule.

The Add Whitelist Rules page opens.

Add Whitelist Rule

— Which indicator type will this rule apply to?
CVE

— Rule Value

CVE-2015-1461

4. Selectthe Indicator type the rule will apply to.
5. Add a Rule Value.

6. Click Next.
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Affected indicators are listed in the dialog box.

Add Whitelist Rule

Continue Editing This Rule

7. Review the affected indicators to determine if you are satisfied with the rule.

"l

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

8. Click Continue Editing this Rule.
9. Ifyou are satisfied with the rule, click Add Rule.

The rule is applied to existing indicators, and it is entered into the Whitelist Rules

table.
Any new indicators will also have the rule applied to them as they enter the system.

Editing a Whitelist Rule

"

Important: Editing a whitelist rule will not undo any changes the rule had
made prior to being edited.

To edit a whitelist rule:
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1. Click on the settings icon ['3 and select Data Management.

The Data Management page opens.

THREATQ )

Data Management

Tk Vititmisted indlcators

Automatic Expiration

unburden your team from the task of manually deprecating intelligence. Based on aset of crireria defined and conerolled by you, threat intelligence wil automatically expire as it becomes bess relevant

ta your beam and infrastructure

abuse.ch Feodo Tracker Baret C2 IF Blocklist | Do automatically expire * Exceptions »
admin@threatq. com Dt automatically expire Exceptions ¢
ATTECK Tesals Dt autarmatically expine - Exceptions ¢
Cofanse intelipance Dot Butomatically expire Excoptions ¢

BEETI o s i s g i s s el ity b o

2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ :, B ThrestUbrory A (mestiabons Ll Anayics

Data Management

Automatic Expration Sonng TP

Whitelisted Indicators n

Whitelisting indicators designates them as non-malicious, which can apply to your company’s demain name or any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply to those particular indicators, so that when those indicators are ingested in the future, they will be whitelisted automatically. How it work

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Inthe Whitelist Rules table, locate the rule you wish to edit.
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4. Click Edit.

The Edit Whitelist Rule dialog box opens.

Edit Whitelist Rule

Which indicator type will this rule apply to?

CVE

— Rule Value

CVE-2015-1461

5. Make the desired edits and click Next.

Affected indicators are listed in the dialog box.

Edit Whitelist Rule *

Continue Editing This Rule
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6. Review the affected indicators to determine if you are satisfied with the rule.

The rule has not been applied yet, so you still have time to edit it
based on whether you are satisfied with how it affects the indicators.

7. If you are satisfied, click Edit Rule.
The rule is applied to existing indicators, and itis updated in the Whitelist Rules table.

Any new indicators will also have the rule applied to them as they enter the system.
Removing a Whitelist Rule

To remove a whitelist rule:

1. Click on the settings icon E and select Data Management.

The Data Management page opens.
THREATQ 3

Data Management

Automatic Expiration

Unburden your team frem the task of manually deprecating intelligence. Sased on aset of craeria defined and carerolled by yau, threat imtzlligence wil automatically expire as it becomes bess relevant
ta your team and infrastructurs

abusech Fecds Tracker Botnet C2 IP Blocklist | Don™ automatcally expire Exceptions

admin@rhrears. cam Dt autoratically expire Excepaions ¥

ATT&CK Toals Dot aUtormatically expine Excepeions
i Lefig Doer automatical Excups
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2. Select the Whitelisted Indicators tab.

The Whitelisted Indicators section loads.

THREATQ 3 W ThrestUbrery A Investigotions Ll Analytcs

Data Management

Automatic Expiration Seoring TLe

Whitelisted Indicators n

wihitelisting indicators designates them as non-malicious, which can apply to yeur company’s demain name o any other domain your organization knows to be safe, ThreatQ provides you with
the ability to create rules that apply 1o those particular indicatars, so that when those indicators are ingested in the future, they will be whitelisted automarically. How 17 wocks

D RULE WALUE INDICATOR TYPE AFFECTED = ACTIONS

3. Locate and select the rule(s) from the table that you wish to remove.

4 Click on the delete Icon B

A confirmation dialog box opens, asking if you are sure.

Are You Sure?

This action cannot be undone.

The status of each indicator will remain whitelisted until manually changed.

Delete Whitelist Rule Cancel
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5. Click Delete Whitelist Rule.

The rule is deleted and a confirmation alert appears in an alert bar at the top of the

page.
Indicator URL Normalization
Remove Quotes from the Beginning and/or End of an Indicator

Single and double quote characters are removed if they are the first or last character of an

indicator.

Remove Unneeded Spaces found within an Indicator

All spaces irrelevant of their position in the Indicator value are removed (when applicable).
Adjust leading protocol from indicators

Indicators with a leading protocol [http:/, hitps:/, ftp://, or ftps://] are extracted and included as
an attribute. When applicable, this indicator adjustment could change the indicator type from
URL to FQDN.

Example: Original URL indicator of http://fevilsubdomain.no-ip.biz/ would convert to a FQDN

= evildomain.no-ip.biz.
Adjust the Port from an IP Address

An IP address with a port [ex. 199.7.136.88:8143] will be truncated to the IP address and the

port assignment will be added as an attribute.

Using the previous example the following indicator/attribute will be created:

Field Value

URL 199.7.136.88

Attribute > Port 8143

Adjust Defanged/Neutered Indicators
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Indicators that have been defanged/neutered in order to “safely” share them (i.e. www [dot]
3322 [dot] org or badguy [at] gmail.com) need to be adjusted during import in order to ensure

the indicators are properly deployed.
Create an IP Address from a URL (when applicable)

Using the previous example the following indicators will be created:

Field Value

URL 51.255.131.66/civis/viewforum.php

IP Address 51.255.131.66

Create a FQDN from a URL (when applicable)

When a URL contains a domain [ex. bat99-11611.co/gate777.php] a second indicator will
be created for the domain [bat99-11611.co].

Using the previous example, the following indicators will be created:

Field Value
bat99-11611.co/g-
URL
ate777.php
FQDN bat99-11611.co

Extract HTTP Parameters from a URL Indicator

HTTP parameters [chained.j3oil-
gasinc.net/civis/iviewforum.php?keywords=9obo&amp;fid0=c27] are important but can sig-
nificantly limit pattern-matching detection capabilities due to the likelihood of parameter
deviations, as well as, hamper the volume of URL indicators being deployed. To increase

the probability of detection the http parameters are extracted and created as attributes.

In this example:
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Field

Value

URL IOC chained.j3oilgasinc.net/civis/viewforum.php

Attribute =HTTP Para-

meter = keywords

9obo&amp;fid0=c27

Maintain “WWW” on FQDN Indicators

When parsing or importing a FQDN the “www” will be maintained.

Replace and/or Remove Special Characters

ASCIl Values <32
ASCII Values > 127

<space>

Replacement

Ascii 96

Ascii145

Ascii146

Ascii147

Ascii148

Ascii151

carriage return and line feed

<space>

Control Characters

Remove

Convertto UTF8

null characters.

Remove leading and trailing space, tab, newline, carriage return, vertical tabs and

ThreatQ User Guide, Version 4.39

296



THREAT() /o~

Threat Library
Supported Defanging Techniques
The table below lists all supported indicator defanging techniques.
[] =>
[dot] =>
(dot) =>
[d] =>
-dot- =>
_dot_ =>
hxxp:// => http://
hxxx:// => http://
hxxps:// => https://
hxxxs:// => https://
[hxxp] => http
hxtp:// => http://
htxp:// => http://
hxtps:// => https://
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htxps://

[http]

[hitp:/N

[https]

[https:/

[at]

-at-

_at_

_@_

(@]

[www]

Signatures

https://

http

http://

https

https://

WwWw

ThreatQ allows you to ingest and manage Signatures, such as Snort and OpenlOC. While

importing, ThreatQ parses the signature file for Indicators to add. Once signatures are

included in your deployment, you can add contextual information and correlate them with

Indicators, Events, Adversaries, and Files.

Related Topics:
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o Signhatures Management Page

« Adding a Signature

o Adding a Yara Signature

Signatures Management Page

The Signatures Overview page displays all signatures in the platform. For each signature,

the table displays the Date Created, Signature Type, and Signature Title.

You can filter the table based on criteria to view specific signatures. For each signature, you

can click to view expanded details.
From the Signatures Overview page, you can do the following:

« View all signatures in the platform and details for each signature
« Filter signatures by Date Created, Signature Type, and Signature Title

« Add new signatures
Adding a Signature

To add a Signature:
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1. From the main menu, choose Create > Signature.

The Add Signatures dialog box
THREATQ 9

opens.

18t Analytic

Add Signatures

tent yaud ke to be parsed for signatures.

8 Parse signature for indicators

Extracted Signatures

Apply attributes to all extracted signatures. (optional)

Relate signatures to another object (a.g. an indicator, event. adversary, atc_.)

All Obgjects

m Step 1: Tell is abaut the Impart > Step 2: Review Signatunes

2. Choose the type of signature from the drop-down .

ﬂ For Yara, see Adding a Yara Signature.

3. Select a Source from the dropdown provided.

e N
x

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.
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4 N\

E ."\ "
Source

Demo
Selact a source

Status

| N

5. Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste content into the right pane.

6. Optionally, select to parse the signature for indicators.
7. Choose a Signature Status from the drop-down menu.
8. Optionally, Apply attributes to all extracted signatures:

« Select an Attribute Type.

» Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

9. Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.
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10. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

11. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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loads.
THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

12. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

13. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

14. Click Delete to remove the unwanted items.
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15. Click Create Signatures when finished.
Adding a Yara Signature
To add a Signature:
1. From the main menu, choose Create > Signature.

The Add Signatures dialog box

opens.
THREATQ 3  mrvesioany & estgasons .

Lt Analytics

Add Signatures

& Parse signature for indicators

Extracted Signatures

Apply attributes ta all extracted signatures. (sptienal)

Relate SIgnatures 1o another alject (2.8, an indicator, event, adversary, e}

All Oljcts

m Spep 1: Tell us about the Import > Step 2 Review Signatures

2. Select Yara as the type of signature from the drop-down .

3. Select a Source from the dropdown provided.

"1

You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source

ThreatQ User Guide, Version 4.39 304



THREA TQH Threat Library

10.

N

ﬂ' in the dropdown list provided. See the Traffic Light Protocol (TLP)
topic for more information on TLP schema.

Source

Demo

Select a source

Status

| 5

Do one of the following:

« Drag your file(s) into the left pane.
« Click click to browse, and locate the file you wish to upload.
« Copy/paste content into the right pane.

Optionally, select to parse the signature for indicators.

Determine the method to use if multiple signatures are discovered:
« Save independently as unique signatures

« Save as a single signature
Choose a Signature Status from the drop-down menu.
Optionally, Apply attributes to all extracted signatures:

» Select an Attribute Type.

« Enter an Attribute Value.

« Enter an Attribute Source.

« Optionally, click the Add icon for additional attributes.

Optionally, relate the signature to another object by entering the object in the

Relate signatures to another object field.
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11. Click Next Step.

If signatures are discovered, the Results dialog box appears.

Results

We've found 979 signatures.

How would you like to proceed?

12. You can either select Submit Import to finish adding the signatures or Review to
customize what data is imported.

If you selected to review signatures, the Add Signatures Step 2: Review page
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loads.
THREATQ )

B Threat Library

Add Signatures

979 Signatures Extracted

m]

BROWSER-IE Microsoft Internet Explerer CDocument use after free attempt (268 Active

20:1)

BROWSER-IE Microsoft Internet Explerer CTreeNode use after free memary corr Active

uption attempt (26889:1)

BROWSER-IE Microsoft Internet Explorer CTreeNode use after free memary corr Active

uption attempt (26888:2)

BROWSER-IE Microsoft Internet Explorer anscroll use after free attempt (26887 Active

5

BROWSER-IE Microseft Internet Explorer onscrall use after free attemnpt (26B86:  Active

5)

BROWSER-IE Microsoft Internet Explorer anscrall use after free attempt (26B85:  Active

5)

Step 1: Tell us about the impaort » Step 2: Review Signatures

13. Select one or more signatures and click Delete.

15 Attributes

15 Attributes

15 Attributes

13 attributes

13 attributes

14 Attributes

0 Indicators

0 Indicators

0 Indicators

O Indicators

O Indicators

0 Indicators

Show Details »

Show Details »

Show Details »

Show Details ¥

Show Detalls ¥

Show Detalls »

14. Click on Show Details for a signature to review individual items in a signature.

Use the checkboxes to select unwanted signature items and click Delete.

A warning dialog box appears.

[iS

Are You Sure?

This will delete the selected Signature items from the import.

Cancel

15. Click Delete to remove the unwanted items.
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16. Click Create Signatures when finished..

STIX
The following describes how to use STIX in ThreatQ:

STIX Overview

ThreatQ STIX Object Types

« STIX Data Mapping

Parsing a STIX File for Indicators

STIX Overview
ThreatQ allows you to ingest and manage STIX files. You can ingest STIX data in two ways:

« You can setup a STIX/TAXII Feed, as described in STIX/Taxii Feeds.

« You can upload a STIX file orinsert STIX data to parse for indicators, as described

in Parsing a STIX File for Indicators.

¢ ThreatQ supports STIX 1.1.1, STIX 1.2 and STIX 2.0.

Related Topics

« STIX Data Mapping

o ThreatQ STIX Object Types

ThreatQ STIX Object Types
STIX integration provides ThreatQ with the following additional object types.

o Campaigns
o Courses of Action
« Exploit Targets

« Incidents
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o TTP objects
Identities (STIX 2.0)

Reports (STIX 2.0)

Vulnerabilities (STIX 2.0)

These objects enable better understanding and communication of STIX data. STIX data will

be mapped to these objects and existing objects in the system.
STIX Data Mapping

The following sections display how STIX data becomes mapped to indicator objects and
attributes in ThreatQ.

o STIX1.1.1, 1.2 Data Mappings

o STIX 2.0 Data Mappings

STIX1.1.1, 1.2 Data Mappings

You can click onthe = icon located to top-right of this topic to expand and collapse all map-

ping tables below.

Threat Actors Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Identity Adversary.value
ID Adversary.attribute STIX Reference ID
Title Adversary.value
Type Adversary.attribute Type
Timestamp Adversary.published_at
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STIX Field ThreatQ Field Mapping ThreatQ Name
Description Adversary.attribute Description
Motivation Adversary.attribute Motivation
Sophistication Adversary.attribute Sophistication
Intended_Effect Adversary.attribute Intended Effect
Role Adversary.attribute Role
Confidence Adversary.attribute Confidence
Handling Adversary tlp
Observed TTPs TTP
Associated_Actors Adversary
Associated_Campaigns Campaign

Indicators Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Indicator.attribute Indicator Title
ID Indicator.attribute STIX Reference ID
Timestamp Indicator.published_at
Type Indicator.attribute Indicator Type
Description Indicator.attribute Description
Short Description Indicator.attribute Short Description
Producer Indicator.source
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STIX Field ThreatQ Field Mapping ThreatQ Name
Observable Indicator
Indicated TTP TTP
Kill_Chain_Phases Indicator.attribute Kill Chain Phase
Likely_Impact Indicator.attribute Likely Impact
Suggested_COAs Course of Action
Handling Indicator.tlp
Confidence Indicator.attribute Confidence
Indicator.attribute.source
Related Observables
Related_Indicators Indicator
Related_Campaigns Campaign
Signature
Signature.type ="Snort"
Signature.value
Indicator.source
Course of Action
Indicator.attribute Start Time
Indicator.attribute End Time
Indicator.published_at

Exploit Targets Mapping
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STIX Field ThreatQ Field Mapping ThreatQ Name
Title Exploit Target.value
ID Exploit Target.attribute | STIX Reference ID
Description Exploit Target.attribute | Description
Short Description Exploit Target.attribute | Short Description
Weakness Exploit Target.attribute | CWE ID
Weakness Exploit Target.attribute | Weakness Description
Configuration Exploit Target.attribute | CCE ID
Configuration Exploit Target.attribute | Configuration Description
Configuration Exploit Target.attribute | Configuration Short Description
Vulnerability Exploit Target.attribute | CVE ID
Potential_COAs Course of Action
Related_Exploit_Targets | Exploit Target

Observables Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
ID Indicator.attribute STIX Reference ID
Indicator.attribute Description
Indicator.type IP Address

Indicator.value

Indicator.type Filename
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STIX Field ThreatQ Field Mapping ThreatQ Name
Indicator.value
Indicator.type File Path
Indicator.value
Indicator.attribute File Size
Indicator.attribute File Format
Indicator.attribute Packer
Indicator.type MD5
Indicator.type SHA-256
Indicator.type SHA-1
Indicator.type SHA-512
Indicator.value
Indicator.type SSDEEP
Indicator.value
Indicator.type FQDN
Indicator.value
Indicator.type URL
Indicator.value
Indicator.type Email Subject
Indicator.value
Indicator.type Email Address
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STIX Field ThreatQ Field Mapping ThreatQ Name

Indicator.value

Indicator.type IP Address

Indicator.value

Indicator.type User-agent

Indicator.value

Indicator.type Filename

Indicator.value

Indicator.type Mutex

Indicator.value

Indicator.attribute Port
Indicator.attribute Protocol
Object.Description

Spearphish.value

Indicator.type Registry Key

Indicator.value

Indicator.attribute Hive

Campaigns Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name

Title Campaign.value
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STIX Field ThreatQ Field Mapping ThreatQ Name
ID Campaign.attribute STIX Reference ID
Description Campaign.attribute Description
Short Description Campaign.attribute Short Description
Timestamp Campaign.started_at
Names Campaign.attribute Alias
Status Campaign.attribute Status

Intended_Effect

Campaign.attribute

Intended Effect

Confidence Campaign.attribute Confidence
Activity Campaign.attribute Activity
Related TTPs TTP

Related Incidents Incident

Attribution Adversary

Associated_Campaigns Campaign

Courses of Action Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Course of Action.value
ID Course of Action.attribute STIX Reference ID
Description Course of Action.attribute Description
Stage Course of Action.attribute Stage
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STIX Field

Objective

ThreatQ Field Mapping

Course of Action.attribute

ThreatQ Name

Objective

Objective Confidence

Course of Action.attribute

Objective Confidence

Type Course of Action.attribute Type

Short Description Course of Action.attribute Short Description
Parameter_Observables Indicator

Impact Course of Action.attribute Impact

Cost Course of Action.attribute Cost

Efficacy Course of Action.attribute Efficacy

Related _COAs

Course of Action

Incidents Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Title Incident.value
ID Incident.attribute STIX Reference ID
Timestamp Incident.published_at
Description Incident.attribute Description
Categories Incident.attribute Category

First Malicious Action

Incident.attribute

First Malicious Action

Initial_Compromise

Incident.attribute

Initial Compromise

First_Data_EXxfiltration

Incident.attribute

First Data Exfiltration
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STIX Field

Incident_Discovery

ThreatQ Field Mapping

Incident.attribute

ThreatQ Name

Incident Discovery

Incident_Opened

Incident.attribute

Incident Opened

Incident_Opened

Incident.started at

Containment_Achieved

Incident.attribute

Containment Achieved

Restoration_Achieved

Incident.attribute

Restoration Achieved

Incident_Reported

Incident.attribute

Incident Reported

Incident_Closed

Incident.attribute

Incident Closed

Incident_Closed

Coordinator

Incident.attribute

Coordinator

Incident.attribute

Coordinator

Reporter Incident.attribute Reporter
Incident.attribute Reporter

Responder Incident.attribute Responder
Incident.attribute Responder

Victim Incident.attribute Victim
Incident.attribute Victim

Related Indicators Indicator

Related Observables Indicator

Leveraged_TTPs TTP

Intended_ Effect

Incident.attribute

Intended Effect
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STIX Field ThreatQ Field Mapping ThreatQ Name
COA_Requested Course of Action
COA_Taken Course of Action
Confidence Incident.attribute Confidence

Attributed_Threat_Actors Adversary

Discovery_Method Incident.attribute Discovery Method
Related_Incidents Incident
TTP Mapping
STIX Field ThreatQ Field Mapping ThreatQ Name

Title TTP.value

ID TTP.attribute STIX Reference ID

Description TTP.attribute Description

Handling TTP.ilp

Kill_Chain_Phases | TTP.attribute Kill Chain Phase

Intended_Effect TTP.attribute Intended Effect
TTP.attribute CAPEC ID

Behavior TTP.attribute Attack Pattern
TTP.attribute Attack Pattern Description
TTP.attribute Attack Pattern Short Description
TTP.attribute Malware Type
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STIX Field

ThreatQ Field Mapping

TTP.attribute

ThreatQ Name

Malware Name

TTP.attribute

Malware Description

TTP.attribute

Malware Short Description

TTP.attribute

Malware Detection Vendor

TTP.attribute

Malware Family

TTP.attribute

Exploit

TTP.attribute

Exploit Description

TTP.attribute Exploit Short Description
Exploit_Targets Exploit Target
Related TTPs TTP
Resources TTP.attribute Tool

TTP.attribute Tool

TTP.attribute Tool Type

TTP.attribute

Tool Description

TTP.attribute

Tool Short Description

TTP.attribute

Infrastructure Type

TTP.attribute

Infrastructure

TTP.attribute

Infrastructure Short Description

TTP.attribute

Infrastructure Description

Indicator
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STIX Field ThreatQ Field Mapping ThreatQ Name
TTP.attribute Persona
Victim Targeting TTP.attribute Victim Name
TTP.attribute Victim <CIQ Identity Name>
TTP.attribute Targeted Systems
TTP.attribute Targeted Information
Indicator

CIQ Identity Mapping

STIX Field ThreatQ Field Mapping ThreatQ Name
Party Name Object.attribute Name
Organization Name Object.attribute Organization
Industry Sector Object.attribute Industry
Nationality Object.attribute Nationality
Languages Object.attribute Language
Address Object.attribute Country
Email Address Object.attribute E-Mail Address
Chat Handle Object.attribute Chat Handle
Phone Object.attribute Phone
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STIX 2.0 Data Mappings

You can click onthe = icon located to top-right of this topic to expand and collapse all map-

ping tables below.

Attack Patterns Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Attack Pattern.Published_at
description Attack Pattern.Attribute Description
external_references|] See External References
kill_chain_phases.[le See Kill Chain Table
modified Attack Pattern.Attribute Modified At
name Attack Pattern.Value
revoked (if revoked == true) | Attack Pattern.Attribute Revoked
labels Attack Pattern.Attribute Label

Threat Actors Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

aliases Adversary * The Adversary cre-
ated will have all

the same attributes
and published_at
as the base Attrib-
ute. All alias
Adversaries will be

inter-related
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Adversary.Published_At
goals Adversary.Attribute Goal
labels Adversary.Attribute Label
modified Adversary.Attribute Modified At
name Adversary.Value
primary_motivation Adversary.Attribute Primary Motivation
resource_level Adversary.Attribute Resource Level
roles Adversary.Attribute Role
secondary_motivation Adversary.Attribute Secondary Motiv-

ation

sophistication Adversary.Attribute Sophistication
revoked Adversary.Attribute

(if revoked == true)

Revoked

external_references|]

See External References

personal_motivations

Adversary.Attribute Personal Motivation

Indicators Mappings

ThreatQ Field Map-

STIX 2.0 Field . ThreatQ Name
ping
created Signature.Published_
at
description Signature.Description
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ThreatQ Field Map-

STIX 2.0 Field _ ThreatQ Name
ping

external_references | See External Refer-

[ ences

labels Signature.Attribute Label

modified Signature.Attribute Modified At

name Signature.Name ThreatQ will default to using Indicator
Pattern as the signature name if a name
is not provided.

pattern Signature.Value

Signature.Type Indicator Pattern

valid.from Signature.Attribute Valid From

valid.until Signature.Attribute Valid Until

revoked (if revoked | Signature.Attribute
Revoked

== true)

kill_chain_phases.[] | See Kill Chain Table

,

ThreatQ Indicator and / or Event objects based on the Observables Map-
ping may be derived from the pattern field and related back to the res-
ulting Signature.

Identities Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

contact_information Identity.Contact_Information
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Identity.Published_at
description Identity.Description
external_references|] See External References
identity_class Identity.Attribute Identity Class
modified Identity.Attribute Modified At
name Identity.Value
sectors Identity.Attribute Sector
labels Identity.Attribute Label
revoked (if revoked == true) Identity.Attribute Revoked

Observables Mapping

STIX 2.0 ThreatQ Field Map-
ThreatQ Name

Field ping

created Observable.Published

at

modified Observable.Attribute Modified At

revoked (if | Observable.Attribute
revoked == Revoked

true)

external_ref- | Observable.Attribute External Reference

erences See External References.

number_ Observable.Attribute Number Observed
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STIX 2.0 ThreatQ Field Map-

ThreatQ Name

Field ping
observed
Specifies Cyber Observable Objects rep-
objects[] resenting this observation. See the tables
below for parsing details.

Artifact Mapping

STIX2.0 ThreatQ Field Map-

ThreatQ Name
Field ping

e: arti- Indicator.Type
typ yp URL
fact

mime_type | Indicator.Attribute MIME Type

url Indicator.Value

hashes{} Indicator.relationship

hashes Indicator.Type MD5 / SHA-1/SHA-256 / SHA-384 / SHA-
{}.key 512 / Fuzzy Hash
hashes

Indicator.Value
{}.value

Autonomous System Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: autonomous-system | Indicator.Type ASN
number Indicator.Value
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STIX 2.0 Field

name

ThreatQ Field Mapping

Indicator.Attribute

ThreatQ Name

Name

rir

Indicator.Attribute

Regional Internet Registry

Directory Mapping
STIX 2.0 Field

type: directory

ThreatQ Field Mapping

Indicator.Type

ThreatQ Name

File Path

path Indicator.Value

path_enc Indicator.Attribute Path Encoding
created Indicator.Attribute Created At
accessed Indicator.Attribute Last Accessed

contains_refs

Indicator.relationship

Domain-Name Mapping

STIX 2.0 Field

ThreatQ Field Mapping

ThreatQ Name

type: domain-name

Indicator.Type

FQDN

value

Indicator.Value

resolves_to_refs|]

Indicator.relationship

Email Addr Mapping
STIX 2.0 Field

ThreatQ Field Mapping

ThreatQ Name

type: email-addr

Indicator.Type

Email Address
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STIX 2.0 Field

display_name

ThreatQ Field Mapping

Indicator.Attribute

ThreatQ Name

Display Name

value

Indicator.Value

belongs_to_ref]]

Indicator.relationship

Email Message Mapping

STIX 2.0 Field

type: email-message

ThreatQ Field Mapping

Event.Type
Indicator.Type

ThreatQ Name

Spearphish
Email Subject

subject** Event.Title
Indicator.Value
is_multipart Indicator.Attribute Is Multipart
date (if parsing as an Event.happened_at
event)* Indicator.Attribute
sent date (if parsing as an
indicator)
content_type Indicator.Attribute Content Type
from_ref Event.Relationship
From
Indicator.Relationship
sender_ref Event.Relationship
_ . _ Sender
Indicator.Relationship
to_refs Event.Relationship T
o
Indicator.Relationship
cc_refs Event.Relationship CC
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name

bcc_refs Event.Relationship
BCC
Indicator.Relationship

received_lines Event.Attribute

Indicator.Attribute

Received Lines

additional_header_fields | Event.Attribute Additional Header - {key}

Indicator.Attribute p |

ﬂ An attrib-
ute is cre-
ated for
each
key-
value
pair of
the addi-
tional_
header_
fields
object.

body Event.Attribute

Body
Indicator.Attribute

body_multipart[].body Indicator
Filename
raw_ref***

raw_email_ref Event.Relationship

Indicator.Relationship

* To parse an event from an email message, the email must have a dateand subject
field.

** To parse an indicator from an email message, the email must contain a subject
field.
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STIX 2.0 Field

*k%k

ThreatQ Field Mapping

ThreatQ Name

If an objectin body_multipart has a body field (body_multipartf].body), an attribute

is created. The attribute's name is "Body Multipart" and the attribute's value is in the

format "Content Type: {body_multipart]].content_type}, Content Disposition: {body_

multipart].content_disposition}, Body: {body_multipart[].body}".

Note: Parsing both an indicator and event from an email message will relate the two

objects .
File Mapping
STIX 2.0 Field fhreatQ !:ield MaP~ Threatq Name
Y

type: file Indicator.Type Filename

size Indicator.Attribute File Size

hashes{}

hashes{}.key Indicator.Type MD5 / SHA-1 / SHA-

256 / SHA-384 /
SHA-512 / Fuzzy
Hash

hashes{}.value

Indicator.Value

name

Indicator.Value

name_enc

Indicator.Attribute

File Name Encoding

magic_number_hex

Indicator.Attribute

Magic Number Hex

mime_type

Indicator.Attribute

MIME Type

created

Indicator.Attribute

Created At
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
ping
accessed Indicator.Attribute Last Accessed
parent_directory_ref Indicator.Relationship
is_encrypted Indicator.Attribute Encrypted
encryption_algorithm Indicator.Attribute Encryption Algorithm

decryption_key

Indicator.Attribute

Decryption Key

contains_refs[]

Indicator.Relationship

content_ref

Indicator.Relationship

extensions.archive-ext.contains_

refs|]

Indicator.Relationship

extensions.archive-ext.version

Indicator.Attribute

Archive Version

extensions.archive-ext.comment

Indicator.Attribute

Archive File Com-

ment

extensions.ntfs-ext.sid

Indicator.Attribute

Security ID

extensions.ntfs-ext.alternate

data_streams[].hashes{}

extensions.ntfs-ext.alternate

data_streams[].hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.ntfs-ext.alternate

data_streams[].hashes{}.value

Indicator.Value
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

extensions.ntfs-ext.alternate

data_streams[].name

Indicator.Attribute

Alternate Data

Stream Name

extensions.ntfs-ext.alternate

data_streams|].size

Indicator.Attribute

Alternate Data

Stream Size

extensions.pdf-ext.version

Indicator.Attribute

PDF Specification

Version

extensions.pdf-ext.is_optimized

Indicator.Attribute

PDF Is Optimized

extensions.pdf-ext.document_

info_dict{}.key/value

Indicator.Attribute

Formatted as: 'PDF
{key title()}'

extensions.pdf-ext.pdfid0

Indicator.Attribute

PDF First File Iden-

tifier

extensions.pdf-ext.pdfid1

Indicator.Attribute

PDF Second File

Identifier

extensions.raster-image-ext.im- | Indicator.Attribute Image Height
age_height
extensions.raster-image-ext.im- | Indicator.Attribute Image Width

age_width

extensions.raster-image-ext.bits_

per_pixel

Indicator.Attribute

Image Bits Per Pixel

extensions.raster-image-ext.im-

age_compression_algorithm

Indicator.Attribute

Image Compression

Algorithm

extensions.raster-image-ext.exif_

tags{}.key/value

Indicator.Attribute

Formatted as: 'Image
EXIF {key.title()}
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

extensions.windows-pebinary-

ext.pe_type

Indicator.Attribute

Executable Extension

Type

extensions.windows-pebinary-

ext.imphash

Indicator.Attribute

Executable Imphash

extensions.windows-pebinary-

ext.machine_hex

Indicator.Attribute

Target Machine Hex

extensions.windows-pebinary-

ext.number_of sections

Indicator.Attribute

PE Binary Section

Count

extensions.windows-pebinary-

ext.time_date_stamp

Indicator.Attribute

PE Binary Created
Date

extensions.windows-pebinary-

ext.pointer_to_symbol_table_hex

Indicator.Attribute

Symbol Table Hex
Offset

extensions.windows-pebinary-

ext.number_of_symbols

Indicator.Attribute

PE Binary Symbol
Table Size

extensions.windows-pebinary-

ext.size_of _optional_header

Indicator.Attribute

PE Binary Optional

Header Size

extensions.windows-pebinary-

ext.characteristics_hex

Indicator.Attribute

PE Binary Char-

acteristics Hex

extensions.windows-pebinary-

ext.file_header_hashes{}

extensions.windows-pebinary-

ext.file_header_hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

Hash

extensions.windows-pebinary-

ext.file_header_hashes{}.value

Indicator.Value

extensions.windows-pebinary-

ext.optional_header.magic_hex

Indicator.Attribute

PE Binary Magic Hex

extensions.windows-pebinary-
ext.optional_header.major_

linker_version

Indicator.Attribute

PE Binary Major

Linker Version

extensions.windows-pebinary-
ext.optional_header.minor_

linker_version

Indicator.Attribute

PE Binary Minor

Linker Version

extensions.windows-pebinary-
ext.optional_header.size_of

code

Indicator.Attribute

PE Binary Code Size

extensions.windows-pebinary-
ext.optional_header.size_of_ini-

tialized _data

Indicator.Attribute

PE Binary Initialized

Data Size

extensions.windows-pebinary-
ext.optional_header.size_of

uninitialized_data

Indicator.Attribute

PE Binary Unini-

tialized Data Size

extensions.windows-pebinary-

Indicator.Attribute

PE Binary Memory

ext.optional_header.address_of Address Entry Point
entry_point
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

extensions.windows-pebinary-
ext.optional_header.base_of

code

Indicator.Attribute

PE Binary Base
Code Memory
Address

extensions.windows-pebinary-
ext.optional_header.base_of

data

Indicator.Attribute

PE Binary Base Data
Memory Address

extensions.windows-pebinary-

ext.optional_header.image_base

Indicator.Attribute

PE Binary Base
Image Memory
Address

extensions.windows-pebinary-
ext.optional_header.section_

alignment

Indicator.Attribute

PE Binary Section
Alignment Bytes

extensions.windows-pebinary-
ext.optional_header file_align-

ment

Indicator.Attribute

PE Binary Image File
Alignment Bytes

extensions.windows-pebinary-
ext.optional_header.major_os_

version

Indicator.Attribute

Windows OS Major

Version

extensions.windows-pebinary-
ext.optional_header.minor_os_

version

Indicator.Attribute

Windows OS Minor

Version

extensions.windows-pebinary-
ext.optional_header.major_

image_version

Indicator.Attribute

Image Major Version
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STIX 2.0 Field

ThreatQ Field Map-
ping

ThreatQ Name

extensions.windows-pebinary-
ext.optional_header.minor_

image_version

Indicator.Attribute

Image Minor Version

extensions.windows-pebinary-
ext.optional_header.major_sub-

system_version

Indicator.Attribute

Subsystem Major Ver-

sion

extensions.windows-pebinary-
ext.optional_header.minor_sub-

system_version

Indicator.Attribute

Subsystem Minor Ver-

sion

extensions.windows-pebinary-
ext.optional_header.win32_ver-

sion_value_hex

Indicator.Attribute

Win32 Version Hex

extensions.windows-pebinary-
ext.optional_header.size_of

image

Indicator.Attribute

Image Byte Size

extensions.windows-pebinary-
ext.optional_header.size_of

headers

Indicator.Attribute

PE Binary Combined

Header Size

extensions.windows-pebinary-
ext.optional_header.checksum_

hex

Indicator.Attribute

PE Binary Checksum

Hex

extensions.windows-pebinary-
ext.optional_header.subsystem_

hex

Indicator.Attribute

PE Binary Required

Subsystem Hex
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
ping
extensions.windows-pebinary- Indicator.Attribute DLL Characteristics
ext.optional_header.dll_char- Hex

acteristics_hex

extensions.windows-pebinary- Indicator.Attribute Reserved Stack Size
ext.optional_header.size_of

stack_reserve

extensions.windows-pebinary- Indicator.Attribute Stack Commit Size
ext.optional_header.size_of

stack_commit

extensions.windows-pebinary- Indicator.Attribute Heap Space Reserve
ext.optional_header.size_of Size

heap_reserve

extensions.windows-pebinary- Indicator.Attribute Heap Space Commit
ext.optional_header.size_of Size

heap_commit

extensions.windows-pebinary- Indicator.Attribute Loader Flags Hex

ext.optional_header.loader_

flags_hex
extensions.windows-pebinary- Indicator.Attribute Number of RVA and
ext.optional_header.number_of Sizes

rva_and_sizes

extensions.windows-pebinary-

ext.optional_header.hashes{}

extensions.windows-pebinary- Indicator.Type MD5 / SHA-1 / SHA-
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STIX 2.0 Field

ThreatQ Field Map-

ping

ThreatQ Name

ext.optional_header.hashes{}.key

256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.windows-pebinary-
ext.optional_header.hashes

{}.value

Indicator.Value

extensions.windows-pebinary-

ext.sections[].hashes{}

extensions.windows-pebinary-

ext.sections[].hashes{}.key

Indicator.Type

MD5 / SHA-1/ SHA-
256 / SHA-384 /
SHA-512 / Fuzzy
Hash

extensions.windows-pebinary-

ext.sections[].hashes{}.value

Indicator.Value

extensions.windows-pebinary-

ext.sections[].name

Indicator.Attribute

PE Binary Section

Name

extensions.windows-pebinary-

ext.sections[].size

Indicator.Attribute

PE Binary Section

Size

extensions.windows-pebinary-

ext.sections[].entropy

Indicator.Attribute

PE Binary Section
Entropy

IPv4 Mapping
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STIX2.0 ThreatQ Field Map-

ThreatQ Name

Field ping
type: Indicator.Type CIDR Block (if value contains a / and does
ipv4-addr not end with /32)

IP Address (if the value ends with /32, the /32

is omitted and reported as an IP Address)

value Indicator.Value

resolves_ | Indicator.Relationship

to_refs[]
belongs_
to. refs[ Indicator.Relationship
IPv6 Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: ipv6-addr Indicator.Type IPv6 Address
value Indicator.Value
resolves_to_refs|] Indicator.Relationship
belongs_to_refs|] Indicator.Relationship
MAC Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: mac-addr Indicator.Type MAC Address
value Indicator.Value
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Mutex Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: mutex Indicator.Type Mutex
name Indicator.Value
URL Mapping
STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: url Indicator.Type URL
value Indicator.Value

User Account Mapping

ThreatQ Field Map-

STIX 2.0 Field _ ThreatQ Name
ping
type: user-account Indicator.Type Username
user_id Indicator.Attribute UserID
account_login Indicator.Value
account_type Indicator.Attribute Account Type
display_name Indicator.Attribute Display Name
is_service_account Indicator.Attribute Is Service Account
is_privileged Indicator.Attribute Is Privileged Account
can_escalate_privs Indicator.Attribute Can Escalate Priv-
ileges

is_disabled Indicator.Attribute Is Disabled
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. ThreatQ Field Map-
STIX 2.0 Field . ThreatQ Name
Ping
account_created Indicator.Attribute Account Created
account_expires Indicator.Attribute Account Expires
password_last_changed Indicator.Attribute Password Last
Changed
account_first_login Indicator.Attribute Account First Login
account_last_login Indicator.Attribute Account Last Login
extensions.unix-account-ext.gid Indicator.Attribute Account Group ID
extensions.unix-account-ext.- Indicator.Attribute
Account Group
groups(]
extensions.unix-account- Indicator.Attribute Account Home Dir-
ext.home_dir ectory
_ _ _ _ Account Command
extensions.unix-account-ext.shell | Indicator.Attribute Shell
e

Windows Registry Key Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
type: windows-registry-key Indicator.Type Registry Key
key Indicator.Value
values[].name Indicator.Attribute Registry Name
modified Indicator.Attribute Registry Modified At
creator_user_ref Indicator.Relationship
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Campaigns Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
aliases Campaign
created Campaign.Published_at
description Campaign.Description
first_seen Campaign.Started_at
last_seen Campaign.Ended_at
modified Campaign.Attribute Modified At
name Campaign.Value
objective Campaign.Objective
revoked (if revoked == true) Campaign.Attribute Revoked
external_references|] See External References
labels Campaign.Attribute Label

Courses of Action Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Course of Action.Published_at
modified Course of Action.Attribute Modified At
name Course of Action.Value
description Course of Action.Description
action
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
revoked (if revoked == true) Course of Action.Attribute Revoked
external_references|] See External References
labels Course of Action.Attribute Label

Intrusion Sets Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
aliases Intrusion Set
created Intrusion Set.Published_at
description Intrusion Set.Description
first_seen
goals Intrusion Set.Attribute Goal
modified Intrusion Set.Attribute Modified At
name Intrusion Set.Value
primary_motivation Intrusion Set.Attribute Primary Motivation
resource_level Intrusion Set.Attribute Resource Level
secondary_motivations Intrusion Set.Attribute Secondary Motivation
external_references|] See External References
revoked (if revoked == true) Intrusion Set.Attribute Revoked

Malware Mapping
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Malware.Published_at
description Malware.Description

kill_chain_phases.[]

See Kill Chain Table

labels Malware.Attribute Label
modified Malware.Attribute Modified At
name Malware.Value

external_references|] See External References

revoked (if revoked == true) Malware.Attribute Revoked

Tools Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Tool.Published_at
modified Tool.Attribute Modified At
labels Tool.Attribute Label
name Tool.Value
revoked (if revoked == true) Tool Attribute Revoked
external_references|] See External References
description Tool.Description
kill_chain_phases.[] See Kill Chain Table
tool_version Tool.Attribute Tool Version
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Reports Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
created Report.Published_at
modified Report.Attribute Modified At
name Report.Value
description Report.Description
labels Report.Attribute Label
object_refs Report.Relationship.Link
external_references|] See External References
revoked (if revoked == true) Report.Attribute Revoked

Sightings Mapping

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
count Event.Attribute Count
created Event.published_at
first_seen Event.happened_at
last_seen Event.Attribute Last Seen
observed_data_refs Event.relationship.link
sighting_of_ref Event.relationship.link
where_sighted_refs Event.relationship.link
revoked (if revoked == true) Object.attribute Revoked
Event.name STIX Sighting
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STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
Event.type Sighting
external_references|] See External References
modified Event.Attribute Modified

External References

_ ThreatQ Field Map-
STIX 2.0 Field _ ThreatQ Name
ping

Object.external_references|].source_name | Object.Attribute External Refer-
ence*

Object.external_references[l.external_id Object.Attribute External Refer-
ence*

Object.external_references[].description Object Attribute External Refer-
ence*

Object.external_references[].url Object.Attribute External Refer-
ence*

* Formatted as: {source_name} ({external_id}): {description} - {url}

Kill Chain Phrases

STIX 2.0 Field ThreatQ Field Mapping ThreatQ Name
kill_chain_phases][].kill_chain_name Object Attribute Kill Chain Name
kill_chain_phases[].phase_name Object Attribute Kill Chain Phrase
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Parsing a STIX File for Indicators

ThreatQ allows you to upload a STIX file orinsert STIX data to parse. for indicators.

To parse a STIX file for indicators:

1.

Click on the Create button, located at the top of the dashboard and select STIX

Parser under the Importheading.

The Parse For Intelligence dialog box will load.

Do one of the following:
« Drag yourfile(s) into the left pane.
« Click on Click to Browse, and locate the file you wish to upload.
« Copy/paste the contentin the right pane.

Select or clear the Normalize URL Indicators check box. See Indicator URL

Normalization for more information.

Click Next Step.
Enter an optional Name.

Select a Source from the dropdown menu provided.

You can also click on Add a New Source if the desired source is not
listed in the dropdown menu

Select any optional Attributes to be applied.

Optionally, enter a comment.

Optionally, use the Add relationships search field to add object relationships.

. Optionally, add any desired Tags.

G‘L If at any point, you wish to abandon the import, click Cancel.
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11. Click Apply.

New objects will become available in the Threat Library.

Object Details Page

You can click on an object within the ThreatQ application to access its details page. The
Object Details page provides you with an in-depth look at an individual object. You can
enter comments for others to view, link related objects, and view an audit log of all activity

associated with the object.

Specific objects, such as Indicators, will display additional information such as the indic-

ator's status, score, and expiration data.
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example.com e 1 STATUS:  Actwe

INDICATOR: FOOM

Created: 03/08/201%  First Seen: D208/2019 06:02pm  Expires: add cace ~ () A -
i |
(@) context @ Attributes 7 o
£ Autributes 7 19
B Sources (3] 19 . E Sources 3 3
@ gz 19
B Descrigtion (1] 19
(_@ Relationships ! G Tags 9
0 Adversaries 2) 19
®Fey 19
1 [Z Description 10 o
@ ndcsos 15 (19
@ s 19
£ comments (1} (19 ) Adversaries 11 .
ﬁ Operatiens 1’9
Files 12 # Link
[ Audicrog 19
@ Indicators 13 o -
® Tasks 14 © Croate .
{2 Comments 15 .
2& Operations 16
B Audit Log 17
=

ltems marked with an * in the Object Details Legend indicate an option
only available to specific object types.

Object Details Page Legend

Header Section

Number Field Description Reference
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Object Details Page Legend

1 Edit Object Link | The Edit link allows you to edit « Editing Adversaries
specific details about an object. . Editing Events
Edit fields will differ based on the
« Editing Files
type of object.
- Editing Indicators
2 Score Selection* | The Score Selection dropdown » Overriding the Scoring
Applies to Indicator | allows you to override an indic- Algorithm with a Manual Score
Object TypesOnly | ator's score set by the scoring
algorithm.
3 Scoring Influence* | You can click on the icon to » Configure Indicator Scoring
App'/ies toIndicator | review the criteria utilized by the . Building a Scoring Algorithm
Object Types Only | gpplication's scoring algorithm to
generate the Indicator's score.
4 Status* The Status dropdown menu « Indicator Status
Applies to Indicator | gllows you to manually set the
Object Types Only | statys of an indicator. Default
statuses include: Active,
Expired, Indirect, Review, and
Whitelisted.
5 Add to Watchlist | The Watchlist toggle button « Configuring the Watchlist
allows you to add and remove
the object from the Watchlist wid-
get.
6 Expiration*® The Expire link allows you to set « Indicator Expiration
App'/ies tondicator | an expiration date for the indic- « Automatic Expiration and
Object Types Only | ator, protect from auto-expiration Policies
policies, and remove an existing
set expiration date.
Details Section
Number Pane Description Reference
7 Attributes The Attributes pane displays « Attributes Pane
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Object Details Page Legend

attributes associated with the
object. You can Add, Edit, and
Delete attributes found in this

section.

8 Sources

The Sources pane displays
sources associated with the
object. You can Add additional

sources to an object.

Adding a Source to an Object

9 Tags

The Tags pane displays tags
associated with the object. You
can Add and Delete tags found in

this section.

Managing Tags

10 Description

The Description pane allows you
to add general information about

the object.

Description Pane

11 Adversaries

The Adversaries pane displays
adversaries associated with the

object.

Adversaries Pane

12 Files

The Files pane displays files

associated with the object.

Files Pane

13 Indicators

The Indicators pane displays
indicators associated with the

object.

Indicators Pane

14 Tasks

The Tasks pane displays tasks

associated with the object.

Tasks Pane

10 Related Objects

There are several different related
panes depending on the types of

objects linked to the object.

You can use these panes to view

and add/remove linked indicators,

Relationships Panes
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Object Details Page Legend

files, signatures, events, adversar-

ies, tasks, and investigations.

15

Comments

The Comments pane allows you

to record comments about the

object for other users to read and

reference.

« Comments Pane

16

Operations

The Operations pane allows you to

associate third-party attributes and

related indicators to the indicator.

Note: This options requires the
installation of Operations. See the
Operations Overview topic for

more details.

o Operations Overview

« ThreatQ Operations Devel-

opment Guide

17

Number

Audit Log

Field

The Audit Log panel displays all
actions and changes made to an
Object.

Description

« Common Enrichment and

Audit Log Questions

Reference

18

Action Menu

The Actions menu allows you to
execute the following actions for

an object:

« Adda New Attribute
« Add a New Comment
« CreateaTask

« Generate a Report

« Add a Relationship

« Adda Source

« Delete Object

« Actions Menu

19

Details Navigation

This allows you to jump to a par-

N/A
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Object Details Page Legend

Tabs ticular pane on the Object Details

page.

Actions Menu

The Action Menu, located on the left-hand of the Object Details page, allows users to quickly

execute system object processes.
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G Context
{

@ Add Attribute
2 Add Comment
¢ Add Relationship

& Add Source

© Create Task

Generate PDF

| ] Delete Indicator

Actions Include:
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Action

Add Attrib-

ute

Function

Brings up the Add Details dialog box to add an

attribute to the object.

Reference

Adding an
Attribute to

an Object

Add Com-

ment

Creates a new text box entry in the comment

pane.

Adding Com-
ments

Add Rela-

tionship

Brings up the Add Relationships dialog box to link

other system objects to the object.

Linking
Adversaries
Linking
Events
Linking Files
Linking Indic-

ators
Linking Sig-
natures
Linking
Tasks

Add Source

Brings up the Add Details dialog box to add a

source to the object.

« Adding a
Source to

an Object

Create Task

Opens up the Add Task dialog box.

Assigning a
Task

Generate

Report

Generates a PDF report of the object.

Generating
Reports

Delete
Object

Delete the system object.

N/A
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Context Panes

The Context section of the object details page displays attributes, sources, and tags asso-

ciated with the system object.
Related Topics:

Attributes Pane

Adding a Source to an Object

Managing Tags

Description Pane

Attributes Pane

The Attributes Pane displays any attributes associated with the system object. You can
review attribute details as well as add and remove attributes from this pane.

@ Attributes (2) © pdd

O ATTRIBUTETYPE = ATTRIBUTE VALUE = SOURCES DATE CREATED -

- abusa.£h Foodo Trackes Bstnet 02 1P Bloc o

O  Destination Fort 3 b 05/05/2019 0311 prm
kit
abusa.£h Faodo Trackir Batnit C2 1P Bloc

O Malware Type Kt 05520159 031 1pm

Related Topics:

o Adding an Attribute to an Object

o Deleting an Attribute

« Deleting an Attribute Source

Adding an Attribute to an Object

You can link adversaries to a system object.
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To add an attribute:

1. Locate the Attributes pane on the object details page.

2. Click on the + Add Details link located to the top-right.
The Add Details dialog box opens with the Add Attributes tab selected by default.

Add Details

Add Source

3. Select an Attribute Type from the Attributes dropdown or enter a new type.
4. Select an existing Attribute Value from the dropdown or enter a new value.

5. Select a Source from the dropdown or enter a new source.

ﬂ You can select the + icon to add additional attributes.

6. Select Add Attributes.

Deleting an Attribute

You can delete an attribute from the object details page.

To delete an attribute:
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1. Locate the Attributes pane on the object details page.

2. Select the checkbox next to the attribute to delete.

ﬂ You can select more than one attribute to delete

3. Select Delete.

The confirmation dialog box opens.

Are You Sure?

Deleting the selected attributes can not be undone.

Delete Attributes | Cancel \

4. Select Delete Attributes.
Deleting an Attribute Source
You can delete an attribute's source from the object details page.
To delete an attribute source:

1. Locate the Attributes pane on the object details page.
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2. Selectthe X next to the attribute's source.

The confirmation dialog box opens.

Are You Sure?

Deleting this attribute source can not be undone

Delete Attribute Source

3. Select Delete Attribute Source.

Adding a Source to an Object
You can add sources to a system object in its details pane.
To add a source:

1. Locate the Sources pane on the object details page.

2. Click on the + Add link located to the top-right.
The Add Details dialog box opens with the Add Source tab selected by default.

Add Details
Add Attributes Add Source

Add new source
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3. Select a Source from the dropdown provided. If TLP is enabled, you can override

the source-default TLP designation.

e N
x

ﬂ You can also click on Add a New Source if the desired source is not
listed in the dropdown list . If administrators have enabled TLP view
settings, users can select a TLP designation light for the new source
in the dropdown list provided. See the Traffic Light Protocol (TLP)

topic for more information on TLP schema.
u

Source
Demao
Select a source

Status

| -

4. Select Add Sources.

Managing Tags
You can add and remove tags in the Tags pane on the object details page.
To add a tag:

1. Locate the Tags pane on the object details page.
2. Selectthe Tags text field and enter the tag.

3. Press [Enter] or [Return].

ﬂ Repeat steps 2-3 to add additional tags.

To delete a tag:

1. Locate the Details pane on the object details page.

2. Select the X next to the tag to delete.
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Description Pane

The Description Pane section of the object details page allows you to add a description for

the system object.
To update the Description pane:

1. Locate the Description pane on the object details page.
2. Select Edit.

3. Make the required changes and select Save.

Relationships Panes

The Relationship section of the object details page displays other system objects that have

been related to the current object.

You can link/unlink system objects from relationship panes and perform bulk updates
(related indicators pane only). You can click on a related object to navigate to its object

details page.

Relationships panes will only appear if a system object is already related
to the object. Use the Actions button to relate the initial object: Actions >
Add Relationship.

Related Topics:

« Indicators Pane

« Adversaries Pane

» Files Pane

o Investigations Pane

o Signatures Pane

« Events Pane
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Adversaries Pane

The Adversaries Pane allows you to link and unlink adversary to an object. You can also
add comments and adjust the adversary's confidence level. You can click on the Show in
Threat Library link to view the related adversaries in the Threat Library or on a specific
adversary nhame to open its object details page.

o Adversaries (1) # Show in Threat Library & Link

Confidence

© 4dd Comment

Praview

"l

The Adversary pane will only load if there is an existing adversary linked
to the object. Click on the Action Menu and select Add Relationship to
add the first adversary.

Related Topics:

o Linking Adversaries

o Configuring Confidence Level

« Commenting on Related Adversaries

« Unlinking Related Adversaries

Linking Adversaries
You can link adversaries to a system object.

To link an adversary:
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1. Locate the Adversaries pane on the object details page.

"1

The Adversary pane will only load if there is an existing adversary
linked to the object. Click on the Action Menu and select Add Rela-
tionship to add the first adversary.

2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships
(l\_‘:‘

3. Use the supplied text field to select a file.

ﬂ Repeat Step 3 to select multiple adversaries.

4. Click Add.
Configuring Confidence Level
You can configure a related adversary's confidence level from the Adversaries pane.

To configure the confidence level of a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Click the dropdown arrow to the right of the adversary, and slide the scale to the
desired confidence level.
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0 Adversaries (1) il Showin Threat Library & Link

O @ adversary

Confidence

© Add Comment

G\ The confidence level can be setto 0, 25, 50, 75, and 100. ]

The displayed confidence level will be modified to reflect your selection.

Commenting on Related Adversaries
You can add, edit, and remove comments to related adversaries.
To add a comment to a related adversary:

1. Locate the Adversaries pane on the object details page.

2. Select Add a Comment.

The Comments text field opens.

e Adversaries {1} i) Show in Threat Library & Link

25%" ~

Confidence

ar

3. Enter a comment.

4. Click Add Comment.

To edit a related adversary comment:
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1. Locate the Related Adversaries pane on the object details page.
2. Select Edit under the comment to update.

3. Update the comment.
4

. Click Save Changes.
To delete arelated adversary comment:

1. Locate the Related Adversaries pane on the object details page.

2. Select Delete under the comment to update.

A confirmation dialog box opens.

Are You Sure?

Deleting this comment can not be undone.

Delete Comment Cancel

3. Select Delete Comment.

Unlinking Related Adversaries
You can unlink related adversaries for an object.
To unlink related adversaries:

1. Locate the Adversaries pane on the object details page.
2. Select the checkbox(es) next to the adversary(ies) to unlink.

3. Select the i unink icon.
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Indicators Pane

The Indicators Pane allows users to link and unlink indicators to an object as well as perform

a bulk update to selected linked indicators.

Indicators (2) @ Show in Threat Library & Link

(] VALUE = SCORE STATUS = REFORTED = TYPE =

o @ 10 Review 024/3019 031 1pm P Address

- ] 0 Antive DAZ5E0E 0311 pm 1# Address
P

"l

The Indicators pane will only load if there is an existing indicator linked to
the object. Click on the Action Menu and select Add Relationship to add
the first indicator.

Related Topics:

o Linking Indicators

o Performing Bulk Updates to Related Indicators

« Unlinking Related Indicators

Linking Indicators
You can link indicators to a system object.
To link an indicator:

1. Locate the Indicators pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select an indicator.

ﬂ Repeat Step 3 to select multiple indicators.

4. Click Add.

Performing Bulk Updates to Related Indicators
You can perform bulk updates to linked indicators listed in the Indicators pane of an object.
To perform a bulk update:

1. Locate the Indicators pane on the object details page.

2. Select the checkbox(es) next to the indicator(s) to update.
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3. Select the # Bulkupdate jcon.

Bulk Update Tool Your changes will affect 2 Indicators

Prowide an additional source

Apply Attributes

Extend Date

The Bulk Update form loads.

4. Select the desired changes and click Apply Changes.

Unlinking Related Indicators
You can unlink related indicators for an object.
To unlink related indicators:

1. Locate the Indicators pane on the object details page.
2. Select the checkbox(es) next to the indicators to unlink.

3. Select the i unink icon.
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Files Pane

The Files Pane allows you to link and unlink files to an object.

%

Files (1) @ Shawin Threat Library

0 TITLE 2 SOURCES DATE ADDED =

o @ % Threat Quatient 03/12/2019 07:27am

You can view a quick summary of the file by clicking the on the eye icon to the left of the file
name or click on the name itself to navigate to its object details page. You can click on the

Show in Threat Library link to view the related events in the Threat Library or download a
copy of the file by clicking on the + icon .

The Files pane will only load if there is an existing file linked to the object.
Click on the Action Menu and select Add Relationship to add the first file.

Related Topics:

« Linking Files
« Unlinking Related Files

Linking Files
You can link Files to a system object.
Tolink afile:

1. Locate the Files pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships .

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Files
You can unlink related files for an object.
To unlink related files:

1. Locate the Files pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the i unirk icon.
Signatures Pane

The Signatures Pane allows you to link and unlink signature to an object. You can click on

the Show in Threat Library link to view the related signatures in the Threat Library or on a
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specific signature name to open its object details page.

0 Slgnatl.lres (1) iR Show in Threat Library & Link

[m] NAME = TYPE = DATE CREATED

o @ W i " B ONS traf tpct £45F snort 05N 2015031 Tpm

"1

The Signatures pane will only load if there is an existing signature linked
to the object. Click on the Action Menu and select Add Relationship to
add the first signature.

Related Topics:

« Linking Signatures

o Unlinking Related Signatures

Linking Signatures
You can link Signatures to a system object.
Tolink afile:

1. Locate the Signatures pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

{ ﬂ Repeat Step 3 to select multiple signatures.

4. Click Add.

Unlinking Related Signatures
You can unlink related signatures for an object.
To unlink related indicators:

1. Locate the Signatures pane on the object details page.
2. Select the checkbox(es) next to the signatures to unlink.

3. Select the # unink icon.

Investigations Pane

. L . .
{ Q ThreatQ Investigations requires a separate license.
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The Related Investigations pane displays any ThreatQ Investigation related to the object.
Adding and removing an object to an investigation is controlled through the Investigations

interface.
You can click on the investigation to open ThreatQ Investigations.
Events Pane

The Events Pane allows you to link and unlink events to a system object. You can click on
the Show in Threat Library link to view the related events in the Threat Library or on a spe-

cific event name to open its object details page.
9 Events (1) @ Show in Theeat Library & Link

[m] NAME = QCCURRED = TWPE =

(] @ 044172019 10-38am DS Attack

The Events pane will only load if there is an existing adversary linked to
the object. Click on the Action Menu and select Add Relationship to add
the first event.

Related Topics:

o Linking Events

o Unlinking Related Events

Linking Events
You can link events to a system object.
Tolink an event:

1. Locate the Events pane on the object details page.
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2 Select# Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple events.

4. Click Add.

Unlinking Related Events
You can unlink related events for an object.
To unlink related events:

1. Locate the Events pane on the object details page.
2. Select the checkbox(es) next to the event(s) to unlink.

3. Select = unink icon.
Tasks Pane

The Tasks Pane allows you to create, link, unlink, and delete tasks associated with an
object. You can click on the Show in Threat Library link to view the related tasks in the

Threat Library or on a specific task name to open its object details page. You can also view
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a quick summary of the task by clicking the on the eye icon to the left of the task name.
@ Tasks (1) B Showin Theeat Library © Create & Link

[m] i NAME = ASSIGNED TO STATUS = PRICRITY =

O = & wvestigate th Daveid Klees To Da Mediurmn

"1

The Tasks pane will only load if there is an existing task linked to the
object. Click on the Action Menu and select Create Task to add the first
task.

Related Topics:

« Linking Tasks

« Unlinking Related Tasks

« Deleting Related Tasks

Linking Tasks

You can link Tasks to a system object from its object details page.

ﬁ You can also related a task to a system object while creating a task.

To link a task:

1. Locate the Tasks pane on the object details page.
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2 Selectthe ¢ Linkicon.

The Add Relationships dialog box opens.

Add Relationships

Add Relationships

Q

3. Use the supplied text field to select a file.

ﬁ Repeat Step 3 to select multiple files.

4. Click Add.

Unlinking Related Tasks
You can unlink related tasks for an object.
To unlink related tasks:

1. Locate the Tasks pane on the object details page.
2. Select the checkbox(es) next to the files to unlink.

3. Select the # unink icon.
Deleting Related Tasks

You can delete Tasks related to a system object from its object details page.

To delete a task:
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1. Locate the Tasks pane on the object details page.
2. Select the checkbox next to the task to delete.

3. Selectthe @ oelete icon.

A confirmation dialog box opens.

Are You Sure?

Deleting this task can not be undone.

Delete Task Cancel

4. Select Delete Task.

Comments Pane

The Comments pane allows users to record comments about the system object for other

users to see.
The following functions can be performed:

o Adding Comments

o Editing Comments

o Deleting Comments

Adding Comments

ﬂ Users can also click on the Actions menu and select the Comment option.

From the Object Details page:
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1. Click on the expand icon [Zl to expand the Comments pane.

2. Click on the Add Comment link located at the top-right and lower-left of the pane.

The new comment text box opens.

E COMMENTS

David Klees (10/15/2018 06:45pm)
Suspicious Activity from IP

edit delate

David Klees (10/15/2018 06:46pm)

DDoS-related attack possible

edit delete

3. Enter a comment.

4. Click on the Add Comment button.

Editing Comments

From the Object Details page:
1. Click on the expand icon [£l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update.

The edit comment text box opens.

E COMMENTS + Add Comment

David Klees (10/15/2018 06:45pm) Hide

Suspicious Activity from IP

David Klees (10/15/2018 06:46pm) Hide
DDoS-related attack possible
adit  delate

Add a Comment
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3. Editthe comment.

4. Click on the Save Changes button.
Deleting Comments

From the Object Details page:
1. Click on the expand icon &l to expand the Comments pane.

2. Click on the Edit link located beneath the comment to update..

The delete confirmation dialog text box opens.

ARE YOU SURE?

Once deleted this comment can not be recovered

Delete Comment Cancel

3. Click on the Delete Comment button.
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Analytics

The Analytics tab provides a summary view of Adversary, Event, File, and Indicator Object

Types.

"l

Search filters are not available for these views nor can you modify the
types of columns used. Use the Advanced Search to utilize these options.

Analytics pages include:

Adversaries

« Events
« Files

Indicators

Adversaries

The Adversaries page provides an overview of all the adversaries within ThreatQ as well as

overlapping use of specific indicators.
There are three sections:

o Adversaries Summary Table

o Adversaries Overlap Table.

« Indicator Distribution Pie Chart

Adversaries Summary Table

The Adversaries Summary table lists adversaries by name, number of indicators, date cre-

ated, and the most recent event date associated with the adversary.
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ADVERSARIES

Showing 1 to 10 of 92 Row count: 10 *
ADVERSARY NAME = MLUMEER OF INDICATORS % DATE CREATED & MOET RECEMNT EVENT DATE @
Adversary Bravo 03/1872019 01:05pm
Agirated Rhinoceros 0371872018 01;09pm
Ajax Team 03/18/2019 01:24pm
Albino Rhino 03/18/2019 01:18pm
AMCHOR PANDA 03/15/2013 06:31pm 052H2018 01:44am
ANDROMED# SPIDER 03/15/2019 06:31 pm O301/2018 09:00pm
Appetizing Ferret 03/18/2019 01:09pm,

APT1 0371872019 07:04pm
Astonishing Pheasant 0371872019 01:09pm
BERSERK BEAR 03/15/2019 0B:32pm 1001902018 04:44am

The following functions are available:

Function Details

Opening the Adversary 1. Click the name in the Adversary Name column.
Details page for an

adversary

Performing a search for 1. Click the number in the Number of Indicators column to
related indicators set the adversary name as a search criterion and open

the Advanced Search page.

Opening the Event 1. Click the date in the Most Recent Event Date to open
Details page for an the Event Details page.

adversary event

Changing the number 1. Click the paging batch option located to the bottom-

of entries displayed in right of the table.

the table

Sorting the table by a 1. Click the column header. To reverse the column sorting
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Function Details

column order, click the header a second time.

Searching within the 1. Click within the search box at the top of the column,
Adversary Name and enter your search criteria.

column

Adversaries Overlap Table

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

ADVERSARY OVERLAP

DATE = OVERLAPPING ADVERSARIES = ADVERSARY NAMES % TYPE % OVERLAPPING INIMCATOR #

04/02/2019 02:10pm 2 ABCThreat, nameAdversary Emnall Subject rest123

The following functions are available:

Function Details

Opening the Adversary Details 1. Click the name in the Adversary Name

page for an adversary column.

Opening the Indicator Details 1. Click the identity in the Overlapping Indicator

page for an overlapping indicator column.

Changing the number of entries 1. Click the paging batch option located to the

displayed in the table bottom-right of the table.

Sorting the table by a column 1. Click the column header. To reverse the
column sorting order, click the header a
second time.
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Function Details

Searching within a column 1. Click within the search box at the top of the

column, and enter your search criteria.

Indicator Distribution Pie Chart

The Adversary Overlap table lists adversaries, the date and time they were created, their

type, and any overlapping indicators.

INDICATOR DISTRIEUTION
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The following functions are available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to open

about a selected value a popup identifying the indicator.

The number of times the indicator was found within the
specified time frame, and what percentage of the total

number of indicators it represents.

Hiding or unhiding one of 1. Click the indicator on the left of the pie chart to
the values from the pie remove it; click a second time to reinstate it.
chart
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Function Details

Adjusting the time frame 1. Click the dropdown menu at the top right and select
of the information dis- the desired timeframe.
played

You can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

o LastYear

« User-set custom range

Printing the graph or sav- 1. Click the hamburger menu = and select the desired
ing itas a PNG, JPEG, option.
PDF, or SVG

Events

The Events page provides a high-level view of what types of events have occurred and how

frequently they are occurring.
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Events Overview

Analylics Mew Events

EVENTS TIMELINE [ Last 30 Days =
a‘ —
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‘ Jan 21 e hhid M 2008 Apr 201K ey 2004 Jem FBLE Jul 2018 Aug 2006 Sep 2014 et 2013 Mow 2l e BO1E e B01G = ‘

To Access the Events page:

1. In the navigation menu, choose Analytics > Events.
The Events Overview page opens.
The tab options include:

o Events History Scatter Plot

o Monthly Heatmap

« New Events Summary

Events History Scatter Plot

The scatter plot points are plotted by date (x-axis) and hour (y-axis). The legend under the

scatter plot identifies the different kinds of events shown.
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Analytics
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The following functions are available:
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Function Details

of the event types

Viewing an event’s name, date 1. Hover your mouse over an event on the scatter
and time, and source plot to see its name, date and time, and source.
21

:s;;lue:tsl?d}%???%é:ggéﬁ:mﬁﬁm issued to dionaea.carnivore.it with common name Nepenthes Development Team ¥
E 12 ' . = > " ; - + 0
9 b - "
. » l . ] L s L ]
0 ''m [ ] ] L ] n ] [ ] [ ] [ ]
Opening the Event Details 1. Click the event in the scatter plot.
page for one of the events _ . . )
For more information, see Object Details Page.
Hiding or unhiding one or more 1. Click the event type in the legend immediately

below the scatter plot to remove it from the

graph; click it again to reinstate it.
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Function Details

Adjusting the time frame of the 1. Click the dropdown menu at the top right and

information displayed select the desired time frame.
You can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

Last Year

« User-set custom range

Printing or downloading the 1. Click the hamburger menu = and select the
scatter plot as a PNG, JPEG, desired option.

PDF, or SVGfile
Monthly Heatmap

The Monthly Heatmap table lists events that happened per adversary each month. Shading
of the monthly totals is used to allow you to quickly scan for patterns in the events and to

quickly detect events with higher monthly counts.

MONTHLY HEATMAP {3 Last Year =

Jan 20l& wh 201E Mar 201R Apr 2018 May 201& Jun 2018 Jul 201d ug 1018 Sep 201A Ot F01A MHov Fia e JO1H Jam 3018 =
1% team o o o o o o o a o 1 o o o
o Q 1 o o o o L] Q o b o o o
@ 2| o o o o o a o b o o b 05
o 1 o o o o 1 o a o o o o o
apl-23 L] 1 o o o [ L @ [ b o o b
apt-37 L] 1 a o o o " a o a a o a 1
cyber-berkut ] 1 a » 0 [ [ ] o o a o o
farcy bear L] ] a i o [ 2 L] o o @ o o
group 123 L] r] a ) Ul L) L) a ) a a o a L¥
hidden cobra ] o a ) 1 o n L] o o a o o
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The following functions are available:

Function Details

Viewing an event’'s name and 1. Hover your mouse over an event on the
monthly count heatmap to see its name and monthly
count.
Jan 2018 Feb 2018 Mar 2018 Apr 2018 May 2018 Jun
338 team 0 anonymous: 2 0 o 0
anonplus 0 February 2018 0 0 0
anonymous. 0 2/7 0 [ 0
apt 1 1 0 0 0 0
apt-28 0 1 0 0 0
apt-37 0 1 0 0 0
cyber-berkut 0 1 0 0 0
fancy bear 0 0 0 0 0
group 123 0 2 0 [} 0
hidden cobra 0 0 0 0 1
oilrig 0 1 0 0 0
operation darkseoul 0 o 0 0 1
scarcruft 0 1 0 0 0
stone panda 0 0 0 0 1
Adjusting the time frame of the 1. Click the dropdown menu at the top right
information displayed and select the desired time frame.

You can select from:

o Last24 Hours

Last 7 Days
o Last30 Days
o LastYear

« User-set custom range

Printing the graph or Saving itas a 1. Click the hamburger menu = and select

PNG, JPEG, PDF, or SVG the desired option.
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New Events Summary

The New Events Summary table provides a breakdown of events by date, type, title, and

sources.
DATE - TYRE = TME = SOURCES
by date : Start t
11/21/2018 DZ:44pm Exfiltraticn Attack Event: 110 Johnryu
1119/2018 12:44am Login Compromise Attack Event: 109 JehnnyU
11172018 08:44pm ‘Watchlist Attack Event: 107 JohnryU
11/11/2018 07:44am Dos Amack Attack Event: 108 Johnmyu
11/06/201 8 05:44am SQL Injection Attack Attack Event: 112 JohnmyU
1170372018 11:44pm Malware Attack Event: 106 Johnryu
11/03/201 8 12:44am Command and Control Attack Event: 111 Johnmyll
10/28/2018 05:44pm Login Compromise Attack Event: 102 JohnryU
10/26/2018 01:44pm Exfiltration Attack Event: 103 Johnmyu
10/19/201 8 04:44am Command and Contral Attack Event: 104 Johnryl

<l z 3 45 6 7> Rowsperpage 10 =

The following functions are available:

Function Details

Opening the Event Details page 1. Click the eventtitle.

for one of the events _ _ ) )
For more information, see Object Details Page.

Changing the number of entries 1. Click the dropdown menu at the top right of
displayed in the table the table, and select the desired option.
Sorting the table by a column 1. Click the column header.

2. Click the header a second time to reverse sort

order.

_ o 1. Click within the search box at the top of the
Searching within a column o
column, and enter your search criteria.
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Files

The Files page provides you with a pie chart displays the percentage of different types of
files within the system and a table that lists the files, the date and time they were created,
their title, their source, their category, and associated keywords.

Files Overview

OVERVIEW

ThreatQ C5V File: 1%

Crowdstrike Intelligence: 2%
FireEye Analysis: 3%
Ceneric Test 7%

8

=

=

STIX: BE%
DATE = TITLE = SOURCE CATEGORY KEYWORDS
O Filter by date A, Start fyping, L Start typing, 1 Start typéing.
0320/2019 05:33pm Eenerate_campaign.py threatg@threatg.com CrowdStrike Intelligence &
03/20/2019 05:30pm techsupport.txt threatg@threatg.com CrowdStrike |ntelligence o
N tgt_threatq_et-cabbb0d2-2f16-43
03182019 01:4%9pm ] BOer-b3341 5463891 sl Super@threatg.com STIX &

Available views include:

« Files Pie Chart

« Files Table
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Files Pie Chart

The File Types pie chart displays the percentage of different types of files within the system.

OVERVIEW

Threald CFV File: 1% i Cuckos: 1%

CrawdStrike Intelligence: 2%

Threar] CSW Filie
FircEye Analysis: 3%

Files: 1

Ceneric Text: 7%

Values

STIX: BER

The following function is available:

Function Details

Viewing more information 1. Hover over a colored section of the pie chart to

about a selected file open a popup that gives the number of attach-

ment types.

Cuckoo: 1% FireEye Analysis
Files: 3

CrowdS 2%

FireEye Analysis: 3%

Generic Text: 7%

Printing the graph or Saving it 1. Click the hamburger menu = and select the
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Function Details

as a PNG, JPEG, PDF, or desired option.
SVG

Files Table

Immediately below the Browse pie chartis a table that lists the files, the date and time they

were created, their title, their source, their category, and associated keywords.

DATE TILE = SOURCE CATEGOAY KEYWORDS
Filter by date SEAMT typing... SEart typing... 3

03/20/2019 05:33pm generate_campaign.py threatg@threatg.com CrowdStrike Intelligence i

03/20/2019 05:30pm techsuppart . txt threatg@threatg.com CrowdStrike Intelligence iy
tgt_threatq_et-cabbbOd2-2f16-43

03/18/2019 01:49pm ) e :.}}41 e Super@threats.com STIX &y

03/18/2019 01:4gpm 71T PRCIABETEAER A Super@threatq.com STIX &
nd_threatq_indicator-cfbcdfod-d

03/18/2019 01:4%pm 068-4dc8-a57b-cda54868bf28.x Super@threats.com STIX )
m
nd_threatq_indicator-20788288-

03/18/201901:48pm 9690-4766-a314-6bBa18325a%91, Superi@threatq.com STIX =)
M
nd_threatq_indicator-443e4e59.

031872019 01:48pm Th29-4243-BeB0-5af3b7M07a34.x Super@threat.com STIX i
m
coa_threatq_coa-ccf236e2-3126

03/18/2019 01:47pm ryiiirs l—._, 2817 CA06H om Super@threatq.com STIX o)

031872019 01:47pm Campaign.xml Super@threats.com STIX iy
cam_threatq_campaign-8a56607

03/18/201901:46pm 2-5h&1-dfaf-aced-16525ba 144 x Super@threatqg.com aTix )

m

(“2 3 4 5 6 7 .. 11 » Rowsperpage 10 ~

The following function is available:

Function Details

Opening the File Details page for a 1. Click the name in the Title column.

file

Changing the number of entries dis- 1. Click the paging batch option located to the
played in the table per page bottom-right of the table.
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Function Details

Sorting the table by a column 1. Click the column header.

2. To reverse the column sorting order,

click the header a second time.

Searching within a column 1. Click within the search box at the top of

a column, and enter your search criteria.

Downloading a file 1. Click the download icon #=.

Indicators

The Indicators page provides an insight into what indicators have been added to the system
within the last 15 days, as well as an overview of how many indicators fall under each indic-

ator type.
To Access the Indicators Page:

1. From the navigation menu, click on Analytics and choose Indicators.
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The Indicators Overview page will open with three view tab options at the to of the
page.
THREAT(Q 3 AT (e *Create

Indicators Overview

RECENTLY CREATED INDICATORS

1z
4
; l
.

Apr2 Apri Aprd Apr 7 Apr§ Aprg Apri0 Apr 11 Apri2 .\\pﬂ; Apr 14 hpr!s Aprig  Apriy

B
1]

B

=

Indicators Created
o

]

STATUS HETWORK HOST TOTAL
Active 338 1] 339
Expired
Indirect ]
Review 2m 20
Whitelisted

Totals 541 541

The page is broken down into different Indicator class views that are accessible via the

tabbed navigation located at the top of the page.

Summaries included on the Indicator Page Include:

Recently Created Indicators Histogram

« Most Recent 100 Indicators

Attributes Table

« Recent Sources

Attack Phases

ThreatQ User Guide, Version 4.39 393



THREA TG m Analytics

Attack Phases

Attack Phases are the ways an indicator might be used and are listed as indicator attributes.
The Attack Phases pie chart displays the number of indicators that fall under each attack
phase.

ATTACK PHASES 3 Last 30 Days =

The following functions are available:

Function Details
View the Number of 1. Hover the mouse over a portion of the pie chart to view
Indicators for an Attack a popup the Attack Phase and number of indicators
Phase associated with it.

2. Clicking on a pie chart section will open the Advanced
Search page with the specific filter settings used for

that selection.

Adjustthe Date Range | The default Date Range is 30 days.

for the Information Dis-

played 1. Click the date range icon located to the top-right of the
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Function Details

chart and use the dropdown menu select the desired

range.
Users can select from:

Last 24 Hours

o Last7 Days
Last 30 Days

Last Year

« User-set custom range

Hide a Values from the 1. Click on a Attack Phase in the legend to the left of the
Pie Chart pie chart to hide it.

The Attack Phase will be removed from the pie chart and

the source in the legend appear greyed out.

2. Click on the Attack Phase again to add it back to the
pie chart.
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Attributes Table

The attributes list on the left side displays attributes related to indicators in your system.

ATTRIBUTES

Select an attribute below:

Showing 1 to 10 of 30 Rowcount: 10 v
Type = Nales Please select an attribute on the left.
Allack Phase 526,415 >
Audience 221,038 >
Commpile Tims 121 »
Confidence 1,523,494 >
CPE 192,802 »
CrowdStike Domain Type TH ¥
CrowdStnke Intel News 6 >
Crowdstres |9 Address Type T
CrowdSlike Slalus 140 >
CrowdStnke Threat Type 1,853,109 >

=3 =

The following functions are available:

Function Details

Change the Number of 1. Click the Row Count icon located to the top-right of the
Entries Displayed in chart and select a new display count from the drop-
the Table down.

Search/Filter Attributes 1. Click within the search box at the top of the column, and

and Values enter your search criteria.

View More Information
About a Selected
Attribute

1. Click on an attribute row in the table to view additional

information in the right pane.
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Function Details

ATTRIBUTES

Select an attribute below:

Showing 1 to 10 of 30

Type

Audence

221036 >

Attack Phase

H

Comple Time. 121 » |>’|

Configence 1623494 >

cee 192,802 >

Crowastiie Domain Type 75

CrowgStrie ntel News: 62

Crowostree 12 Andress Type T

Crowostrie Staws 10 > Showing 117017 Rowcount| 10~

CrowgStrie Threal Type 1,863,100 >

= =

2 574
D a2
Expol 131

2. Hover the mouse over different portions of the pie chart

to reveal the segment's value.

3. Click on an Attribute Value in the summary table below

the pie chart to open the Advanced Search page with

those attribute values applied.
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Most Recent 100 Indicators

The Most Recent 100 Indicators list displays the 100 most recently reported indicators.

Maost Recent 100 Indicators

Showing 119 25 of 100 Row count 25
Date - Indicator Score Type Status Source
10/0E 2018 05:30pm 6C1423c4c Fo0be2da1 2030805500 5903 (5 MDOS AClve CrowdStnke
100082018 05 30pm Abcla 1997 92bTeS 44 0dbT 8T a0 0 B4 2288 [ SHA-1 Active CrowdSirile

1000872018 05:30pm TTedd

CA39cC950019Tced2T 17efud262 54 5b0ddde04 18 (1] SHA-236 Aclive CrowdSirike

100082018 05 30pm Wit edefc20chidedci0daitalTad5ea05 [ SHA-256 Ariive CrowdSirike

10/0E201E 05 30pm 16a5122515eTE2eebc 16d76ace0041c [0 MDS5 Aclive CrowdStrike

10M0E201E 05 30pm diaeSciTectatnb3bEciaatoe3 s 4ael!

3003959 ] EHAA Aclive CrowdStnke

10082018 05 30pm 41587 3deccbd Bdle oo ctlaln /37 4V eddebb4c2Obin 2d4bd 3 [ SHA-236 Aclive CrowdSinke
14bEdaz 1eeh

1000812018 05.30pm 91dbbEbM 9862200957 23337904 2868de 0 MDS Active CrowdSlrike

100082018 05:M0pm 13790 1801679003331 21 55¢e 319316731 509502 306bocd 105 0 SHA-256 Arlive CrowdStrike
B05acee303916¢

104082018 05 30pm Oa4MTaT9e TS 2T T2CIMe0T 140421708128 [ SHA-1 Aciive CrowdShike

10/0E201E 05:30pm IBEAZAthacdb0cGARAChA4C3anF6AS 147 [ MDS Aciive CrowdStke

10082018 05:30pm ededaalabobs2at3abidcblasbsartatdscarza [H SHA-1 ACtve CrowdStnke

10008/2018 05: 30pm T4664bE2415ac23 113264 2T TedddaTid 1 cafeS66 3T 8eSeft (] SHA-256 Active CrowdSirile
9931391090

1000872018 05 30pm I7404edBAT180bd5Ic3edFaTe19bEIE2 0 MDS Acdive CrowdSlrike

The following functions are available:

Function Details

Resort the Table 1. Click on the different table headings to resort that

table by that column.

Search and Filter Table 1. Click on one of the search boxes at the top of the

Results columns and enter a keyword to filter the results.

You can use the supplied dropdown selections for
the Status and Type columns to filter by system-avail-

able values.

Modify the Number of 1. Click on the Row Count icon located to the top-
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THREAT() ™
right of the chart and select a new display count

Rows Displayed

from the dropdown.

Access the Indicator 1. Click on the specific Indicator to review to open

Details Page for a Specific the Indicator's Details page.

Indicator

Recent Sources
The Recent Sources Scatter plot displays how many indicators were provided by a given

source each day within a specified time frame.
RECENT SOURCES 4 Last 30 Days -
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The following functions are available:

Function Details

Hover the mouse over one of the scatter plot circles
to view a popup with the Source, Date, Time and

View the Date and Num- 1.

ber of Indicators from a
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Function Details

Given Source

Number of Indicators.

RECENT SOURCES L5 30 Days +
= L . 2m8092021 = L -~
) _ o @ | D coviwne 157 mones | @ @ @ o0 o coPod
5 D 2 6 & & @ & | y
)

&
Hagddd ' T8

2. Click on the one of the scatter plot circles to open
the Advanced Search page with the specific filter

settings used for that selection.

Adjust the Date Range of

the Information Displayed

The default date range is 30 days.

1. Click the date range icon located to the top-right of

the chart and use the dropdown menu select the

desired range.
You can select from:

» Last24 Hours
o Last7 Days
« Last30 Days
o LastYear

« User-set custom range

Hide Values from the Scat-

terplot

1. Click on a source in the legend under the scatter

plot to hide it.

The Source will be removed from the scatter plot and
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Function Details

the source in the legend appear grayed out.

2. Click on the source again to add it back to the scat-

ter plot.

Recently Created Indicators Histogram

The histogram is organized by date. Daily indicator totals are at the top of each column.

Each bar is broken down into colors, one for each indicator type.

RECENTLY CREATED INDICATORS

20,691
2k 18,590

16,384

14,796 15,176 15,267 15,404
Sk ! 13,646
. 13,138 13,412
10,674 1347 10,850
! 8,697 8,635
I 6,860
K I
oz O3

Sep23 Sep24  Sep25 Sep26 Sep27 Sep28  Sep2y  Sep30  Octd ol Oct 5 Oct & ot 7 Oct8

Indicators Created
=]
=

o
e

o

The following functions are available:

Function Details

Viewing the number of 1. Hover over a colored section to view a popup show-

indicators created each ing how many attempts of a particular type (for

day by type example, MD5, SHA-1, SHA-256) were made on
that date.
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RECENTLY CREATED INDICATORS

2018-10-05
7346 MDS indicators
20k
18,590

16,381
- 1479 15176 15,267 15,400
= 15,138 (EXIE
10678 L2 10,850

o sgor 8635
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EK I
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Zooming in for a closer 1. Drag your mouse over a section of the histogram,

Indicators Crealed

view and your view will be magnified.

RECENTLY CREATED INDICATORS

25 =
21,103
20k
FIREY
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8
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2. Click Reset Zoom to return to the full histogram.

Printing the histogram or 1. Click the hamburger menu =, and select the desired
downloading itas a PNG, option.
JPEG, PDF, or SVGfile
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Incoming Feeds

The following describes how to use incoming feeds to ingest threat intelligence data.

o Incoming Feeds Overview

« Managing Incoming Feeds

o Historic Feed Pulls

« Feed Health Notifications

Incoming Feeds Overview

You can enable and manage incoming feeds in ThreatQ to ingest threat intelligence data.

Incoming feeds are organized into the following categories:

Commercial

o OSINT or Open Source
STIX/TAXII Feeds

o Labs

Commercial Feeds

Commercial feeds are provided by paid feed providers as a service. To enable these feeds
in ThreatQ, you will need an API ID or API Key from the provider. Commercial feeds typically
provide highly contextual threat intelligence data. You can learn more about these feeds on

their vendor's websites.

OSINT Feeds

OSINT feeds are open source threat intelligence feeds. Open source feeds are free to use,

but some may require you to register with the feed provider to attain an API Key.
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STIX/Taxii Feeds

STIX stands for Standard Threat Information Expression, itis an emerging standard for the
sharing of machine readable intelligence and incident data. A STIX package is an XML doc-
ument that can contain many indicators and related context information. For the automated
sharing of STIX packages, a protocol called TAXII (Trusted Automated eXchange of Indic-

ator Information) is used to provide a feed to consumers.
ThreatQ provides a feature for consuming STIX/Taxii feeds.
Related Topic

Adding a New STIX/TAXII Feed

Labs Feeds

Labs (formerly known as ThreatQ Labs) are driven by ThreatQuotient’s Threat Intelligence
Services Team. Labs feeds provide a solution for data ingestion that is not provided by the
feeds pre-configured with the ThreatQ platform. You should inquire with a Threat Intel-

ligence Engineer to see what Labs are available.

Managing Incoming Feeds
Manage threat intelligence feeds on the Incoming Feeds page.

The following table describes the actions you can take to manage Incoming Feeds.
To Do this..

Turn a feed on or off Toggle the switch next to the feed name.

N . Click Feed Settings for the feed you wish
Editing a feed’s display name or URL
to edit, and make desired edits.
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_

Install/lUpgrade Configuration Driven See the Adding/Upgrading a CDF from

Feed (CDF) the ThreatQ Interface topic.
Uninstall Configuration Driven Feed See the Removing a CDF from the
(CDF) ThreatQ Interface topic.

Adding/Upgrading CDF Command

Use the steps below to add or upgrade a Configuration Driven Feed (CDF) using the Com-
mand Line Interface (CLI). The command creates connectors for each feed defined in the

feed definition file.
To install a CDF:
1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatq:feed-install <Feed

Definition File>

ﬂ The application will notify you if the feed(s) in the feed definition file
already exists in the system and will cancel the installation. See the
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N
"1

To Upgrade a CDF and Changes in User Configurations sections

below for more information.

threatq:feed-install 6266 Started > 2019-02-21 18:47:24
threatq:feed-install 6266 Command failed:

The provided definition file contains the following installed feeds:
Testing at 5 AM. Proceed with the update by usihg the --upgrade flag.

. J

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

To Upgrade a CDF

e N
x

This command can be used to update a feed's Category and Namespace.
If the category exists on the appliance, the command will update both
fields and link the feed to the designated category. ThreatQ will confirm
that the defined category exists before completing the update command. If
the category does not exist, ThreatQ will not update the feed.

1. SSH to your ThreatQ installation.

2. Navigate to the api directory using the following command:

cd /var/www/api

3. Place the application into maintenance mode - see the Maintenance Mode topic.

4. Run the following command:

sudo php artisan threatqg:feed-install <Feed

Definition File> —--upgrade

5. Bring the application out of maintenance mode - see the Maintenance Mode topic.

Changes in User Configurations

ThreatQ User Guide, Version 4.39 406



THREA TQ H Incoming Feeds

When upgrading an existing feed using the --upgrade flag, the application will compare the
existing version of the feed with the new version for differences in the user configuration. If a
difference is detected, the application will inform you that the current user configuration for

that feed will be overwritten. The application will require user input to continue with the feed

upgrade.

threatq:feed-install 6674 Started > 2019-02-21 18:48:28
threatq:feed-install 6674 Warning: The provided definition file
contains updated user configurations. It is highly recommended to
create a copy of the configuration values for the following feeds
before proceeding with the update: Testing at 5 AM.

Do you want to continue? (Y/N) Y

threatq:feed-install 6674 Number of connectors in the definition file:
1

threatq:feed-install 6674 Number of existing connectors updated: 1
threatq:feed-install 6674 Finished > 2019-02-21 18:48:34 > 6.19s

Itis recommended that you create a copy of the existing configuration val-
ues before proceeding with the upgrade.

Command Flag Help

You can also see a full list of command flags using the following command while under the

Ivarlwww/api directory:

sudo php artisan threatqg:feed-install --help

Adding/Upgrading a CDF from the ThreatQ Interface

You can add or upgrade a CDF from the Incoming Feeds page of the ThreatQ interface.

G\ The process to upgrade a CDF is the same as adding a new CDF.

To add a CDF fro